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Introduction 
 
Welcome to Practice 2000, a comprehensive computing system that assists in the 
management of a medical practice. It gives you the best patient billing, HIC Online, 
appointments, pictures/text scanning and payroll. 
 
We are proud that our enthusiastic users consider Practice 2000 the best system. We listen 
to users’ comments and incorporate their ideas into the software. Our most sincere thanks to 
all the doctors, practice managers and receptionists who tell us what they want. 
 
Practice 2000 is Windows-based and easy to use. If you are familiar with Windows 2000/XP, 
you can use Practice 2000 straight away by reading the control tips on screen. These are the 
pop-up texts explaining what each button and each field does.  
 
Practice 2000 is developed using Microsoft Office 2000 with MS SQL 2000 / 2005 technology 
and is therefore fully integrated with Word and Excel. All the data you entered into Practice 
2000 can be exported to other applications easily.  
 
Practice 2000 helps providing a better service to the patient, reducing the administration time 
for the practitioner, and making a better bottom line for the practice. 

 
Users’ comments 
 
 “The PRACTICE program is very comprehensive, diverse in its application, extremely easy 
to use and satisfies all the requirements needed to run a very busy general practice” - Dr. 
R.H. Moffitt, South Morang Medical Centre. 
 
“I am very happy with Practice 2000.  It is a solid, reliable product.  It has numerous functions 
that assist in many aspects of running a surgery” - Dr. Peter Coulton, Kerrie Road Medical 
Centre. 
 
“...Practice 2000 was perfect for my needs ... It is simple to use ... I used it (Medclaims) from 
day 1 ... However the most important aspect to your program is the support you give... I 
would be pleased for any doctor who is considering using Practice 2000 to come and have a 
look at it in action at my surgery.” - Dr. A. Zulman, Macedon Medical Centre. 
 
“I would like to compliment you on the PRACTICE software package ... The majority of our 
staff were able to use PRACTICE with only a couple of hours tuition ... Your after sales 
support and attention to detail is to be commended, and I would not hesitate in 
recommending your company, products and service to anyone.” - G. Ross-Crossley, 
Managing Director, Pain Clinics Aust. 
 
“...to my delight, it has been a resounding success ... it is an extremely efficient, reliable 
software package ... backup and availability has been fantastic ... I would have no hesitation 
in recommending PRACTICE to any medical practice” - Robyn Allen, Practice Manager, 
Carrington Consulting Suites 

 

Acknowledgements  
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Dr Cindy Cuc Nguyen and Dr. Peter Coulton are the first two users (or rather Guinea Pigs) of 
the software, and suffered bugs accordingly. Dr Arthur Zulman is a fussy client who demands 
the most efficient way of doing things, and keeps on ringing until the features he needs has 
been developed. He also wrote a training manual. Dr Tony Michaelson provided many great 
suggestions as he is a programmer himself. Lu Pease redesigned the software to make it 
suitable for neurosurgeons, and appointed herself the software quality controller. She rang 
us so often that she became a de facto member of the software development team. Dr 
Gareth Ross-Crossley, Dr. R Moffit, Ms Robyn Allen, Ms Wendy Goonen, Ms Stephanie 
Relph and many other doctors and practice managers have made suggestions to the 
software, encouraged us and recommend Practice 2000 to their colleagues 
 

Licence agreement 
 
The copyright, patents, trade marks and all other intellectual property rights in the Software 
and related documentation are owned by and remain the property of Abaki Pty Ltd and are 
protected by national laws and international treaty provisions.  
 
Abaki warrants that:  
 

1. For a period of 180 days from you purchasing the Software, it will materially conform 
to the electronic documentation provided with it; and with respect to any physical 
diskette(s), the same shall be free from defects in materials and workmanship for a 
period of 180 days from purchase. 

2. In the event of notification within the warranty period stated in clause 7.1, Abaki shall 
replace the defective Software and/or diskette(s). The remedy for breach of the 
warranties set out in clause 7.1 shall be limited to replacement of the defective 
materials and shall not encompass any other damages. 

3. Save as stated herein, Abaki expressly disclaims all other conditions, warranties, 
terms and undertakings, expressed or implied, statutory or otherwise, relating to the 
Software and related documentation or technical support, including but not limited to 
warranties of quality, performance, satisfactory quality or fitness for a particular 
purpose.  

 
Abaki accepts no liability for any direct, indirect or consequential loss or damage of data, 
profit, revenue, anticipated savings or business, however caused or associated, even if 
foreseeable or made known to Abaki, due to alleged use of the Software and/or associated 
training. Abaki’s maximum liability to you for any cause whatsoever will be limited to the 
amount paid for the Software. 

 
Abaki provides supports to clients who pay annual support fees through phone, fax, modem 
(using Symantec PCAnywhere) or the Internet. 
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Hardware/Software 
requirements 

 
The following are recommended configurations for acceptable performance. You can vary 
the specifications depending on computer usage.  
 

Small Practices (1-5 computers)  
 
NETWORK  
 

· 5-port hub 100Mbs  
· Internet connection  

 
RECEPTION COMPUTER (acting as File Server) 
 

· SOFTWARE 
o MS Windows XP Professional  
o Practice 2000 for practice management 
o Locum, Best Practice or Medical Director for writing prescriptions 
o Pathology downloading software  
o MS Word for letter writing  
o RealVNC (for remote support)  
o Antivirus + firewall  
 

· HARDWARE  
o 3-GHz Pentium 4 CPU or equivalent 
o 2 GB of RAM 
o 100 Gb HDD/7200 rpm 
o 100 Mb/s Ethernet card  
o Uninterrupted power supply (UPS) 300 VA 
o Laser printer 
o CD rewriter for backup purposes. 

 
DOCTORS' COMPUTERS (acting as workstations) 
 

· SOFTWARE 
o MS Windows 2000 Professional  
o Practice 2000 (for the appointment book and the waiting room) 
o Locum, Best Practice or Medical Director for writing prescriptions 
o Antivirus + firewall 
 

· HARDWARE  
o 3-GHz Pentium 4 CPU or equivalent 
o 1 GB of RAM 
o 80 GB HDD/7200rpm 
o 100Mbs Ethernet card 
o Laser printer (with 2 paper trays if possible – 1 for scripts and 1 for letters) 

kjfkdfd 
 

Large or Multi-Site Practices (5+ computers) 
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NETWORK  
 

· 100Mbs network hub/router 
· ADSL Internet connection 

  
SERVER  
 

· SOFTWARE 
o MS Windows 2000 or 2003 Server/Advance Server Edition with Terminal 

Services Licenses 
o MS Small Business package (for SQL Server 2000, Word and other tools) 
o Practice 2000  
o Locum, Best Practice or Medical Director for writing prescriptions 
o Pathology downloading software 
o Real VNC (for remote support) 
o Antivirus/firewall  
 

· HARDWARE  
o Fast, possibly multiple CPU 
o 4 GB RAM 
o 120 Gb HDD/7200rpm (SCSI recommended) 
o 100Mbs Ethernet card 
o Laser printers 
o UPS  
o Tape drive for automatic overnight backup. 
o CD rewriter for additional backup 

 
WORKSTATIONS 
 
Can be anything (e.g. 10-year old Win98 computers) since all processing is done on the 
server.   
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Hardware & network 
setup 

 
Computer Setup 
 

1. Screen resolution: 800x600 pixels for 15' Monitor, 1024x768 for 17' Monitor 
2. Regional setting: English (Australian). Location: Australia. Short Date Style: 

dd/mm/yy . Time format: H:mm:ss. AM symbol: AM. PM symbol: PM. 
3. Install driver for the laser printer. Set paper size to A4. Set as default printer. Share 

the printer.  Normally Practice 2000 prints invoices on the default printer.  If you don’t 
want to print on the default printer, Practice 2000 can be configured to print on any 
printer named INVOICES. 

4. Install driver for the Medicare dot matrix printer, if any. Name the printer MEDICARE. 
Set its Auto Tear Off feature to ON (consult the printer’s manual. This is a lengthy 
procedure). Share the printer. 

5. Install driver for the laser printer that will be used to print the Medicare Claim Form 
(PC1 form), if applicable. Name the printer PC1MEDICARE. Share the printer. The 
PC1 form is available free of charge from HIC. 

6. Install driver for the dot matrix printer that will be used to print patient labels on 
continuous roll, if applicable. Name the printer LABEL . Share the printer. 

7. Install driver for the Dymo Single Label printer that will be used to print patient labels 
on continuous rolls, if applicable. Name the printer DYMOSingleLabel . Share the 
printer. 

8. If there are other printers on the network, install drivers for these printers too. In case 
the local printer is out of order, the network printer could be quickly set as the default 
printer. 

9. If a Medicare Card Swiper is available, plug the keyboard into the Swiper. Then plug 
the Swiper into the keyboard socket in the computer. 

10. Install other softwares such as Microsoft Office 2000, RealVNC (available in the 
Practice 2000 CD-ROM), Symantec PCAnywhere. 

11. Install Modem drivers and other drivers such as scanner, zip drive etc. 
12. If there is a CD rewriter, install Adaptec’s DirectCD or Nero’s InCD for backup 

purposes.  
13. If there is a tape drive for backing up data, schedule system to create a database 

back up of Practice 2000 to the database folder. Create a shortcut on the desktop 
named BACKUP DATA so that the user can run to back up the whole 
\\SERVER\PRACTICE folder. If you use diskettes or zip disks, backup should be 
configured within Practice 2000 (see later). 

 

Network Setup 
 

1. The server on the network should be named simply SERVER.  
2. The workstations on the network should be named CLIENT1, CLIENT2… 
3. The network password for all machines should initially be PASSWORD. For Windows 

XP, enable the guest account 
4. If possible, set all Practice 2000 users as member of Administrator group in server 
5. Share the printers, scanners, etc  
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Printer Setup on Windows NT/2000/XP 
 
Suppose there is a printer named PC1MEDICARE attached to a computer CLIENT1 for 
printing PC1 forms (Medicare Patient Claim form). To print the PC1 form from another 
computer CLIENT2, you have to install the PC1MEDICARE printer on CLIENT2.   
 
The normal network printer installation will create a printer called “PC1MEDICARE on 
CLIENT1”, which Practice 2000 will not recognise.  Practice 2000 requires the printer to be 
named exactly as PC1MEDICARE.  You cannot rename the printer because it’s a network 
printer. 
 
To create a printer called PC1MEDICARE on CLIENT2, please: 
 

1. From CLIENT2, go to Start, Settings, Printers. Double-click icon Add Printers to start 
the Add Printer Wizard and follow these steps in the Wizard: 

2. Specify the choice of 'Local Printer' 
3. Create a new 'Local Port', if necessary, and name the Local Port as 

\\CLIENT1\PC1MEDICARE. If this Local Port, thus named, already exists, just choose 
the option to use it instead of trying to create a new one 

4. Choose the printer make and model associated with the printer PC1MEDICARE 
already existed with CLIENT1 

5. Rename the printer as PC1MEDICARE  
 

Printer Setup in Terminal Services  
(For Windows 2000 Server/Advance Server) 
 

1. On each computer with a printer attached, share the printer 
2. On the server, open the Printers folder.  Add all printers on the network to it.  Make 

sure that the Medicare printer is named “Medicare” and not “Medicare on Workstation 
1”.  Repeat with PC1MEDICARE and LABEL. 

3. On the server, open Administrative Tools, Computer Management, Local Users and 
Groups, Users.   

4. For each user, open the Properties dialog box, Environment tab.  Tick “Connect client 
drives at logon”, UNTICK “connect client printers at logon” and “default to main client 
printer”. 

5. On each workstation, logon into the server. Set the correct default printer.  The 
setting will be remembered. 

 

Multiple sites: how to print Medicare Assignment Fo rms  
 
Suppose the system consists of 2 sites running under Terminal Services.  Each site has a 
dot-matrix printer to print the Medicare Assignment forms.  The printers have to be named 
exactly MEDICARE and MEDICARE2 (“MEDICARE ON CLIENT1” won’t work).   Please: 
 

1. On the server, log in as Administrator 
2. Click Start, Settings, Printers, Add Printer to add two printers named MEDICARE and 

MEDICARE2 for site 1 and site 2, respectively 
3. If you use Practice 2000 Access version: make a shortcut for c:\practice\practice.mde 

named PRACTICE_SITE1, and a shortcut for c:\practice\practice2.mde named 
PRACTICE_SITE2. Practice.mde always prints to MEDICARE, and Practice2.mde 
always prints to MEDICARE2 

4. If you use Practice 2000 SQL:  make a copy of c:\practice\practicesql.mde and 
rename it c:\practice\practicesql2.mde.  Then create 2 shortcuts as in step 3. 
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Practice 2000 Installation 
 
Practice 2000 includes a cutdown version of SQL Server 2000 that supports up to 8 
concurrent queries at the same time. This converts to approximately 5 simultaneous users. If 
you have 6 or more computers in the network that access Practice 2000, you may need to 
consider SQL Server 2005 Express Edition or purchase SQL Server 2000 Standard / 
Enterprise Edition. SQL 2000 Standard / Enterprise Edition can only be installed on Windows 
Server platform.  
 

Installation on Windows 2000/2003 Server with Termi nal 
Services 
 

1. Login as Administrator or a member of the Administrators group 
2. Open your Internet browser, download the Ms Access Runtime Transform file from 

www.abaki.com/termsrvr_art.mst 
3. Copy the MST file to the following directory on your computer. If necessary, create 

the folders as needed:  
C:\Program Files\ORKTools\Toolbox\Tools\Terminal Se rver Tools 

4. Insert the Practice 2000 CD.  Click Start, Settings, Control Panel, Add/Remove 
Programs, Add New Programs, CD or Floppy, Next.  

5. Type D:\Runtime\Setup.exe TRANSFORMS="c:\program 
files\orktools\toolbox\tools\terminal server tools\ termsrvr_art.mst"  (there’s a 
space between the words PROGRAM and FILES) 

6. Follow instructions until the Microsoft Access 2000 Runtime program is installed  
7. Back to Add/Remove Programs, Add New Programs, CD or Floppy, Next.  
8. Follow instructions until the Practice 2000 Installation program appears  
9. In the Practice 2000 Installation screen, choose the Full installation option  
10. Always install Practice 2000 in the C:\PRACTICE folder, or else it may not work 

properly. Press Enter to accept all default answers until the installation is completed.  
11. You will be asked to install the Microsoft Database Desktop Engine (MSDE 2000).  

Answer yes if you do not have SQL Server 2000 or 2005 previously installed on the 
system.   

12. Practice 2000 keeps its programs in the C: drive, but you can move the data files to 
another drive, e.g. D.  To do this, simply copy the whole C:\PRACTICE folder to 
D:\PRACTICE. 

13. No need to do anything for the workstations other than configuring printers. 
 

Installation on normal servers  
 

1. Login as Administrator or a member of the Administrators group 
2. Insert the CD. The Practice 2000 setup program should run automatically. If not, click 

Start, Run. Type D:\Install and click OK (replace D: with the correct CD drive letter if 
necessary) 

3. In the Practice 2000 Installation screen, choose the Full installation option  
4. Always install Practice 2000 in the C:\PRACTICE folder, or else it may not work 

properly. Just press Enter to accept all default answers until the installation is 
completed.  

5. You will be asked to install the Microsoft Database Desktop Engine (MSDE2000).  
Answer yes if the computer is the server, answer no if it’s workstations.  MSDE2000 
is a free, cut-down version of Microsoft SQL Server 2000.  
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6. Practice 2000 keeps its programs in the C: drive, but you can move the data files to 
another drive, e.g. D.  To do this, simply copy the whole C:\PRACTICE folder to 
D:\PRACTICE. 

7. Repeat the steps 1-5 above for each computer in the network 
 

Attaching to a blank new database 
 
After full installation, when you open Practice 2000, you’ll see fictitious patients and doctors.  
This is a demo database for you to play around with.  When you have finished learning 
Practice 2000, do the following to open a blank new database to start real work. 
 

1. On the server , share the C:\Practice folder with Read / Write permission as Practice 
(or share the D:\Practice folder if you want to store data in the D drive) 

2. Click Start, Programs, Practice 2000, Workgroup Admin 
3. Click Join. Assuming that the Server is named SERVER, type in 

\\SERVERServer\Practice\System.mdw. Click OK, OK, Exit. 
4. Double click the Practice 2000 SQL shortcut on the desktop to run the software  
5. From the Main Form, click Admin Tasks, Setup tab, Attach Database.  
6. Type  C:\Practice\Practice.mdf (or D:\Practice\Practice.mdf if data is on the D: drive). 

Leave the user name as SA, password by default is nothing (or password  if using 
SQL Server service pack 3 or later). Then click OK. 

7. Repeat steps 2-6 on all workstations.  In step 7, type \\Server\Practice\Practice.mdf 
rather than C:\Practice\Practice.mdf 

 
You might already have patient demographic data from a previous computer system.  They 
should now be transferred into Practice 2000.  Medclaims, HIC Online, and linking to Medical 
Director/Locum should also be configured (see the next section) 
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Entering practice details 
 
Before using Practice 2000, we need to set up lists of accounts, doctors, fee scales, items, 
etc. These lists are rarely changed.  To do the setup, on the server, from the Main Form, 
click Admin Tasks, Setup tab. Click each button in turn to enter data. 
 
Doctor Accounts   
 
These are providers’ bank accounts that will receive patient payments. Each provider can 
have a separate bank account.  Sometimes several providers share the same bank account. 
 

Business Addresses 
 
A practice is usually run as a single business e.g. Highett Road Medical Centre. This 
business has an address and other details such as the Australian Business Number (ABN).  
When billing the patients, these details will be printed as the letterhead for the invoices.  The 
letterhead will also be used in recalls, correspondence, etc. 
 
To create a letterhead, click on “New Business”, and then enter the details in the white 
boxes. This standard letterhead is good for general use. For advanced users who want to 
have a professional-looking letterhead, please: 
 

1. Create a Microsoft Word document for your letterhead. It can contain graphics. The 
letterhead is limited to 3.5 cm in height.  Both the left and the right margins should be 
1.5 cm 

2. Save the document, e.g. as C:\MYLETTERHEAD.DOC 
3. In the Business Addresses form, click Customize.  
4. In the Insert Object dialog, tick Create From File, type C:\MYLETTERHEAD.DOC 
5. Remove the tick in the Display as Icon checkbox, then click OK. 

 
A specialist working at 3 sites should have just one letterhead containing 3 addresses. He 
definitely needs to use the above procedure to customize the letterhead.  
 
Sometimes a practice runs 2 businesses, e.g. a medical business and a physiotherapist 
business.  You need to create 2 separate letterheads.  An unlimited number of businesses 
can be created in Practice 2000. 

 
Letterheads can be suppressed to allow the use of stationery containing pre-printed 
letterheads: click Admin Tasks,Setup, Letterhead, answer Yes. 
 
Note: If you are running Norton Antivirus, make sure that script blocking is disable or 
customized business address will not work. 
 

Fee Scales  
 
They are sometimes called Fee Types or Fee Schedules.  Some standard scales are Bulk 
Billing 85% Medicare, Private Patient, Veterans’ Affairs and Work Cover. Users are advised 
not to change any standard fee scale. 
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If your practice does mainly Bulk Billing, select this fee scale as the default fee scale for new 
patients (there’s a box on the Fee Scales form for this option) . Otherwise, select Private 
Patient as the default scale. 
 
Practice 2000 usually comes with GP items. If you are a specialist, you might wish to delete 
all these items so that you can enter specialist items. To delete them, click Delete All Items. 
(Any item that has been used in invoices will not be deleted.) 
 
For some clinics, especially with specialists, there can be up to 30 fee scales available. 
Some of them are used more frequently than others. Therefore they should be on top of the 
list. Just give a large ListOrder to the fee scale. The fee scale with the largest list order 
number will be on top of the list 
 
Creating New Fee Scales 
 

· In the Fee Scales form, click New Scale. 
· In the Fee Code box, type a letter or a word that has not been used before (e.g. H for 

HBA or PH for Physio) 
· In the Fee Name box, type in the full name of the scale (e.g. HBA). If you do not type 

in anything, the feescale would still be created but will be displayed as a blank 
feescale on the list 

· Suppose all invoices under the HBA fee scale are to be billed to HBA.  Please click 
the Change button next to the Default Payer box to select (or to create) HBA from the 
database.  If the invoices are to be billed to different payers (e.g. Workcover), just 
leave the box blank. 

· Some fee scales such as Medicare Bulk Billing and HBA require the batching of 
invoices. Some scales such as Child Immunization allow sending the batch 
electronically.  Some scales such as WorkCover require a claim number in the 
invoices. Please tick the appropriate check box. 

· Change the Charge (GST-inclusive fees) for the items (and the GST rates, if 
required). 

· Close Practice 2000 on all computers for the new fee scale to take effect. 
· An unlimited number of fee scales can be created 

 
A list of GP items is supplied as standard with Practice 2000. We can supply items for Gynae 
& Obstetrics, Ophthalmologists and Psychiatrists, etc.  Please contact us for more details.  
 
Creating New Items 
 

1. In the Fee Scales form, click New Item. Type in a short item code, either numeric 
such as 12345, or alphabetic such as MEDREPORT  

2. Decide if you want to create the item for all scales or only the current scale.  You will 
get a new line in the table of items.  Fill in the details for this item as follows. 

3. Select the type for the item. Procedure means the item’s Charge will be halved or 
quartered when the Multiple-Procedure Fee calculation method is used. Consultation 
means the item’s Charge will always remain the same. If Type is left blank, it defaults 
to Consultation 

4. Enter the Charge (GST-inclusive fee) for the item 
5. For most medical items, the GST rate should be left blank or entered as 0%.  Medical 

reports attract a 10% GST.  The GST rate for an item can change with fee scales. 
6. Enter a short item description. The description will be printed on invoices.  The 

description in the Medicare Benefit Schedule book is too lengthy to be used. 
7. The MBS Type is defined in the Medicare Benefit Schedule book. It should normally 

be left blank.  Only Radiologists need to select the type in order to calculate the fees 
for Diagnostic Imaging services.   
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8. Some practice pays doctors 50% on some items (e.g. consultation items) and 30% on 
others (e.g. pregnancy tests).  If you want to group these items separately in the 
income reports, please enter the Group name for each item.  The group name can be 
numeric such as 30, or alphabetic such as HALFPAY. 

9. If you want the item to appear on top of your item list when doing invoices , enter a 
large number in the List Order field, e.g. 1000.  If two items have the same list order, 
they will be sorted numerically (or alphabetically). 

10. The ID field is used by the computer and cannot be changed. 
11. Click New Item to do another item. Close the form when finished. 
12. An unlimited number of items can be created 
 

Removing Items: Click the Item then click “Delete Item”.   
 
Merging Items 
Suppose you have an item code MR and another item code MEDREP.  You want to change 
all items MR to item MEDREP.   
 

1. Click Merge Items.   
2. In the Merged Item box, type MR.  
3. In the New Item box, type MEDREP.   
4. Click the Merge button. The item MR will disappear, leaving only item MEDREP. 

 
If you merge 2 items with the same code, you must be sure which one to be removed (ie. the 
Merged Item), by looking at the Charge, Description, etc., then proceed as above. 
 
Discount Items: To give a discount to patients, create a new item with the code 
DISCOUNT. Enter a negative fee, e.g. -5.00$. 
 
Medicare Fees: Medicare fees for MBS items are supplied and updated regularly. To 
put the fees in:  
Click the Start button in Windows, Programs, Practice 2000, Update Medicare Fees. This will 
update the Bulk Billing fees and the 100% MBS fees. 
 
Changing Private Patient Items fees 
 

1. In the Fee Scales form, click the down arrow in the Select Fee Scale box, select 
Private Patient 

2. Change the fees of each item, then press the down arrow on the keyboard  
 
You can multiply fees from one schedule by a given factor to create fees for another 
schedule . For example, suppose you want fees for private patients to be 110% of the full 
MBS:  
 

1. In the Fee Scales form, click the down arrow in the Select Fee Scale box, select 
Private Patient 

2. Click Copy Fee.  When asked for the fee scale to copy from, type 5 then click OK (5 
is the fee code for the full MBS) 

3. When asked for the multiplying factor, type 1.1 then click OK (ie. 1.1 = 110%) 
4. When asked for a constant to add, type 0 then click OK 

 

Doctors 
 

· Click New Doc to enter doctors and other providers such as sisters and 
physiotherapists. Even your family trust can be entered as a doctor (so that the trust 
can bill other doctors for servicing the medical practice).  
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· The Provider Number field is mandatory.  If a provider does not have a medical 
provider number, enter the provider number as 1, 2, 3 etc.  There will be a warning 
message that the provider number does not have 8 characters; ignore it.  

· If a doctor has two provider numbers, create two doctor records and enter them 
separately and add something to the surname to differentiate, eg. if Dr Smith works at 
Richmond and Fitzroy, you can write the surnames as SMITH (R) and SMITH (F). 

· The Bank Account field is mandatory .  When you receive payments from patients, 
Practice 2000 needs to know which bank account to put the money into.  

· For short-term locums, please fill the Locum To field.  The message “Locum To Dr. 
...” will be printed on invoices so that Medicare can remit money to the main doctor. 

· When a provider leaves the practice, untick the "Available To Work" check box. The 
provider will not be listed when creating invoices.  Do not delete the Provider record 
since the data are required for existing invoices. If the doctor is on the appointment 
book, change his column number to non-numeric value. 

· For specialists, tick the "Referral Required" check box.   
· The doctor list is used in many places in Practice 2000, for example when creating 

invoices.  If a doctor is popular, he/she should be put on top of the list.  Just give a 
large "List Order" number to the doctor.  The doctor with the largest List Order 
number is on top of the list. 

 

Transaction Types   
 
Some of the most popular types are already available such as Cash, CHEQUE, and Credit 
Card etc. Please do not change existing types. You can add more types at the bottom of the 
table. Write the type name in the second column.  The first column will automatically be given 
a number 
  
Patient Accounts 
 
The following options can be configured from the Patient Accounts button: 
 

1. Print each patient on a separate invoice when billing several patients to a single 
WorkCover company. 

2. Edit/Modify the message to be printed at the bottom of the original invoice. The 
standard message is “Please keep this original account for claiming medical 
benefits”. 

3. Edit/Modify the message to be printed at the bottom of the duplicate invoice.  The 
standard message is “This is NOT the original account” 

  

Appointments 
 

1. Supply surgery information. If working hours are 8 am to 6 pm, enter 7:30 am to 6:30 
pm to allow for emergency appointments.  

2. Enter data for the "Appointment length". We recommend 10 minutes (even though a 
doctor can take 15 or 30 minutes per patient). This gives 6 appointment slots per 
hour.  The doctor who works on 15-minute appointments needs only 4 slots per hour.  
You can block off one out of 3 slots for this doctor (See the Appointment Book section 
on how to mark off slots). If a doctor works on 30-minute appointments, block off 2 
out of 3 slots. Note: The appointment interval cannot be changed later on, so please 
be careful. 

3. Old appointments will be deleted automatically so that searches can be made more 
quickly. We suggest you keep appointments of the past 100 days only. If you want to 
find out when a patient visited the practice, use the Invoices form.  

4. The appointment book has many columns. To allocate a column to a particular 
provider: 
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a. Ensure the provider has already been entered as a doctor.  (If not, click Admin 
Tasks, Setup tab, Doctors, New Doc, then enter the provider details.  Close 
the Doctors form and the Admin tasks form) 

b. In the Appointment Setup form, click Columns for Doctors.  A table will be 
displayed, showing the names of the providers. In the last column of the table 
(entitled “Column Num In Appointment Book”), type in the column number for 
each provider, e.g. 1,2,3. Each provider must have a different column number.  
The provider who works the hardest should be allocated to the first column. 

5. There is no need to allocate a second column to a provider in order to do double 
bookings. The appointment book allows you to create another row whenever double 
or triple booking is required. 

6. If there are many providers in your practice, you can make the columns narrower so 
that more columns will be visible on the screen. Conversely, if you have only 1 or 2 
providers, you can make the columns wider. Click Column Widths and enter the 
widths in mm. 

7. Sometime the doctors want to know the receptionist who book/cancel the 
appointments. Checking the appropriate checkbox will force users to enter their 
initials anytime the work with appointments book 

8. Practice 2000 can check to see whether a patient has made a duplicate booking if 
Check for future booking checkbox is ticked. 

 

Waiting Room/Invoices 
 
The following options can be configured to tailor the billing process to each particular clinic: 
 

1. New invoices shall NOT have a default doctor or item. Enabling this option allows you 
to print a blank Medicare voucher containing only patient details. 

2. New invoices shall NOT have a default item. Enabling this option allows you to print a 
Medicare voucher having patient and doctor details, but NO items. 

3. For new invoices, the default doctor will be the current doctor, not the doctor who saw 
this patient previously. Enabling this option if you have only one doctor in the surgery 
at this time. 

4. Print Medicare assignment form for bulk-billed patients as soon as they arrive at 
waiting room. It is not recommended to enable this option 

5. Print Medicare assignment form for bulk-billed patients when they leave waiting room   
6. Display Patient details when the patient enters the Waiting Room 
7. When finding a patient, start the cursor at File# box (note: the cursor normally starts 

at Surname box) 
8. When a bulk-bill patient arrives at waiting room, print a default item on M/care 

assignment form 
9. Print a bill for Private/WorkCover patients as soon as they arrive at the w/room  
10. “I assign my right to benefits to the practitioner”, or “I assign my right to benefits to the 

PATHOLOGY practitioner” 
11. Use Plain A4 paper for printing (for clinics which do not use a dot-matrix printer for 

Medicare forms) 
12. Print invoice number and patient's arrival time on Medicare Assignment Forms 
13. Print Medicare form for ALL patients (including private, TAC...) when they enter 

w/room so you can see file number. Tear off unused Medicare afterwards. 
 
If this computer runs Windows NT and also prints the Medicare Assignment forms on a dot-
matrix printer:  
 

1. Click WinNT Medicare Printer Setup.  
2. In the Page Setup screen, click the Page tab. Ensure that the Paper Size is Medicare 

(or any WinNT paper form with size 8” width x 8.5” length), Source is Tractor, and 
Use Specific Printer is selected. 
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3. Click the Printer … button, and ensure that the printer name is MEDICARE. Click OK, 
OK.  

4. Close the “Medicare Assignment Report”; say Yes to saving the changes. 
 
If this computer runs Windows NT and also prints patient labels on a dot-matrix printer:  
 

1. Click WinNT Label Printer Setup.  
2. In the Page Setup screen, click on the Page tab, ensure that the Paper Size is Label 

1.5” (or any WinNT paper form with size 4” width x 1.5” length), Source is Tractor, use 
Specific Printer is selected. 

3. Click the Printer … button, and ensure that the printer name is LABEL. Click OK, OK.  
4. Close the Report; click on Yes to saving the changes. 

 

Recalls  
Click the Default button to use the default settings. These are suitable for most practices. 
 
Postcodes   
This is the list of all suburbs and postcodes in Australia. You can add new suburbs at the 
bottom of the table. This table is updated twice per year with each release 
 
Letterheads  
This option allows you to select pre-printed stationery that already has letterheads 
 
Attach Database    
 
A database file contains all the patients, doctors, appointments, and invoices etc, i.e. 
everything you have ever keyed into Practice 2000.  When you first install Practice 2000, it is 
attached to C:\Practice\Pracdemo.mdf.  These files contain fictitious patients and doctors.  
To do real work, please: 
 

- Ensure that MS SQL Server or MSDE 2000 is running on the Server.  You should see 
the SQL Server icon on the tray near the clock at the bottom right corner of the 
screen.  (If not, click Start, Programs, Startup, Service Manager, then click 
Start/Continue). 

- In Admin Tasks, Setup, click the Attach Database button. 
- Click on Browse and choose the correct database. Usually it is 

C:\Practice\Practice.mdf on the server and \\Server\Practice\Practice.mdf on the 
workstations. 

- Enter the username and password. The default User name is SA, the default 
password is either blank or password.   

- Click Attach.  Practice 2000 will connect to the chosen database. 
- Restart Practice 2000 SQL as required  

 
Setting up Practice 2000 to interface with Best Pra ctice 
 
Best Practice is a clinical software package.  The transfer of patient data is via the file 
PATIENTS.IN as with Medical Director. 
 

1. On the server, open Practice 2000.  In Admin Tasks, Setup, click Script Software.  
2. Enter 1 for Medical Director, and then click OK to accept  
3. When asked for the Medical Director folder, enter the full path name to the folder 

where Medical Director data is kept, e.g. \\SERVER\MDW2\. Then click OK 



 

20  
 

4. On each other computer in the network, run Practice 2000. When asked for the 
Medical Director folder, type \\SERVER\MDW2\ or similar. 

5. On each computer, click the Tools menu, Options, Advanced tab.  Change the 
OLE/DDE Timeout to 300 seconds. 

 

Setting up Practice 2000 to interface with Medical Director  
Medical Director 2 
 

6. Install Medical Director 2 on Server. 
7. On Server, open Practice 2000.  In Admin Tasks, Setup, click Script Software.  
8. Enter 1 for Medical Director, and then click OK to accept  
9. When asked for the Medical Director folder, enter the full path name to the folder 

where Medical Director data is kept, e.g. \\SERVER\MDW2\. Then click OK 
10. On each other computer in the network, run Practice 2000. When asked for the 

Medical Director folder, type \\SERVER\MDW2\ or similar. 
11. On each computer, click the Tools menu, Options, Advanced tab.  Change the 

OLE/DDE Timeout to 300 seconds. 
 
Medical Director 3 
 

1. Install Medical Director 3 on Server. 
2. On the server, Run Practice 2000.  In Admin Tasks, Setup tab, click Script Software.  
3. Enter 1 to choose Medical Director, then click OK.  
4. Click OK again to close a message. 
5. When asked for the Medical Director folder, enter the full path name to the folder 

where Transfer.out is kept, e.g. \\SERVER\HCNData Then click OK 
6. On each other computer in the network, run PRACTICE 2000. When asked for the 

Medical Director folder, type \\SERVER\HCNData or similar. 
 

To write scripts for a patient: 
 

1. In the Waiting Room form and the Appointment Book, click on a patient, and then 
click the MDW/Locum button. MDW will be opened, displaying the chosen patient  

2. Alternatively, in any form where you can see a patient (e.g. the Patients form, 
Invoices form etc), click the RX icon on the Patient toolbar on the top. 

 

Setting up Medical Director to interface with Pract ice 2000 
 
Medical Director 2 
 

1. On the server , run Medical Director.  Create a new user called MANAGER, type 
PRACTICE MANAGER, password PASSWORD.   

2. Close MD2.  Run it again, log in with the password PASSWORD. 
3. Close down any patient.  Click Tools menu, Options, Links tab.  
4. Tick the check boxes for: Link to Billing Package. 
5. Tick the box “Read Link File From This Computer”.   
6. In the box for Path To Transfer File, type the full path to the shared PRACTICE folder, 

e.g. \\SERVER\PRACTICE\ 
7. In the box entitled Path For TRANSFER.OUT File, type the full path to the shared 

MD2 folder, e.g. \\SERVER\MDW2\.  Click Save twice  
8. MAKE SURE THAT MD2 ALWAYS RUN ON THE SERVER, otherwise the new 

patients will not appear on MD2 for the doctors. 
9. MAKE SURE THAT THE LINK FILE PROCESSOR IS NOT RUN ON ANY 

COMPUTER 
10. On each workstation , run Medical Director and log in as a doctor.  
11. Close down any patient.  Click Tools menu, Options, Links tab.  
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12. Tick the check boxes for: Link to Billing Package. 
13. MAKE SURE THE BOX “READ LINK FILE FROM THIS COMPUTER” IS NOT 

TICKED. 
14. In the box entitled Path For TRANSFER.OUT File, type \\SERVER\MDW2\ 
15. Click Save and close MDW2 

 
Medical Director 3 
 

1. On the server , run HCN Maintenance.  
2. Click on  Database Tasks, Medical Director then double click on Link File Processor  
3. Select your name from the list and put in your password, click on OK 
4. A link file processor icon will appear on the taskbar. Right click on it then click on 

option 
5. In the box for Link File Format, select GENERIC ASCII V2 
6. In the box for Path To Transfer File, type the full path to the shared PRACTICE folder, 

e.g. \\SERVER\PRACTICE\ 
7. Tick on Load Link File Processor at start-up. Tick on Log Transactions. Enter 60 as 

Link Interval. Enter 50 as Link File Size Limit. 
 

Synchronization between MD 2 & Practice 2000 
 
You need to do the synchronization once when you first install Practice 2000. You do 
synchronization again whenever Medical Director is unable to open a patient, or if Medical 
Director has duplicate patients. Only Medical Director 2 supports this feature. 
 

1. Find a quiet time, e.g. after hours. 
2. Close MD on all computers 
3. On the server, in Practice 2000, click Admin Tasks, Setup, Send To Script Software. 

This exports all patients into the file PATIENTS.IN. This file can be found in the 
directory containing PRACDATA.MDB, say \\SERVER\PRACTICE. 

4. Click Start, Programs, Medical Director, Maintenance, Data Transfer tab, Import. 
5. Enter password, click on Next. 
6. Select Yes.  Click Next. 
7. Select Demographics, click on Next. 
8. Select the file format GENERIC ASCII V2 - PATIENTS.IN.  Click Next. 
9. Click Browse to select the folder containing the files PATIENTS.IN and 

PRACTICE.MDF (usually C:\PRACTICE\).  Click OK. 
10. Click Next. MD2 will read each patient record in. The process can take 1 hour.  
11. At the end, when asked if you want to empty the PATIENTS.IN file, answer YES.  

 

Interfacing with the Locum 3 prescription writing s ystem:  
 

1. From Admin Tasks, Setup tab, click Script Software.  
2. Enter 3 then click OK. 
3. Consult Locum3 manual to see how to interface to Practice 2000 (Usually: in Locum 

3, click File menu, Preferences, Direct Link, select PRACTICE 97/2000 or PRACTICE 
2000 SQL) 

4. Locum3 is fully integrated with Practice 2000.  
 
 

Backup 
 
The SQL Server controls the database files PRACTICE.MDF and PRACTICE_LOG.LDF all 
the time.  You cannot copy them directly without stopping the Server. A more convenient 
method is to convert those two files into a PRACTICE.DAT file before backing up. Backup 
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can ONLY be done on the Server. Assuming that C:\Practice is the database folder on the 
Server, the following files need to be backed up:  
 

· C:\Practice\Practice.dat  
· C:\Practice\Letters\ 
· C:\Practice\LetterTemplates\  
· C:\Practice\HICOnline\hic.psi (if HIC Online is used) 
· C:\Practice\system.mdw 

 
On the server, in Admin Tasks click Backup 
 

1. Click Options on the bottom left. Enter C:\Practice\Practice.dat as the SQL Backup 
File. Tick on Use External Zip Encoder.  Click on Set Default Values and click on 
YES. Click OK 

2. Add files and folders you need to backup to the list. Generally you need 
C:\Practice\Practice.dat, C:\Practice\Letters\*.* a nd 
C:\Practice\LetterTemplates\*.*    

3. Suppose your backup medium is drive D.  This could be a CD, a DVD or a USB 
memory stick. (Nero InCD or Roxio EasyWriter is required if you want to backup 
directly to the CD or DVD)  Enter D:\ as the destination folder for backup. 

4. Enter the name for your backup file or let Practice generate it base on the date of 
backup 

5. Click Save Settings to save the changes.  
6. Click Next to backup.   

 
If you use tapes for backing up  
 
Depends on the back up software that you use, it may or may not be able to copy the 
database files while SQL Server still place a lock on it. If you are not sure, it is recommended 
to generate a backup file first before attempting to copy. 
 
Create a batch file with the following contents. It will make a back up of the database 
Practice to C:\Practice\Practice.dat. You can use Windows Tasks Scheduler to schedule it to 
run at any specific time of the day 
 

osql -S 10.0.0.1 -E -Q "BACKUP DATABASE Practice TO 
DISK='C:\Pracdata\Practice.dat' WITH INIT, NOUNLOAD, NAME='PRACTICE BACKUP', 
NOSKIP, STATS=10, NOFORMAT" 

 
A sample batch file is: 

 
@ECHO OFF 
 
for /f "tokens=1,2,3 delims=/ " %%i in ('date /t') do set logdate=%%k%%j%%i 
 
@ECHO ON 
 
osql -E -Q "BACKUP DATABASE PRACTICE TO  DISK = 
N'C:\PRACTICE\%logdate%.dat' WITH  INIT ,  NOUNLOAD ,  NAME = 
N'Practice Backup',  NOSKIP ,  STATS = 10,  NOFORMAT" 
 
c:\practice\pkzipc -add=update P:\Practice2000\%logdate%.zip 
C:\Practice\%logdate%.dat C:\Practice\Letters\*.* 
C:\Practice\LetterTemplates\*.* C:\Practice\HICOnline\hic.psi 
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Transaction categories 
 
These are income/expense categories, e.g. telephone, power. You can add any categories 
you like.  Please do not change the first entry, Sales/Service. 
 
Label printer 
 
Normally patient labels are printed on the default printer, which must be a laser or an inkjet.  
This option allows you to use a dot-matrix printer to print labels. Large practices sometimes 
use this option. 
  
PC1MEDICARE Printer 
 
For private patients, you can print the Medicare Claim Form (PC1) to help them claim 
Medicare benefits.  The PC1 forms are normally printed on the default tray of the default 
printer.  Some printers have 2 trays. To print on the second tray of the printer: 
 

1. Adds another printer in Windows, call it PC1MEDICARE. Do not set it as the default 
printer. 

2. Set its second tray as the default tray. 
3. In Admin Tasks, Setup, click PC1 printer, click on Yes. 
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HIC Online/Eclipse 
installation  

 
HIC Online allows medical practices to send Patients Claims for private patients to the HIC 
over the Internet.  You can also send Medicare, DVA and Child Immunisation claims.  
Eclipse is a part of HIC Online that allows specialists to send claims electronically to health 
funds on behalf of patients.  Dentists can use Eclipse for in-patient claims (i.e. services are 
provided at a hospital), but not for services provided in a private practice. 
 
IMPORTANT NOTE:  Before installation, please ensure that you have: 
 
· The Practice 2000 CD  
· If you have applied for individual certificates, all the iKeys from HIC and all the papers 

containing the passwords for the keys. 
· The floppy disc or CD containing the location certificate  and the letter containing the 

PIC pass phrase (we strongly recommend you not to use the Individual Certificate which 
comes as a USB key). 

· Please make sure that you have completed the 
online registration at 
http://www.hesa.com.au/HIC_online.htm. 

· Practice 2000 SQL version 2.91 or later (look on the 
Main form) 

 
 

STEP 1: Software installation (This must 
be done on all computers that transmit HIC Online.) 

 
· Insert the Practice 2000 CD into the CD-Rom 

Drive.  If auto-run is enabled, the installation 
screen will appear. If not, click Start, Run. Type 
D:\Install.exe (change D to the letter of your CD-
Rom)   

· On the installation screen, click on HIC Online. 
Follow the onscreen instructions. It would install 
all the software required for HIC Online (HIC Online components, PKI Certificate 
Manager, Java Virtual Machine, iKey drivers).  

 
If you already installed HICOnline version 2.8, do not do step 2 -> 4 
 

STEP 2: Install the Location Certificate (Do this on the server only. Every 2 
years you get a new certificate from Medicare Australia and you have to do this step again) 

 
Go to Start, Control Panel and double click on HIC PKI Certificate Manager 
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Click on Setup button on the HIC PKI Certificate Manager main window as shown below.  
 

 
 
Select the Create a New Store radio button and click Next .  
 

 
 

The Store Setup Wizard will now ask you to select the store’s location. Type 
C:\Practice\HICOnline\hic.psi and click Next  

 
The Store Setup Wizard will ask you to create a password for your store. On the 
Password and Confirm, type password00 and then click the Finish button to create the 
store.  
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To install the Location certificates, select the Install button.  
 Enter password00 and select the Next button 
 

 
 
Select floppy or CD supplied by HeSA, or another convenient location that you may have 
copied the files to. Click Next to continue.  

 

 
 

Enter password, remember the PIC is case sensitive and must be entered exactly as it 
was received from HeSA. Select Next to continue.  

 
 

STEP 3: Copying the Crypto Store (This should be done on all workstations 
every time you install a new certificate on the server)  
 

· On each workstation, run Practice 2000 
· Click Admin Tasks -> Set up -> HIC online Setup 
· Click on Crypto Copy  
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STEP 4: Configuring Practice 2000 (server only) 
 

· Open Practice 2000. Click on Admin Tasks -> Set up -> HIC Online Setup 
· Click Reset. Enter your initials and click OK.  
· Enter the minor customer ID and click OK 
· Click Yes when asked if you want to transmit HIC Online immediately 
· Click OK to save the settings 

 
 

Supporting HTTP Proxy Server Authentication 
 

When the HIC Online Client Adapter (CA) is installed on a network that uses a proxy server 
additional environment configuration is required to point the CA through the proxy in a similar 
way that a web browser is configured to use a proxy.  

User authentication involving the entry of a UserID and password is often required.  

Setting up the Proxy Server 
Use of a proxy server with HIC Online requires the setting of two environment: 
Environment Variable Value  

easy_parmX  

-Dhttp.proxyHost=<proxyname> 
where<proxyname> is the name of the proxy eg. 'webproxy'  

Note: <proxyname> may be an IP address, DNS or host table entry. 

easy_parmY  -Dhttp.proxyPort=<port> 
where <port> is the port number eg. '8080'  

* where X and Y are numbers from 1-20 that have not been, and will not be, used to describe 
any other easy_parm variables.  

Note: using the prefix -D when setting the easy_parm variables will store the values as Java 
system properties. Setting the easy_parm variables in this manner must be done if you are 
intending to bypass the cdll and access the java components directly. 

Proxy settings found in an Autoexec.bat (or, for non-Win98 users, specified via the 
Environment tab) might look like this: 
 
SET easy_parm3=-Dhttp.proxyHost=webproxy 
SET easy_parm4=-Dhttp.proxyPort=8080 

Win98 Users 
Win98 must have environment variables set in the Autoexec.bat, see above for an example. 
 
Win98 will not allow more than 1 equals sign in a single set statement, to avoid this use"++" 
instead for the second instance of "=": 
eg. SET easy_parm1=-Dhttp.proxyHost++webproxy 
 

 
RENEWING THE LOCATION CERTIFICATE 
 
Every 2 years you get a new certificate from Medicare Australia and you have to do this step 
again 
 
- When the clinic receives a new certificate, do not install until within 7 days of expiry of the 

existing one.   
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- On the server, close Practice 2000.  
- Open My Computer.  Double-click the C: drive.  Double click the Practice folder.  Double 

click the HICOnline folder 
- Right-click the file hic.psi, left-click Rename.  Change the name hic.psi to hic.psi1  
- Click Start, Control Panel.  Look for the HIC PKI Certificate Manager icon. 
 
- If you cannot see the icon: 

o Close the Control Panel.  Click Start, Run.  Type 
http://www.medicareaustralia.gov.au/resources/pki/certificate_manager/mai_pki_utiliti
es.zip then click OK 

o Click Open to start downloading the file 
o When WinZip (or similar program) displays a list of files, double-click the last line 

(HIC PKI Certificate Manager Installer.exe) to install the program 
 

- Click Start, Control Panel.  Double click on HIC PKI Certificate Manager.  
- Click the Setup button on the HIC PKI Certificate Manager main window. 
- Select the Create a New Store radio button and click Next. 
- The Store Setup Wizard will now ask you to select the store's location. Type 

C:\Practice\HICOnline\hic.psi and click Next 
- The Store Setup Wizard will ask you to create a password for your store. In the Password 

and Confirm boxes, type password00 and then click the Finish button to create the store. 
- To install the Location certificates, click the Install button. 
- Enter password00 and click the Next button 
- Select floppy or CD supplied by HeSA, or another convenient location that you may have 

copied the files to. Click Next to continue. 
- Enter the PIC supplied by HIC, remembering that the PIC is case sensitive and must be 

entered exactly as it was received from HeSA. Click Next to continue. 
- Follow the prompt on the screen to complete the installation of the new certificate 
- Now select the old certificates and delete them please. 
- Close HIC Certificate Manager.  The setup for the server is now complete. 
- On the workstations that you want to transmit HIC Online, run Practice 2000, go to Admin 

Tasks, Setup, HIC Online Setup, Crypto Copy. It will copy the certificate from the server 
to the workstation.  (No need to do this step if the workstation is not used for HIC Online 
transmission.) 

 
DVA Paperless Claiming with Practice 2000 SQL 
 
Electronic claims with the Department of Veterans Affairs are no longer required be 
accompanied by a hard copy presented on an approved DVA form. The provider is still 
required to present the patient with a copy of the DVA Printed statements for their approval 
and signing. 
 
DVA claims will be assessed in accordance with DVA assessing rules. Claims with prior 
approval items will require referral to DVA for assessment.  
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Advanced options 
 
There are many advanced options to customize the working of your Practice further.  To set 
up these options: 
 

1. In Admin Tasks, Advanced tab, click on Miscellaneous.  A table will be displayed. 
2. Scroll to the bottom of the table. The last line is empty. Type in the parameter in the 

first column. In the second column, type in the desired value. 
3. Close the table. 
  

See below for the meanings of some specific parameters: 
 
Total Account Rendered (i.e. total amount outstanding) is normally printed in Tax Invoices for 
private patients. If you don't want to print it: param=PrintTotalAccountRendered , value=NO 
When entering new patients, Minor File number can be automatically given (except for the first 
person): param=MinorFileNumRequired , value=TRUE 
Can use Single Label Printers such as those made by Seiko to print patient labels and family 
labels: param=SingleLabelPrinter , value=True. You need to create a new printer icon named 
"Single Label" 
To prevent printing Veterans vouchers from the Waiting Room: parameter=VeteransNoPrint , 
value=TRUE 
When opened, Practice 2000 automatically attaches to the database used when last opened. To 
prevent this: parameter=DatabaseNoAttach , value=TRUE. This is useful to, eg. create 2 copies 
of Practice 2000 to run 2 different databases, e.g. PRACDATA.MDB for work and 
PERSONAL.MDB for personal use. Just copy PRACTICE.MDE into PERSPROG.MDE, run 
PERSPROG.MDE and attach it to PERSONAL.MDB. 
The bottom part of invoices is the return slip. If you allow patients to pay by credit card, you can 
allow room for credit card payment details in the return slip: 
parameter=CreditCardPaymentAllowed , value= TRUE 
Some practices reduce fee when a patient exceeds eg. 10 visits in a year or the whole family 
exceeds eg. 20 visits. Practice 2000 can give a warning when the number of invoices for the 
patient has exceeded the limit: parameter=InvoiceNumWarning , value=10, and 
parameter=InvoiceNumFamilyWarning , value=20. The year is started from 
parameter=invoicenumStartDate , value=dd/mm. Only Private patient fee scale invoices are 
counted if you use the parameters PrivateInvoiceNumWarning and/or 
PrivateInvoiceNumFamilyWarning    
When searching for patients in the Find Patients form, Practice 2000 immediately displays a list 
of patients as you type in each character.  On large databases and slow networks, this can take 
too long.  To prevent immediate search for patients after each typed letter: 
parameter=FindClientsImmediately , value=FALSE 
Each day, you can see which doctors are available to work today by going into Main Form, More 
tab, and clicking Available Doctors. When opening Practice 2000, it can automatically asks you 
to select available doctors: parameter=DoctorsAvailableSetup , value=YES. 
Patient File Number can be made unchangeable to avoid inadvertent changes: 
param=FileNumNoChange , value=TRUE 
Practice 2000 normally uses 1.5” laser labels. To print patient label on 1" labels: 
param=CardLabel1inch , value=TRUE.  1" label is NOT recommended. 
In a multi-disciplinary practice, e.g. dental + medical, dental patients can have their own file 
numbers separate from medical patients (eg D00234, D00235 ... vs plain 1001, 1002 for 
medical): parameter=FileSequenceD , value=00000. When entering new patient record, as soon 
as you press D, the file number changes to the D00001, D00002 etc. You can have 27 separate 
sequences. Just add parameters FileSequenceA, FileSequenceB etc 
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For Workcover/TAC patients, Practice 2000 can automatically print one single invoice for every 5 
visits: parameter=NumWorkCoverVisitsToPrint , value=5. For each patient visit, just click Print 
Later in the Payment Allocation form.  On the 5th visit, Practice 2000 will inform you that the 
patient has had 5 visits. 

 
 

Auto correct  
 
This is a common feature for all Microsoft Office applications.  If you type TEH, it is 
automatically corrected to THE.  To disable auto corrections: uncheck the tick box Replace 
Text As You Type.  
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A brief guide to Practice 
2000  

 
 
 

 
 
 

Important nomenclature 
 

· The Title bar is the bar on top of the screen. It contains the title Practice 2000 or 
Practice 2000 SQL 

· The Menu bar is the bar beneath the title bar. It contains the menus File, Edit, Patient 
… 

· The Toolbar is the bar beneath the menu bar. It contains icons to run commands. 
· The Patient Toolbar is the 3RD bar. It contains icons to run commands related to a 

patient (e.g. to show all invoices for the patient). 
· The Status bar is the bar at the bottom of the screen. Please read it to see what the 

text boxes and the buttons do. 
· “Click” means pressing then releasing the left mouse button (for right-handed mouse). 
· “Right-click” means pressing then releasing the right mouse button  
· “Press” refers to pressing a key on the keyboard. 
· “File => Close” means choosing the File menu from the menu bar, then select the 

Close command. 
 

Important actions 
 

· When entering data in forms, use the Tab key to move from field to field, not the 
Enter key.  
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· If a form has a button with dark borders, it is the default button.  Pressing the Enter 
key is the same as clicking this button. 

· Most forms are locked to prevent accidental data change. To edit data, click the 
ALLOW EDITING icon on the toolbar (the first icon) 

· After clicking a Print button on a form, a report may be displayed on the screen. To 
print it, click the File menu, Print command (or click the Printer icon on the toolbar) 

· If you make mistakes and get error messages such as “The value you enter is not 
appropriate...” press the ESCAPE key to clear the error. 

· The toolbar contains the words Patients, Appointments, Waiting Room, Invoices and 
Main.  Clicking on these words will bring up the corresponding forms.  Alternatively, 
you can press F8, F9, F10, F11 or F12 to bring up those forms.  

 

 
 
 

Registering a new patient 
 

1. Click the New Patient icon on the Patient toolbar.  
2. In the Patients form, fill in the white boxes. 
3. When entering the Medicare number, do not input any spaces. Type in only 9 digits. 

Put the 10th digit in the Medicare Issue field. 
4. When finished, click the Save Record icon on the toolbar. It’s the second icon, next to 

the Allow Editing icon. 
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Searching for patients  
 

1. Click the Find Patient icon on the Patient toolbar (or press Shift-F8) 
2. Enter the first 3 letters for the surname, press Tab, enter the first letter of the first 

name, then press Enter to find matching patients.  
3. The blinking cursor moves to the list on the right. If there are many names in the list, 

use the Up Arrow and Down Arrow keys to select the right person. Press Enter to 
accept the patient. 

4. If the patient cannot be found, click New to register a new patient 
 

Editing patient details 
 
Find the patient as above, and then click the Allow Editing button on the toolbar. 

 

 
Medicare bulk-billing 
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1. Press F11 (or click Invoices on the toolbar) to open the Invoices form.  
2. Click New Invoice. The Find Client form is displayed. 
3. Swipe the Medicare card to get a list of patients (or enter 3 letters for the surname 

and 1 letter for the first name, then press Enter) 
4. Use the Up Arrow and Down Arrow keys to select the right person, then press Enter 

to accept.  
5. In the Invoice Details form, fill in the white boxes.  
6. The Invoice Date must be the consultation date.  
7. Select a provider from the drop-down list.  
8. In the Fee Scale box, select Bulk Billing 85% Medicare.  
9. In the Items table, enter the service items.  
10. Click OK when finished.  
11. Answer Yes or No to printing the Medicare assignment form. 

 
 

 

Private billing 
 

· In the Invoices form, click New Invoice and select a patient from the database 
· In the Invoice Details form, fill in the white boxes as above. 
· In Fee Scale box, select Private Patient.  
· When all the white boxes have been filled, click OK. The Payment Allocation form will 

be displayed.  
· If a payment is to be made: 

o Enter details for the payments (CASH, CHEQUE etc), one on each line. 
o Double click the white Allocated box for each invoice to pay off the invoice. 

You must allocate all the amounts entered (the yellow box showing the total 
amount of the payments must be exactly the same as the yellow box showing 
the total amount allocated).   

· Select one of four options: 
o P/Claim Now: send the patient claim via HIC Online immediately.  
o Store P/Claim: store the patient claim so that you can send via HIC Online 

later.  
o PC1: print a Medicare claim form (PC1) for mailing to HIC 
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o No PC1:  none of the above.   
 

· Click Print All (Unprinted) Invoices to print an account statement. It acts as either an 
invoice or a receipt depending on whether a payment has been made 

 

 
 

 
 

WorkCover billing   
 

· Create a new invoice as above 
· In the Fee Scale box, select WorkCover 
· Click Change Payer. The Find Client form appears 
· In the Surname/Org box, enter the name of the insurance company. Click Find Now.  
· If the insurance company has been previously entered in the database, accept it.  
· Otherwise, you will be asked if you wish to create a new client. Say Yes. In the New 

Client form, fill in the white boxes, then click OK. Back in the Find Client form, click 
Accept 

· In the Invoice Details form, enter the WorkCover claim number in the Notes box 
· When all the white boxes have been filled, click OK. The Payment Allocation form will 

be displayed.  
· Click Print This Invoices to print an account statement. If you wish to print all 

accounts for this insurance company at a later time, click Print Later instead. 
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Waiting Room 
 

· This form is useful to GP’s where there are many patients to be billed each day. 
Specialists usually use the Invoices form for billing. 

· Press F10 (or click Waiting Room on the toolbar) to open the Waiting Room form 
· When a patient arrives, click Patient Arriving. In the Find Clients form, search for the 

patient from the database and accept the patient. (If this is a new patient, click New to 
register a new patient.) 

· In the Invoice Details form, select a doctor and a fee scale for charging. Click OK. A 
new line will be added to the Waiting Room. 

· For Bulk-billing patients, the Medicare/DVA Assignment form can be automatically 
printed as they arrive. Click on Setup to select this option. 

· Doctors can click MDW/Locum to write prescription for the patient.  
· Click Immunisation to record child vaccinations.  
· Click the Patient menu for other actions. 
· When a patient leaves, click on the patient name then click Patient Leaving.  
· The Invoice Details form appears to let you bill the patient. If the patient leaves 

without a consultation, click Delete Invoice. 
 

 
 

Appointments 
 

· When a patient telephones to make an appointment, press F9 (or click Appointments 
on the toolbar) to bring up the Appointments form.  

· Change the appointment date by clicking a date on the appointment calendar.  
· If this is an existing patient, double click the time slot you want to book the patient 

into.  The Find Clients form appears.  Type in any letters for the surname and any 
letter for the first name to search for the patient.  Accept the patient.   

· You will see patient names, address and file number on the top right corner of the 
screen. 

· If the patient is new, on the Find Clients form, click on New Client to add a new client. 
· To bring a patient from the Appointment book into the waiting room: click on the 

patient then click In W/Room. 
· You can also click MDW2/Locum to write scripts. Click New Invoice to bill. Click the 

Patient menu to do all other things 
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Receipting payments  
 

· On the Invoices form, click Find Invoices. On the Find Invoices form, enter patient or 
other details to find the invoice being paid.  

· Click New Payment to bring up the Payment Allocation form. Follow the instructions 
for Private Patient Billing above 

 

 
 

End of Day Processing 
 

· From the Main Form, click Admin Tasks, then Earnings . The Earnings form will 
appear. 

· Enter the dates as required then click Recalculate. 
· To print today’s earning & number of patients shown on the screen, click the Printer 

icon on the toolbar. 
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· To print details of all items rendered and all monies received, click Audit Trail, then 
click the Printer icon on the toolbar 

· Close the Earnings form.  
· In Admin Tasks, click Payments Received . 
· Check the list of payments received against your cash drawer.  
· If OK, click Clear Drawer to print a banking statement 
· Do backups .  This depends on how the backup has been set up.  
 

End of week/month processing 
 
This process is similar to End of Day Processing, except that you need to enter the correct 
period 
   

Important Tips 
 

· If a form does not provide a Delete button, you can delete records by selecting the 
record(s), then click the Records menu, Delete Record command. 

· The toolbar allows you to open frequently used forms quickly: patients, invoices etc. 
Pressing F8, F9 ... F12 does the same thing. 

· Printers: Everything is printed to the Windows’ default printer, except for Medicare 
DB4 forms. These require a dot-matrix printer having the name MEDICARE. Laser 
labels are printed on the default printer. Roll labels can be printed on a dot-matrix 
printer having the name LABEL. 

· Patient toolbar: Many forms such as appointments, waiting room etc, contain a list of 
patients. Click on a patient, then click the icons on the Patient toolbar to display all 
information related to the patient: invoices, payments, recalls etc.  

 

Working with Forms 
 

· When entering data on a form, click on the label for a field to move quickly to that 
field. For example, in the Patients form, click the Address label to move the cursor to 
the Address field. 

· Many command buttons have an underlined letter, e.g. Find Patients. Pressing ALT 
together with the underlined letter, e.g. Alt-F, is the same as clicking this button 

· Many fields have an underlined letter, e.g. Address. Pressing Alt-A will move the 
cursor to this field quickly. 

· Sometimes data are too large to fit into a box, for example the surname could be too 
long.  To see the whole field: press Shift-F2 (or click the Zoom button on the toolbar) 

· To make a new line in a text box: press Control-Enter (pressing just Enter might not 
work) 

· CTRL and Single Quote (Ctrl-‘) (Read: Control Ditto) copies data from the previous 
record to this record.  

· Dates can be entered as 20/01/01 or 200101 
· Use the New button on forms to create a new record.  Do not overwrite existing data.  

A form is like a paper card for entering data. If you overwrite existing data, the old 
data is lost.  

· In a form, data in the white boxes can be edited. Coloured boxes are in general not 
editable. 

· At the bottom of a form, there are buttons to move to the first record, the previous 
record, the next record, the last record, and the new record for data entry.  
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Patients form 
This form records non-medical info about patients.  For confidential medical data, use the 
Medical Records form. 
 

· All payers such as insurance companies are also to be registered on Patients form. 
Payers can then be transferred to the Address Book for writing letters by clicking New 
Addressee. 

· The File Number field is useful only if your clinic use a numerical filing system such 
as the RACGP’s.  A file number can have letters and numbers. Usually, it is used to 
locate the patient file in the filing cabinets.  If you use alphabetic filing, ignore the file 
numbers. 

· The Minor file numbers is used to identify a member within a whole family.  
· If numeric, the file number automatically increments by one for each new patient. You 

can overwrite the file number. 
· When entering a new patient, if you type in a file number that belongs to an existing 

patient, Practice 2000 will by default assume that the two patients are in the same 
family, and will bring up the existing address. 

· Suppose all patients currently have file number smaller than 7890.  If you want new 
patients to have file numbers starting from a particular number, e.g. 10000, please 
click Default File Num, then enter the number you want 

· File numbers can be preceded with a letter from A to Z. For example, a multi-
disciplinary practice can have medical patients with file numbers 1, 2, 3 ..., dental 
patients with file numbers D00001, D00002 ..., and paediatric patients with file 
numbers P0001, P002 ... 

· To make the special file sequences increase automatically, click Admin Tasks, 
Advanced, and Miscellaneous. Create a new record with the parameter 
“FileSequenceD” and value 00000. When you enter a new patient, as soon as you 
type D in the File Number field, you will get D-00001. You can also create 
FileSequenceA, FileSequenceB ... FileSequenceZ 

· When the cursor is blinking in the (blank) Medicare field, you can swipe the Medicare 
card on the card reader to obtain automatically the Medicare number, the Medicare 
Issue number, and the Expiry date.  If no card, you can type in the Medicare number.  
The Medicare number should be typed as 9 digits with no space, although it will be 
displayed with a space between the 4th and 5th digits. The 10th digit should be put in 
the Medicare Issue number. The Medicare Reference number (to the left of the 
patient name) should be recorded also 

· When entering a new patient, if you type in a Medicare number that belongs to an 
existing patient, Practice 2000 will assume that the two patients are in the same 
family, and will bring up the existing address. 

· To update the Medicare number for a patient, click the Allow Editing icon on the 
toolbar, highlight the Medicare number field, and swipe the card. All patients having 
the same old card number will be updated automatically. 

· If a Medicare number is not valid, Practice 2000 will warn you. Same with the 
Medicare expiry date. 

· Birth years can be entered with 2 or 4 digits 
· When you write a letter for a patient, the Nickname will be used in “Dear …” 
· You need to enter only one letter for your favourite suburb. The Postcode will be filled 

in automatically.  
· To see what your favourite suburbs are, click Admin Tasks from the Main form; click 

Set up, then Postcodes. Click anywhere in the List Rank column, then click Records 
=> Sort Descending. List Rank is the number of your patients living in this suburb. 

· If a suburb is not on the pick list, open the Postcodes table as previous, then click 
Records => Goto => New to add the suburb 
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· To automatically dial a phone number using a voice modem, click on a phone 
number, and then click the AutoDialer icon on the toolbar. This method works 
wherever you see a telephone number on any form. 

· Patient details such as the maiden name can be put in the Notes section. They can 
be used to find patients.  For example, suppose you want to send Christmas cards to 
some patients.  Please put the word “Christmas Card” in the Notes field for these 
patients. Click Find Patient.  In the Find Patients form, type “Christmas Card” in the 
Notes field, then click Find Now.  All these patients will be displayed. 

· The Warnings field lets you display a message each time the patient is brought up.  
Examples:  “Bad debt”, “x-ray to be collected”. 

· For private patients, you can make the patient responsible for the invoices by clicking 
Self. You can also select another person or organization as the payer by clicking 
Select.  If the payer has not been entered into Practice 2000 before, click New to 
register. 

· For WorkCover and TAC patients, you can enter the Claim Number, Employer and 
Date of Incidence.  If the patient has several Claim numbers, click Claim List to enter 
or select a claim. 

· The Veterans number must be entered for DVA patients.  
· The Pension / Pharmaceutical Benefit number will be transferred to prescription 

writing software. 
· In the Referred By field, type in the surname to select a doctor from the Address 

Book, then press Tab.  
· If the doctor is not in the Address Book, click New Doc to enter.  
· If there are several referring doctors, click the List button to enter or select a doctor. 
· You can find out how many patients hear about your Practice from newspapers, 

radio, word of mouth, etc. Type the source in Hear From Field for each patient. Later, 
go into Admin Tasks; click Where Clients Hear About You.  A graph will be displayed. 

· Deceased patients: Date of death can be recorded. Recall notices will be suppressed.  
These patients normally cannot be searched for, so invoices cannot be created.  To 
find these patients: in the Find Patients form, tick the Deceased box, then click Find 
Now. 

· To print laser labels containing patient details to stick on patient files or pathology 
requests: insert label paper into the default printer, and then click Print Label. You 
can print several labels in one go. Practice 2000 automatically keeps track of the row 
and column to print. 

· Alternatively, you can use a dot matrix printer to print labels on a roll. In Admin Tasks, 
Set up, click Label to select this option. Label size: 98x38mm. 

· To print laser labels containing patient address for mailing purposes: click Print 
Address. 

· For specialists, to print patient details on C5 envelops: click Print Details. 
· To change address for whole family: click the Family tab, then Change All Address.  
· No need to specify that two people belong to the same family. Practice 2000 

considers that if two people have the same Medicare number, they belong to the 
same family. By default, if two patients have the same file number, they are also 
assumed to be in the same family. To clear this default assumption on the file 
number-family relationship, go to any Patients/Clients record, click Family tab, click 
the Allow Editing icon and untick the check box ‘Include living patients/clients with 
same file number’. 

· To enter several members of a family: enter the first member. When finished, click 
New Family Member.  

· In the Family tab, double click the first name to quickly display the record for a family 
member. 

· You can print a family label: click Print Family Label 
· The Patient menu on top of the screen is most useful: you can see anything related to 

a patient (appointments, recalls, invoices etc), you could do anything (create new 
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invoices, letters, recalls etc). This menu can be used on any screen where a patient 
name is displayed. 

· Some frequently used actions on a patient are provided as command buttons on the 
Patients form: New Invoice, In Waiting Room, New Payment, Show Invoices, Show 
Letters. 

· If a duplicate patient record is entered, you will be warned. Duplicate records means 
that two records have the same surname, first name, second initial and birth date. 

· To delete duplicate records: note the patient ID’s of the duplicates. From Admin 
Tasks, click Duplicate Patients, click onto a record to be merged and deleted among 
its duplicate(s), then click Merge + Delete.  

· Names can be automatically capitalized: tick the Capitalize First Letters check box.  
Before entering names like McDonald, please uncheck this box, otherwise you will 
get Mcdonald. 

· For Asians, put all names other than the surname in the First Name field, and leave 
the Initial field blank.  

· Most addresses require only one line, e.g. `18 Lisbon Street’.  Some addresses 
require two lines, e.g. “C/- Mr. John Smith”, “18 Lisbon Street”. 



 

42  
 

Find Patients form  
 
This form is used to search for patients from the database. It also provides statistics such as 
the number of your patients living in a particular suburb. You can find a list of patients over 
65 years of age, export the list of such patients to Excel or Word, or print out laser labels for 
mailing. 
 

· When the Find Patients form comes up, you can swipe a Medicare card to find the 
patients. If a card is not available, type in 3 letters for the surname, and one letter for 
the first name. When finished, press Enter or click Find Now.  A list of matching 
patients will be displayed.  

· Use the arrow keys to select a patient from this list and then press Enter to accept.  
Alternatively, double click on the name of a patient in the list. 

· The fields on the left of the Find Patients form allow you to find patients by a 
combination of any details you know, e.g. name or address. Use Tab to go from field 
to field.   

o Find patients by the first few letters of names, phone, Medicare number or 
suburb. 

o Find patients by any part of Address, Notes or Medical Problem 
o Find patients by exact birth date, file number, patient number, or a range of 

birth dates. 
· If you mainly use File numbers to find patients: click Admin Tasks, Set up, Waiting 

Room. Tick the option to put cursor on the File number box when opening Find 
Patients form. Uncheck to put the cursor on the Surname box (default). 

· Wild card characters can be used for string pattern matching in any fields: “?” for any 
single character, “*” for any number of characters.  For example, “*AR” will bring up 
BART, BARTON, MARTIN, CHARLES, etc. 

· To create mailing labels for flu vaccine invitations: From Patients form, click Find 
Patient, enter birth date say from 1/1/1800 to 1/1/1932, press Enter, then click Print 
Address. This prints all addresses for elderly people on laser label ready for mailing. 
Addresses are sorted in order of suburb, street number and name. Thus duplicate 
addresses are easily spotted since they are adjacent. 

· When printing mailing addresses on laser labels for a large number of patients, you 
can choose to print only one label per address or to print one label per patient.  
Clicking Print Address will give you the option. 

· To create mailing labels for asthma sufferers: type “asthma” in the Notes search box, 
press Enter, then click Print Address. (You should have previously written the word 
“asthma” in the Notes field for these patients on the patients form). 

· To write personalized letters using Microsoft Word mail merging: on the Find Patients 
form, search for patients you want to write to, then click Write File. 

· To do statistics on patient demographics: enter the criteria, and then click Find Now. 
For example, you can find a list of female patients born between 1900 and 1950 who 
have been a private patient of a particular doctor. You can export this list to Excel or 
Word. 

· You can find “old” patients who have not been seen since a certain date: use the 
“Seen From” field. 

· You can find patients who have had a certain medical item performed, e.g. 701 or 
pregnancy tests.  Just put the item number in the Item fields.  There are two Item 
fields, each of which has an option of Include or Exclude.  Thus you can make 
complicated queries such as “find patients who have had item 701 but not 700” 

· To print a select list of patients with control of what fields to show: 
o In the Find Patients form, enter selection criteria such as a suburb, and then 

click Find Now.   
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o Click Show All.  The Patients form will display the first patient in the list. 
o Click the View menu, and then click Datasheet View.  The Patients form will 

become a datasheet, showing all patients. 
o Click the Format menu, Unhide Columns. A list of fields will be shown. 
o Tick the fields that you want to print. Uncheck the fields that you don’t want to 

print.  Click Close. 
o Resize the columns, as you would do to an Excel spreadsheet. 
o You can sort the records by a given field, e.g. by suburb. Click on any item in 

the column you want to sort by, and then click the Records menu, Sort 
Ascending.   

o Finally, click the File menu, Print command.   
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Invoices form 
 
You can bill patients via the Invoices form or the Waiting Room. The Invoices form is quicker 
and is recommended for specialists. The Waiting Room is more useful to large GP practices. 
Each consultation is to be written as one invoice.  
 

Setting display order 
 
Invoices can be sorted using Invoice#, File# or Invoice Date. They can be either ascending 
or descending. Select the sort field and the order from the bottom right of the Invoices 
screen.  
 

Creating a new invoice 
 

· In the Invoices form, click New Invoice. The Find Client form is displayed. 
· Swipe the Medicare card to get a list of patients (or enter 3 letters for the surname 

and 1 letter for the first name, then press Enter) 
· Use the Up Arrow and Down Arrow keys to select the right person, then press Enter 

to accept. Alternatively, just double click the name of the patient. 
· In the Invoice Details form, fill in the white boxes  
· The Invoice Date should normally be the consultation date.  
· Select a provider from the drop-down list.  
· In the Fee Scale box, select Private Patient or another scale.  
· The account payer is normally the patient himself. If not, click Change Payer. In the 

Find Client form, select a client from the database, or click New Client to add a new 
person. Click Accept to accept the selected client and return to the Invoice Details 
form. 

· In the Items table, enter the service items. If you are unsure of the item code, click 
Select Item.  

· When all the white boxes, including those on the More tab have been filled, click OK.  
 
Medicare bulk billing, Veteran, Private, TAC, Workcover, and AMA, etc. schedules can be 
selected in the Fee Scale field. The Fee Scale determines how an invoice will be processed. 
For example, Veteran Affairs fee scale means direct billing, so Practice 2000 will print a 
Veteran Affairs slip for the patient to sign. If you want to send an account statement to DVA 
rather than bulk billing, you must select the Private Patient fee scale. 
 
Each item in an invoice can be charged to a different fee schedule: use the Schedule column 
in the lower window.  For example, you can invoice a private patient and set the fee to bulk 
billing. 
 
Charges and GST for the items can be overwritten. The GST rate for each item should have 
already been entered during setup (Admin Tasks, Setup, Fee Scales). To give a discount to 
patients, create a new item with the code DISCOUNT. Enter a negative fee, e.g. -5.00. 
 
Held accounts:  For a patient in a hospital, an invoice should be created for each 
consultation. The invoices can be held, i.e. not issued to the patient, by ticking the Held 
Account check box in the Invoice Details form.  When the patient leaves the hospital, you can 
release and print all invoices on one sheet as follows: 
 

· In the Invoices form, click Find.  
· In the Find Invoices form, tick the Held Invoices box, and then click Find Now 



 

45  
 

· Click Preview All.  When asked if you want to release held accounts, say yes 
 
To calculate multiple-procedure fees  for specialists: tick the Multiple-procedure Fee field in 
the Invoice Details form, More tab. Only the items of the type “Procedure” will have fees 
halved or quartered. The consultation items will not have reduced fees. To change the item 
type: click Admin Tasks, Set up, Fee Scales. Find the item, then select its type from the drop-
down list. 
 
To speed up the creation of a new invoice, Practice 2000 gives default doctors, schedules, 
referral details, items etc. To control these defaults: click Admin Tasks, Set up, Waiting 
room/Invoices. 
 
Date of injury, Claim number and other info required by TAC/WorkCover can be entered 
directly in the Notes field of the Invoice Details form. They will be printed on invoices. 
However we recommend the following procedure: 
 

· In the Patients form, display the patient record.  
· Click the Claim List button. In the Workcover/TAC Claims form, enter each claim on 

one row. A patient can have one or several claims. If a claim is no longer active, take 
the tick off the Active box. 

· Select the current claim, and click OK. The claim details will appear in the Patients 
form. Inactive claims cannot be selected. 

· When you create new invoices for this patient, the claim details will appear in the 
Notes field of the invoices 

 
If the patient uses a different claim, go back to the Patients form, click Claim List and select a 
different claim. New invoices will use the details of this claim. 
 
Note: if the claim details are not transferred from the patient record into a new invoice, 
please: 
 

· Click AdminTasks, Setup, Fee Scales 
· In the Select Fee Scale box, select Workcover 
· Make sure that the check box “Use Patient claim details when making new invoices” 

is ticked. 
 
To add your own schedules and items: From the Main form, click Admin Tasks, Set up, Fee 
Scales. Do not change the names of the existing schedules. 
 

· Items codes can have letters and numbers.  
· Items can be added on the fly. In Invoice Details form, if an unknown item is entered, 

you will be asked to confirm that it is a new item 
· Items can be duplicated, e.g. you can have several items with the same “51303” code 

but different text descriptions and fees.  It is however not recommended to have 
several items with the same code. 

· To overwrite the standard description for an item: just write in the New Description 
column for the item in the lower window 

 
The Business that provides the services can be selected on the Invoice Details form (More 
tab). Invoice letterheads are dependent on the business. Two businesses may operate from 
the same location or different locations 
 
To print plain paper A4 Medicare vouchers  instead of the continuous DB4 vouchers: from 
the Waiting Room form, click Setup and tick A4. 
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If you use a dot-matrix printer  for the continuous Medicare vouchers: From the Windows 98 
Start button, click Settings, Printers, then change the name of the dot-matrix printer to 
“MEDICARE”. Practice 2000 assumes a printer of this name already exists in Windows. 
 
After a Home/hospital visit,  the doctor will come back with a number of hand-written 
vouchers. These vouchers must be entered via the Invoices form. The following trick helps 
you do it faster: 
 

· Double click the Windows clock (usually on the right of the Task Bar) 
· Click the home visit date on the calendar, and then click OK. This changes the 

computer date to the date of visit 
· Click New Invoice. The Invoice Details form will appear, showing the home visit date 

as the invoice date. 
· Enter all the invoices, and then change the computer date back to today’s date. 

 

Editing an invoice: 
 
Click Find to find the invoice, then click Edit/Delete. The Invoice Details form will be 
displayed. 
All white boxes can be changed. 
 

· To delete an item, click on the item, and then click Delete Line 
· In a multi-user system, if two people edit the same invoice at the same time, one 

person will see error messages, which indicate that his changes cannot be carried 
out. Just click OK to these messages and try again later. 

· To print invoices for a whole family: bill each person individually and choose Print 
Later in the Payment Allocation form. For the last person, choose Print All Unprinted 
Invoices.  All the invoices will be printed on a single sheet.  Remember to select the 
same payer for each invoice; otherwise you cannot print the invoices together. 

· To print unprinted invoices for a payer: Each invoice shows the date it’s printed at the 
bottom right corner of the Invoices form. You may choose Print Later for each patient 
charged to, say, TAC. Later, at a convenient time, open the Invoices form, click Find 
to find any unprinted invoice for TAC, and then click Preview All. 

· To print unprinted invoices for all payers: on the Invoices form, click Find. Click the 
Printed box twice to clear it, and then click Find Now. All unprinted invoices will be 
displayed. Click Preview All to print them. 

· To print Duplicate statements: in the Invoices form, click on the invoice to print, then 
click Print Invoice. 

· To reprint Medicare vouchers: as above. 
· To print all items and payments for a number of invoices: click Find to display the 

invoices, and then click Preview All. 
· Invoices are designed to go into DL envelopes with a clear window. Just fold the 

sheet into 3 equal parts 
· To set up letterhead for invoices: From Admin Tasks, click Set up, Business 

Addresses, then edit the details such as name and address. 
 

Writing off bad debts: 
 

· Open the Invoices Details form for the invoice. 
· Click Adjust, and then enter a negative amount to zero out the amount owed.  
· Enter a reason in the New Description box. Click OK to close. 

 

Delete an invoice: 
 

· Find the invoice, and then click Edit/Delete to open the Invoices Details form.   



 

47  
 

· If there is a payment, click on the payment, then click Delete Line. You must delete all 
payments before deleting this invoice. 

· Click Delete Invoice, and confirm your deletion. 
 

Invoices are never really deleted. When you delete an invoice, it is only being marked as 
deleted. You can use Find to see deleted invoices. 
 
Sometimes you accidentally create a patient record without names. When you create an 
invoice for this no-name patient, the invoice does not have any patient name in it. You must 
delete the invoice, then delete the patient record that contains no names. 
 

Miscellaneous 
 
Simplified Billing  is a service to patients in hospital whereby a Billing Agent sends a single 
bill to the patient and distributes the moneys received to the health care providers involved. If 
you are a health care provider using a billing agent: 
 

· Click Admin Tasks, Set up, Fee Scales, New Scale to create a fee scale called 
“Simplified Billing”, say.  

· The charge for each item in this schedule is what you could get from the billing agent, 
after their commission. 

· For each new invoice, make the billing agent the account payer. 
 
For private patients, click Print PC1  to print a Medicare Claim Form (PC1).  This pre-
printed paper form is available from Medicare offices free of charge.  The form changes from 
time to time; each form has the version date in small print, e.g. 04/07 for April 2007. If the 
printout does not match the form, you have to tell Practice 2000 which version to use as 
follows:  
 
- On any computer, click Admin Tasks, Advanced, Miscellaneous 
- Look for a parameter called PC1ReportSurfix 
- Change its value to the correct version date, e.g. 0407  
- Close down the table and test print an invoice. 
 
Show Items  The Invoices form shows only a summary of each invoice.  To see the details of 
the invoices being shown on the screen, click Show Items.  There are items that you bill the 
patients, receipts if any, and adjustments. 
 
Debt Collection  While attempting to recover the debt on an outstanding invoice, you can 
click Debt Collection to enter a note on the progress.  This note will appear in the Overdue 
Accounts form and will be printed in the debtors list.  You can decide not to print overdue 
reminders for this invoice until 6 months or one year later by entering a date in the No Bill 
Before field. 
 
For specialists , you can put multiple hospital consultations on one invoice by clicking New 
Invoice.  In the Invoice Details form, enter all items and their service dates.  This is a quick 
way of entering the consultations.   
 
However, a payment can only be applied to the whole invoice; you cannot specify which 
consultations are paid.  In order to pay a particular consultation, please click Split Invoice .  
This invoice will be split into several invoices, one for each service date.  Now you can pay 
the consultations separately. 
 
The List Invoice  button prints all invoices being displayed on the screen.  For example, you 
can click Find to find all held accounts, and then click List Invoice to print them. 
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Payment Receipting 
 

Receipting Payments for Private patients, Work Cove r or 
TAC 
 

· On the Invoices form, click Find to find any invoice for the payer, then click New 
Payment.  

· On the Payment Allocation form, enter each payment (cash, cheque etc) on one line.  
· In the “The above payments are for...” box, select one doctor account to bank the 

payments.  
· The middle section of the Payment Allocation form displays a list of outstanding 

invoices for the payer 
· To pay off an invoice, double click the white Allocated box for the invoice  
· To pay part of an invoice, type the amount paid in the Allocated box. Or you can 

double click the Gap or the Rebate box of the invoice. 
· You must allocate all the amounts entered. The two yellow boxes must have the 

same amount. 
· To print a Medicare claim form (PC1 ): tick the Print PC1 check box. The PC1 forms 

can be ordered from HIC. 
· If a receipt is required for private patients, click Print All (Unprinted) Invoices . Any 

held invoices for the whole family will also be printed 
· If receipts are not needed, click Deem Printed . Work cover & TAC accounts don’t 

require receipts 
· If you want to cancel all change click on cancel 

 

Pre-payment for several visits to the same provider  
 
Suppose the patient plan to have a number of related visits to the same provider in the near 
future. In this case, use one Invoice only: 
 

· At the first visit, create a new invoice. Enter the items in the Invoice Details form and 
click OK/Close. The Payment Allocation form comes up. 

· Enter the large payment. Enter the Allocated amount the same as the paid amount 
and print the Invoice. It will show a negative amount being owed. 

· When the patient comes for the next related visit(s), simply take this Invoice out (use 
Invoices/Find/Find Now with the patient surname filled in when asked). Click 
Edit/delete to add in new items and modify the Invoice date. Click OK/Close. 

· Print the invoice. It will show the patient having a smaller “spare” amount. 
· In the last visit, if the patient now actually owes some positive amount, click New 

Payment to get into the Payment Allocation form to receive and allocate the last 
payment to balance off this Invoice. 

 

Pre-payment for several visits to different provide rs 
 
Where several providers are involved, the above method won't work.  Use this method 
instead: 
 

· On the first invoice, enter the large payment.  This would put the invoice into credit 
(the amount Owed becomes negative).  

· At the next consultation, create another invoice with an item for $30 for example.  In 
the Invoice Details form, click Adjust, put in the negative amount of -30. In the New 
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Description box for this adjustment, write "credit from invoice number ..." (where ... is 
the invoice number of the first invoice) 

· Open the first invoice.  Click Adjust.  Put in a positive amount of 30.  In the New 
Description box for this adjustment, write "credit given to invoice number ..." (where ... 
is the invoice number of the second invoice).  

 
The payment is more than the amount owed 
 

· If you have entered the payment incorrectly on the Pay/Allocate/Print form, just delete 
it.  

· If the overpayment is correct, type the amount paid into the Allocated box for an 
invoice. The result is that this invoice will be in credit.   When this invoice is displayed 
in the Invoices form, the amount owed will be negative. 

· Later, the credit can be used to pay off (or allocated to) other invoices having the 
same payer. 

 
 

Refund to Patient 
 
Suppose you have billed a patient for  $20 and the patient has paid. The invoice shows $0 
owing. Later the patient wants a refund of $20. Please do the following instructions: 
 

· Open the Invoices form, find the invoice, and click Edit/Delete to edit the invoice.  
· On the Invoice Details form, click Adjust; enter -20 to cancel the item.  In the New 

Description column, type REFUND to explain why you enter this adjustment. 
· Click OK to close the invoice. The invoice shows ($20) owing, meaning you owe the 

patient $20.  
· Click New Payment to open the Payment Allocation form 
· Enter -20 as the payment amount, 
· Double click the Allocate box against the invoice, 
· Click Deemed Printed to close. The invoice shows $0 owing. 
· The banking statement will show this negative payment 

 

Receipting Payments from Debt Collectors 
 
If a debt collection agency gets money from patients for you, they charge you a fee. To 
receipt the money: 
 

· Open the Invoices form, find an outstanding invoice, and click Edit/Delete to edit the 
invoice.  

· Click Change Payer to make the debt collector the payer 
· Click Adjust. Enter the debt collection fee for this account (enter a negative number, 

e.g. -10) 
· Enter the adjust reason in the New Description box, e.g. “debt collection fee”. Click 

OK 
· Repeat the above process for all other accounts collected by this agency 
· In the Invoices form, click New Payment to enter the cheque from the debt collector, 

then allocate to the invoices. 
 
Medicare/Veteran payments are automatically receipted and allocated if Medclaims is used.   
 

Receipting Medicare/Veteran payments manually  
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Case 1: invoices have been batched on the computer 
 
If not using Medclaims, you would get a cheque from HIC plus a printout showing the amount 
paid for each claim (a claim is also called a batch). The cheque can pay for one or several 
claims. The printout also shows patients who are paid for and patients who are not paid for.   
 

1. On the Invoices form, click Find. Enter a claim number. Click OK.  
2. The total amount at the bottom right of the Invoices form should match the amount 

paid for this claim.  If not, check the patient list on the Invoices form.  You can sort the 
patient list alphabetically by clicking on any surname, then click the Records menu, 
Sort Ascending.   

3. If necessary, add or remove vouchers from the claim to make the amount paid match 
the printout.  To remove a voucher, click Edit/Delete to open the Invoice Details form, 
delete the claim number, then click OK to close the Invoice Details form. 

4. Repeat steps 1 to 3 to check all other claims paid by this cheque. If the patient list for 
any claim does not match the Medicare printout, you cannot proceed to receipting.  

5. When things are OK, click New Payment. If asked for a period, click OK. 
6. The Payment Allocation form is displayed.  Please enter cheque details. 
7. Click Find Claim. Enter a claim number, then click OK. This will display vouchers for 

the given claim.  
8. Click Auto Allocate to pay this claim 
9. Repeat steps 7 to 8 to pay all other claims for this cheque 
10. When all claims are done, click Close. 

 
Case 2: invoices have NOT been batched on the compu ter 
 

1. On the Patients form, click Find. Enter MEDICARE in the surname box, click Find 
Now. Then click Accept Patient 

2. Click New Payment. When asked for a period, enter a period that will include all the 
invoices to be paid. Click OK. 

3. Enter cheque details for one single Medicare cheque.  
4. Double click the Allocated column of each invoice to be paid  
5. If an invoice is not paid in full, type in the amount actually paid by Medicare. 
6. When the total amount allocated equals the cheque amount, click Close. 
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Waiting Room form 
 
Use this form rather than the Invoices form if (1) you want the doctors to easily write 
prescriptions, or (2) you want to make sure that every patient is billed.  The Invoices form are 
faster for billing purposes. 
 

· When a patient arrives, click Patient Arriving on the Waiting Room form to put the 
patient into the waiting room. An invoice will be raised. Normally you should select the 
provider and the fee scale at this stage. 

· If the patient has been booked into the appointment book, he can be transferred to 
the waiting room. 

· When the patient leaves, click Patient Leaving.  He will be billed automatically. Refer 
to the Invoices Form section. 

· To display the Waiting Room for one doctor or one of related sites only: click Select 
Doctor/Site 

· A doctor can edit the consultation items of the invoice for a patient if she has a 
computer in the consulting room. Just click on the patient, and then click Edit inv. 

· The doctor can open up MDW or Locum for a patient just by clicking this button 
· To record immunisations for a child, click Immunisation. 
· Waiting time is recorded. This is from the time the patient enters the computer waiting 

room until he is billed.  
· To see the average waiting time for any day, open the Invoices form, click Find to 

display invoices for that date.  
· To display patient details every time a person enters the waiting room: click Admin 

Tasks, Setup, Waiting Room, then tick the appropriate option. 
· If the patient leaves without a consultation, click Patient Leaving.  In the Invoice 

Details form, click Delete Invoice. 
· To record consultation time: tick the Consultation check box when the patient goes 

into the consulting room; uncheck it when the patient comes out. 
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Letters and Address Book 
 
Practice 2000 is fully integrated with Microsoft Word. Letter templates are selectable. Data 
sent to Word include all patient details, business name and address, addressee’s name and 
address, and details of the doctor providing service. 
 
The Address Book stores the addressees for letters, as well as referring doctors. It can also 
store specialists, hospitals, friends and relatives. 
 

 
 

To enter a new name in the Address Book 
 

· From the Main form, click Address Book 
· Click the New Record icon on the toolbar  
· Enter details. Enter descriptions such as “Heart Surgeon speaks German” in the 

Notes field. Remember to enter title too. 
· Click the Save Record button on the toolbar, or close the Addresses form. 
· To delete a record: click on the record, and then click the Delete Record button on the 

toolbar. 
 

To find and print some names  
 

· Click Find and enter the criteria.  You can find names by suburb, by type (GP, 
speciality etc), or by some notes. 

·  Click Find Now.  When the list is displayed, click Print Address Book for your own 
use, or click Print All to print sticky labels for mailing out 
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To find GPs who have referred more than 5 patients 
 
For specialists, the Address Book lists all referring doctors.  You can find a list of GP’s who 
have referred more than 5 patients to your clinic as follows: 
  
• In the Address Book, click Find.  In the “No. of Ref Visits >” box, type 5 (or any other 

number) 
• Click Find Now 
 

Writing a Letter 
 

· The addressee must have been in the Address Book. If not, from the Main Form, click 
Address Book. Enter the addressee details in the Addresses form. Close the Address 
Book 

· In the Find Client form, find a patient you want to write the letter about, and then 
accept the patient  

· In the Letters form, select an addressee in the “To” field. You cannot enter a new 
addressee. 

· Select the provider who is writing the letter, and a business address for the 
letterhead. 

· Click Open Letter. A list of templates will be displayed. Choose one template as 
follows 

· If Microsoft Word is not available, choose the QuickLetter.doc template. This is the 
built-in letter writing facility within Practice 2000: fast but no fancy fonts. 

· If Microsoft Word is available, choose “General.doc”. This allows you to write a letter 
to the referring doctor or a Workcover company. 

· If you want to write a letter to the patient, choose “Client.doc”. You do not need an 
addressee in this case 

· Once you have chosen a template, click Open. Microsoft Word will run, showing all 
relevant data from Practice 2000.  

· Write your letter. Print it. Close Word. Always answer YES to save the document. 
· Practice 2000 SQL Letters form allows the choice of 2 doctor addressees and the 

sending of letters by WinFax and by Outlook Express email 
· Letters are kept in the Letters subfolder of the Practice folder on the file server. The 

document name consists of 6 characters for the patient surname, 2 characters for the 
first name, and the letter ID. 

 

Creating your own Letter Template 
 

· In Letters form, click Templates. A list of templates is displayed. 
· Select PRAC97.DOC, and then click OK. Microsoft Word will run. 
· If you see messages like “Error! Bookmark not defined”, then press Alt-F9. 
· Click File menu, Save As. Enter a name for this template, which contains the most 

frequently used bookmarks, e.g. MyGeneral.Doc, for general use later. 
· Save this template for a particular purpose, eg. X-rayLabel.Doc and edit the 

document:  
 
You can use any of the available bookmarks anywhere as follows: 

 
· Highlight an existing bookmark, including brackets, e.g. {PatientTitle} 

a. Press Control-C to copy 
b. Move the blinking cursor to the place where you want to insert.  
c. Press Control-V to paste the bookmark.  

· Delete any unused bookmarks  
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· Type in any common notes/Add in pictures/Do general formatting 
· Save the new template again 
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Appointments form 
 
Use the Page Up/Page Down keys to scroll the form quickly. Clicking on the pop-up calendar 
is the easiest way to move to different dates. The Back, Next, Prev buttons are also handy. 
You can even type in the date in the yellow box on the top left corner (highlight the field, type 
in short date format with date separator eg. 10/02/03, click onto another field). 
 

To make an appointment for an existing patient:  
 

· Go to the slot you want to book the patient. Do not type in the name of the patient. 
· Double click in the middle of the slot .  The Find Clients form appears 
· Search for the patient, and then accept the patient.  The patient’s address and file 

number will show up on the top right of the Appointment Book form. 
· If the patient has referral details, Practice 2000 will check the referral date and the 

referral period to ensure that the referral is still valid on the appointment date 
 
If you simply type in the name of a patient in a slot instead of double-clicking the slot, 
Practice 2000 does not have enough information about the patient. You will not be able to 
bring the patient into the waiting room or bring up Medical Director/Locum. 
 
To make an appointment for a new patient quickly: click Allow Editing icon, write the patient’s 
name and phone number in a slot, then click the Save Record icon on the toolbar.  The top 
right of the form does NOT show the address.  You cannot bring the patient into the waiting 
room. 
 
When making an appointment, you will get a pencil icon on the left of the record indicating 
that you’re editing the record. In a multi-user system, other users will be prevented from 
making appointments on the same (or nearby) record.  So it is very important that you 
save the record quickly, simply by clicking onto an other timeslot, to allow other users 
to make appointments  
 
If Practice 2000 would not allow you to make an appointment, and you get an icon with the 
picture of a circle with a line, this means a colleague of yours is also making an appointment 
at this time.  You have to wait until they finish.  
 
To bring a patient from the appointment book into t he waiting room : click on the patient 
name, and then click inW/rm.  This works for an existing patient only.  It does not work for 
new patients.   
 
Click New Invoice to bill the patient directly 
Click MDW/Locum to write prescriptions 
Click Recall to add a new recall. 
 
To print appointments:  click Print. Click on Yes to print appointment slip for patient to take 
home. Click No to print appointment list for doctor, one sheet per doctor. Each appointment 
includes name, address, and telephone number. 
 
To cancel an appointment : click on the patient name, and then click the button with the 
word CUT (do not click the Cut icon on the toolbar - the one with the scissors picture).   
 
If you simply highlight a patient name then press delete, this does not delete the patient info 
held in this slot. You have to click the Cut button to really remove the patient. 
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Once you have cut a patient off a slot, you can put the patient in another slot: click the new 
slot, then click the button with the word PASTE (do not click the Paste icon on the toolbar).   
 

· Long appointments: cut and then paste on 2 adjacent slots. 
· Double/triple booking: click Double 
· Text can be added at the end of the patient’s name, eg. “Smith, John - URGENT, 

SEVERE PAIN”. 
 
To find appointments for a patient : click Find.  This will display all appointments for the 
patient. Click on each row in turn to see the appointment dates. To find the next available slot 
for one particular doctor or for any doctor: click Free 
 

Resizing and Moving Columns and Rows 
 
Columns can be resized just like a spreadsheet. This allows you to display more or less 
providers on the screen depending on who’s working today. To resize: Place the mouse on 
any vertical dividing line in the grey area on the top of the appointment table. The cursor will 
turn into a double-headed arrow.  Now drag the mouse left or right to make the columns 
wider or narrower. 
 
Columns can be moved around.  Just place the mouse on the column title, and then drag it to 
another place.  
 
It’s possible to resize the rows of the appointment book so that the whole day will fit into the 
screen. Place the mouse on any horizontal dividing line in the grey area on the left of the 
form. The cursor will turn into a double-headed arrow.  Now drag the mouse up or down to 
make the rows taller or shorter.  
 
After resizing rows and columns, slots become very narrow and the texts are hard to see.  
You can click a slot then read the full text displayed on the top right corner of the 
appointment form. 
 
The above manipulation of rows and columns has a temporary effect.  If you close down the 
Appointment book then reopen it, the rows and columns will revert back to normal.  You can 
resize the column permanently as shown in the Practice 2000 Setup section. 
 

Scheduling (Rostering) 
 

                         
 
 
Scheduling 1 day 
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· Suppose your practice opens between 9:00 am and 6:00 pm.  In this example 
schedule, Dr Coulton starts work at 9:00 and does 10-minute appointments. We don’t 
have to do anything for his schedule. 

· Dr Dagley starts at 9:30.  Please type “/ not in” for Dr Dagley in the slots from 9:00 to 
9:20.  Dr Dagley does 15-minute appointments, so we type “/” at 9:50, 10:20 and 
10:50.  This gives Dr Dagley 2 patients every half hour, or 4 patients per hour. 

· Now put the mouse on the 10:00 slot for Dr Dagley, near the left border of the slot. 
The cursor becomes a thick cross.  Press the left mouse button and drag the mouse 
to the 10:50 slot.  All 6 slots are highlighted.  Press Control-C.  We have just copied 
Dr Dagley’s schedule between 10:00 and 10:50.   

· Highlight Dr Dagley’s slots from 11:00 to 11:50 by dragging the mouse as above.  
Press Control-V.  We have pasted the schedule onto this hour.  

· Repeat the above step to paste the schedule on to all other hours for Dr Dagley.  You 
can copy and paste 2 hours at a time to make it faster. 

· Dr Stowe starts at 10:00.  We can copy a block of “/ not in” texts from Dr Dagley’s 
column, then paste onto the slots for Dr Stowe from 10:00 to 10:50. 

· Dr Stowe sees a patient every half hour.  We write “/” at 10:10, 10:20, 10:40 and 
10:50.  This gives him 2 patients per hour.  You can use control-C and control-V to 
copy and paste the slots for Dr Stowe. 

 
Tips: It is common that you can make a mistake when doing rostering: 
 

· If you make a mistake with scheduling, you can clear out a block of slots.  First, copy 
a block of blank slots. Next, paste it onto the block that you want to clear. 

· You can resize the rows and columns so that the whole day is visible on the screen 
as shown above. 

 
SCHEDULING 1 WEEK/FORTNIGHT 
 

· Once you’ve scheduled one day, you can copy that whole day into the next. Just 
highlight all the slots, press control-C to copy, move to the next day, and highlight all 
the slots, press control-V to paste.  Then modify the slots as required for this day. 
Repeat the process for all the days in a week.  

· If the providers work on a fortnight-schedule, continue scheduling for the whole 
fortnight. 

 
SCHEDULING 1 YEAR 
 
Supposed you have created a weekly schedule from Monday 3/1/2000 to 9/1/2000, you can 
copy this schedule to make a one-year schedule as follows: 
 

· On the appointment book, click Schedule.  The Appointment Book Copy form 
appears.  

· In the first field, select 7 for the weekly schedule (or 14 for the fortnightly schedule).   
· In the second field, enter 03/01/00.  Press Tab.  The third field will automatically 

change to 01/01/00. 
· In the fourth field, enter 364, which is almost a year.  Press Tab 
· In the fourth field, enter 10/01/00.  Press Tab.  
· Click Write Schedule (Never Overwrite).  This will copy the 1-week schedule to all 

other weeks, taking care not to overwrite any existing appointments. 
· You can further schedule special days in the year such as holidays. 

 
Tips: The Appointment Book Copy form has 2 other buttons: 
 

· Write Schedule (Ask Before Overwrite): if there’s an existing appointment, you have 
the option of overwriting it or not 
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· Write Schedule (Always Overwrite): all previous appointments might be overwritten 
without you being notified. This is a dangerous thing. 

 

Colour Coding 
 
You might wish to put a colour on slots where the providers are unavailable, a different 
colour for patients who have been put into the waiting room, and another for patients who 
need urgent attention. Practice 2000 assigns a colour to a slot according to the first few 
characters of text in the slot. It allows a maximum of three colours. 
 
Click on Setup then choose “Colour Coding”. The Colour table is displayed.  When a patient 
is put into the waiting room, Practice 2000 places an @ before the patient name.  These 
patients will be assigned a certain colour. 
 
If you have marked off unavailable slots in the appointment book with “/” or “/ not in”, these 
slots will be given a different colour.  If you have marked the slots with “xxxx” rather than “/”, 
you can change the starting text in the Colour table to this string. 
 
For patients who need special attention, you can place a “#” before their name in the 
appointment book (or any other string you like).  In the Colour table, the starting text must be 
written as “[#]” because # is a special character. 
 
You can change the foreground and background colours of the slots by changing the colour 
numbers.  The formula is COLOUR = RED + 256*GREEN + 65536*BLUE, where each 
primary colour goes from 0 to 255 
 

Delete a line in Appointment book 
 
Sometimes you need to remove a row from appointment book. To do it, click on the row that 
you want to remove then click on Delete Row. 
 

Miscellaneous 
 
Suppose a doctor has been Setup in column 3 of the appointment book.  If you want to move 
all his appointments to column 1, click Setup, Move Column and follow on-line instructions.  
Then click Setup, Columns For Doctors and change her column from number 3 to number 1. 
 
Suppose the appointment book shows only times between 11 am to 5 pm only, and you want 
to make appointments from 9 am to 8 pm.  Please: 
 

1. In the Appointment book, click Setup, Roster (Write Slots). The Roster form is 
displayed. 

2. Go to the blank line at the bottom of the form.  Type the following: In Col = 1, To Col = 
1, From = today’s date, For = 1 year, Every Nth Day = 1, Between = 9:00, And = 
20:00, Every Nth Slot = 1 

3. Put a tick in the Do It check box, and then click Write Roster Never Overwrite. 
4. Compact and repair the database. 

 
It is not advisable but possible to have the appointment book to show both 10- and 15-minute 
intervals, e.g. 8:00, 8:10, 8:15, 8:20, 8:30, 8:40, 8:45, 8:50, 9:00 etc. The procedure is: 
 

1. In the Appointment Book Setup form, set the appointment interval to 10 minutes 
2. Click Write Roster.  Add a new line where the text message is blank, In Column 1, To 

Column 1, For 4 weeks, Every 1 Day, Between the surgery start time, And the 
surgery end time, Every 1 Slot. Tick the Do It box 

3. Click Write Roster Never Overwrite.  Close the Roster form 
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4. In the Appointment Book Setup form, set the appointment interval to 15 minutes.  
5. Click Write Roster.  Tick the Do It box for the line we added in step 2 
6. Click Write Roster Never Overwrite.  Close the Roster form 

 

Deleting old appointments 
 
By law you have to keep appointments for 7 years.  However too many appointments will 
slow down the system.  To delete old appointments: 
 

1. Backup Practice 2000 database.  Put away a permanent copy of the data  
2. In Practice 2000, click Admin Tasks, Advanced, Run SQL 
3. Type  DELETE FROM APPOINTMENTS WHERE [TIME] < # 01-AUGUST -2005 # 

(this will delete all appointments before 01 Aug 2005.  Please replace the above date 
with the correct value) 

4. Click OK. Confirm the deletion if asked 
5. Type  DELETE FROM APPTBOOK WHERE [DATETIME] < # 01-AUGUST -2005 # 

(please replace the above date with the correct value) 
6. Click OK. Confirm the deletion if asked 
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Adv Appointment form 
 
From 2005 this advanced appointment book will replace the previous one to provide 
additional functionalities: (1) providers can have different appointment lengths, e.g. 10/15/30 
minutes;  (2) appointment slots can have any colour, whereas previously only 3 colours were 
available. 
 
Use the Page Up / Page Down keys to scroll thought the form quickly. Clicking on the pop up 
calendar is the easiest way to move to different dates. The Back, Next (=>), Prev (<=) 
buttons are also handy. 
 

To make an appointment for an existing patient:  
 

�� Double click in the middle of the slot that you wan t to book the patient(s) .  The 
Find Clients form will appear 

�� Search and accept the patient.  The patient’s address, file number and minor file 
number will show up on the top right of the Appointment Book form. 

�� If the patient has referral details, Practice 2000 will check the referral date and the 
referral period to ensure that the referral is still valid on the appointment date 

 
Note for old appointment book users: Unlike the old appointment book, you are not allowed to type in 
the name of a patient in a slot anymore. 
  
To make an appointment for a new patient:  
 

�� Double click the middle of the slot that you want to book the patient(s). The find 
Clients form will appear. 

�� Click on New Client. Enter the patient Surname, First name (and phone number if 
necessary) Click OK/Close 

�� Accept the patient on the list.  
 
When making an appointment for a new patient, most of the time you would be on the phone. 
It is common to enter only the name and telephone of the patient and wait until the patient 
arrives to fill out the rest of the information. 
 
Click on the patient name then click on: 
 

· In W/rm : To bring a patient from the appointment book into the waiting room:  
· New Invoice : To bill (create a new invoice) patient 
· MDW/Locum : To write prescriptions (open the patient data in MDW2 or Locum) 
· Recall : To add a new recall. 
· Show : To display patient details 
· Double : To make double booking 

 
To print appointments:  click Print. Click on Yes to print appointment slip for patient to take 
home. Click No to print appointment list for doctor, one sheet per doctor. Each appointment 
includes name, address, and telephone number. 
 
To cancel an appointment : right click on the patient name and click cancel.   
 
Note: If you cut the appointment using the cut button instead of doing it this way, although patient has 
disappeared, the system will not record that it was a cancelled appointments 
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Cut / Copy / Paste: 
 
Once you have cut/copied a patient from a slot, you can put the patient in another slot: click 
the new slot, then click the button with the word PASTE (do not click the Paste icon on the 
toolbar).   
 
To find appointments for a patient : click the binocular icon and enter any part of the name 
of the patient you are looking for. It is wise to make your search criteria as unique as possible 
 

Resizing Columns  
 
Close Appointment book on all computer. Click Admin Tasks -> Setup -> Appointment book -
> Advanced. Select number of doctors and hour to be displayed on screen.  The fewer 
doctors are being displayed, the bigger each column will be. 
 
Moving Columns: 
 
Close Appointment book on all computers. Click Admin Tasks => Setup => Appointment 
Book => Doctors => Click on Change (next to column number) to set a new column number. 
 

Doctors’ workdays 
 
This allows you to specify what days a doctor works in any given week: 
 

1. Click Admin Tasks => Setup => Appointment Book => Doctors  
2. Select the doctor, then click Workdays. 
3. Type in the start date and the end date.  Select the workdays.  Click Save 
4. If you want to specify the workdays for other periods, click the New button and repeat 

the step 3. 
5.  When finished, click Close. 

 
If you want to delete any period, just highlight the period in the list, then click the Delete 
button. 
 

Scheduling 
 
Close Appointment Book on all computers. Click Admin Tasks => Setup => Appointment 
Book => Scheduling. The appointment scheduling form will appear. 
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1. Click New Template to clear the current scheduling template and create a new one 
2. Select length of template, there are 3 options: 1 week, 2 weeks and 4 weeks 
3. Tick on the week that you want to setup, tick on a day to select. 
4. Book patients / Block slots like what you do with the appointment book 
5. After finish setting up the template, select a day to start apply the template, select the 

number of weeks that you want to apply then click on Write Schedule. 
6. Schedule can be written in 3 modes:  

a. Never Overwrite: If a slot has already contained an appointments, never 
overwrite it 

b. Always Overwrite: If a slot has already contained an appointments, always 
overwrite it 

c. Ask before Overwrite: If a slot has already contained an appointment, ask user 
to decide if they want to overwrite it. 

 
Note: Appointments schedule will never overwrite a slot with patients by a blank slot no 
matter which options user select. 
 

Rostering 
 
Close Appointment book on all computers. Click Admin Tasks => Setup => Appointment 
Book => Rostering. The appointment rostering form will appear.  
 
Appointment rostering allows users to do scheduling for any period of time, ranging from one 
day to several years in advance.  
 
To add a new roster: 
For example, we need to set up the roster for Dr. Coulton. Select Dr. Coulton from the list of 
doctors then click on New Schedule. There are 4 types of roster you can use: 
 

1. Fixed Time: Occur only once for the specified period. 
2. Daily: Occur every day at a specified period 
3. Weekly: Occur every week at a specified period 
4. Monthly: Occur every month at a specified period 
 

Select the type and period that you would like to use. If it is fixed time, you may use the 
mouse to select a period from the calendar on the right instead of specifying the time 
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manually. Type the text that you want to display on appointment. You can also type the notes 
to clarify the purpose of this appointment schedule. Click on Save. 
 
To edit a roster: 
Select the doctor from the list. Highlight the schedule you want to modify and Click on 
Update to save the changes. 
 
To remove a roster: 
Select a doctor from the list. Highlight the schedule you want to remove and click on Delete. 

 
Colour Coding 
 
Practice 2000 appointment book supports unlimited colours. You might wish to use one 
colour on slots where the providers are unavailable, a different colour for patients who have 
been put into the waiting room, and another for patients who need urgent attention.  
 
Close Appointment book on all computers, click on Setup then choose “Appearance”, the 
Appointment book colour form is displayed. For each appointment type, you can change 
foreground, background colours, specify a special character associated or even specify a 
picture. The notes field is used if user wants to have any description of the appointment type. 
 
To change the colour, double click on the colour column and select the colour you like. 
 
Each appointment type can be used for every doctor (0 – System types) or can only be used 
for a group of doctors only. The group can be added/ removed/modified by clicking in Doctor 
Groups 
 
Changing colour after billing    
 
Once a patient has been billed from the waiting room, Practice 2000 can change the colour 
for the patient in the appointment book.  To switch on this feature, please: 
 
- Click Admin Tasks, Advanced, Miscellaneous  
- Look for a line with the parameter OptionBillCheck.  Change its value to TRUE 
- Close Practice 2000 and run it again. 
 

SMS Reminder 
 
User can send SMS from Practice 2000 to remind patient about their recalls or appointments. 
SMS can be purchased for 25 cents per message. For information about registration fee, 
contact us. 
 
Once you have completed the registration process. There are two ways to send SMS on the 
system. 
 

Sending SMS to each individual patient 
 

· On the appointment book, click on the slot having the patient that you want to send 
SMS to 

· Click on SMS button on Appointment Book form 
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· Enter the message that you want to send to patient, click on Preview to see the 

message first or click on Send to send it immediately 
 

Sending SMS to all patients having appointments wit hin an 
period 
 
On the Main form, click  More -> SMS 
 

· Select the date in appointments  
· Select the doctor(s). You can select only 1 doctor or all the doctors 
· Type / Select the message you want to send to all patients or simply select a stored 

message on the list. 
· Un-tick patients that you do not want to send SMS 
· Click on OK  

 

To delete an SMS template  
 
Click Admin Tasks, Setup tab, SMS Settings.  The SMS-Email Preferences form will appear. 
 
Click the Templates button.  A list of templates will be displayed. 
 
Click on the grey margin of the row that you want to delete.  The whole row will be 
highlighted  
 
Press the Delete key on the keyboard.  You will be asked to confirm the deletion. 
 
 

To create a template 
 
Go to the last row of the template table.  In the first column, type the name of the template ( 
e.g. My Template) 
 
In the second column, type the SMS message you want to send.  The message contains 
special words such as %PatientName% which will be replaced by real data from your 
database before transmission. 
 

Listing patients who have been SMS’ed 
 
Practice 2000 can change the colour in the appointment book to indicate which patients have 
been texted (this option can be turned off).  Additionally the Audit Log keeps a list of these 
patients.  To display the patient list: 
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- Log into Practice 2000 as Admin 
- Click Admin Tasks, Audit Log.  A Find Logs dialog will be displayed 
- In the Others box, type SMS 
- In the From and To boxes, enter the dates of interest 
- Click Find Now.  A list of patients will be displayed. 
 
 

Confirmation Letters 
 
This feature prints out a reminder for the patient on the appointment book. The content of the 
letter is fully customisable. To use it, click on Reminders. To setup: 
 

· Download new version 
· Ensure the PC has folder C:\Practice\Letters 
· Copy the template ApptReminder.doc into C:\Practice\Letter Templates 
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Recalls form 
 

 
 
Use the Recall system to ensure the patient returns for further consultations or tests 
 

Creating a new recall 
 

· Click New Recall 
· Enter the date the patient is due back, or double click the date field to bring up a 

calendar, or click the down arrow to select a period 
· Select a reason for the recall from the drop down list, or enter a short message such 

as “X-RAY” 
· Select the provider and the business address 
· Close the form. The record will be saved automatically 

 
Every Monday, Practice 2000 automatically print recalls that are due in the next 2 to 3 
weeks. Click Setup to change when to print. 
 

Printing recalls manually 
 

· Click Find, enter the recall dates, and click on Find Now to display reminders to be 
printed 

· Click Preview All to print all displayed recalls.   
· Click Print This if you want to print only one recall 

 
When a recall is printed, the date is recorded as Date Contacted. If you contact by phone, 
click the Patient Contacted  button to record the date. 
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If you bill a patient whose recall is due, Practice 2000 will display the recall. Click Patient 
Returned  to record the date of return. This will make the recall inactive, i.e. stop the recall 
from being printed or popped up on screen. Please do not delete the recalls for legal 
reasons. 
 
Click Recall Reasons  to add new reasons. Text to be used in recall letters can be 
customized. To create new paragraphs in the letter, press Control-Enter. 
 
You can alert the operator that something needs to be done when the patient next returns to 
the practice. Just create a recall with today as the due date. Enter your short message in the 
recall reason. When the patient returns, the recall will be automatically displayed. Deceased 
patients will not be recalled. 
 
After the first recall, the patient may not come back. To do second recalls : 
 

· In Recalls, click Find 
· In the “Due Between” field and the “And” field, enter the period that you want to do 

the second recall. 
· Click Find Now.  All recalls without patient returning will be displayed. 
· Click Preview All and then Print.  The patients who have been recalled previously will 

be printed as second recalls. 
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Admin Tasks form 
 
These are the tasks for the administrators.  The user must be in the Admin group to run 
them.   
 
The Setup tab of the Admin Tasks form has been discussed in the Setting Up Your Practice 
section.  The Advanced tab is for software support purposes only. You should only use it 
under our guidance.   
 
The command buttons in the General tab is discussed below.  For Medclaims, Payments 
Received, and Staff Pay, please refer to their own sections in this manual where they are 
discussed in detail. 
 
Message of the day is displayed in the Main Form, updated every 10 minutes. You can 
add/edit the message, then click the Save Record icon on the toolbar. 
 

Earnings form 
 
To find out what each doctor has earned in a given period: 
 

�� Open Admin Tasks. Click Earnings 
�� Enter the period in the From and To dates.  Or double-click the dates to bring up a 

calendar 
�� In the Calculations By box, select Audit Trail if you want to pay the doctors, or click 

Transactions if you want to do tax returns. 
�� Select a particular doctor/account/business/fee scale if required.  If no selection is 

made, earnings for the entire clinic will be shown 
�� Click Recalculate to display the earnings. 
�� To print the earnings exactly as you see on the screen, click the Printer icon on the 

toolbar, or click the File => Print menu.   
 
If the calculation is done by transactions, the Received column in the Earnings form should 
match your banking statements exactly.  The amounts received with and without GST help 
you do your Business Activity Statements for the tax office. 
 
The white boxes allow you to select the earning dates, doctors, bank accounts, fee scale 
type and businesses.  They give you great flexibility in earnings reporting.  Click Recalculate, 
after editing these boxes, to see the earnings.  To clear the boxes, click Clear Search. 
 
Click Transactions  to print report of all the items billed, money received and adjustments to 
invoices.  These are the transactions that are dated in the chosen period.  For example, if the 
earnings period is today, then only invoices dated today will be printed.  On the other hand, 
the Audit Trail  button prints all transactions entered today, even if the invoice is backdated 
to a previous date. 
 
THE DIFFERENCE BETWEEN AUDIT TRAIL AND TRANSACTIONS  
 
Suppose on 30 June 2004 you receive a cheque for $100 from a patient wanting to pay an 
outstanding invoice. You are too busy that day so you do data entry on the next day, 1 July. 
You find the invoice, click New Payment.  In the Date Received box, you back-date the 
cheque to 30 June.  Now: 
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· From Admin Tasks, click Earnings.  In the From box, type 01/06/04.  In the To box, 
type 30/6/04.   

· Select the Calculations as Transactions.  Click Recalculate to display the earnings for 
June.  The Received column will include the $100. 

· Now select the Calculations as Audit Trail.  The Received column will NOT include 
the $100 because the money was NOT entered in June.  Only the Audit Trail for July 
will have this amount 

 
The above example illustrates the fact that the Audit Trail and the Transactions will be 
slightly different because of the backdating of cheques.  We recommend you to use the 
Receipts printed in the Audit Trail to pay the locum doctors.   
 
Other tasks: 
 

· Click Receipts  to print report of all money received, including Medclaims payments. 
· Click Cumulative  to print earnings for today, this week, this month and this financial 

year.   
· Click List Items  to see report of how many times an item is prescribed, and the 

amount billed. 
· Click Daily Billings  to see how much is earned day by day, including GST amounts. 
· Click Patients/Hour  to see the number of patients seen at 9 am, 10 am, etc.  This 

helps you schedule doctors to meet demands. 
 
Click Item Groups  to print the total earnings for each group of items.  For example, all 
consultation items can be put in the group “CONSULTS”, while the vaccination items can be 
put in the group “VACCINES”.  Then you know how much is earned by the Consult items and 
how much by the vaccination items. To set the group that each item belongs to: 

· Click Admin Tasks, Setup, Fee Scales 
· In the Group column, type the name of the group for the item, e.g. CONSULTS 

 
To plot a graph  of the number of patients, click Draw Patients. To see how the number of 
patients fluctuates per hour during the day, choose Graph By Hour on the Earnings form.  To 
see the number of new patients, click Draw New Patients 
 
Click Vaccinations  to print a list of patients who have been vaccinated. Before this, you 
must have already created an item for vaccination in Admin Tasks - Fee Scales. Then for 
each vaccinated patient, create a Private Patient invoice containing this item. 
 
If you prefer that each doctor can only see his/her own earnings: 
 

1. Setup the User Security system, each doctor should have an account with his/her 
own username and password. For more information go to Password and Security 
section 

2. On Admin Tasks -> Advances -> MISC, change the value of OnlyDoctorSeeEarnings 
to TRUE 

3. Click on Admin Tasks -> Setup -> Doctors, specify the user who has the permission 
to view this doctor’s earnings 

 



 

70  
 

 
 
 
 

Overdue accounts form 
 

 
 
 
Each day you create many invoices to bill patients.  It is important to ensure that all invoices 
are eventually paid off.  The Overdue Accounts form lets you know who has not paid. 
 
From the Admin Tasks form, click Overdue Accounts. A list of debtors will be displayed, 
separated into current/30+/60+/90+ days. The 90-day accounts are for those due between 90 
days and 2 years.  The 2-year limit is there to improve the calculating speed.  When printing, 
there’s no limit, i.e. all accounts due for more than 2 years are also printed. 
 



 

71  
 

You should not let any patient owing you for more t han 90 days, i.e. the 90+ column 
should show a zero amount. 
 

· Each month, to print Accounts Rendered: click Preview Reminders, then click OK 
several times until a report is displayed. Click the Printer icon. 

· To see a debtor’s address, click on the debtor, and then click Show Payer . To see 
the accounts, click Show Invoices .  

· To print the debtors’ list, click Preview Debtors . Enter the period for the accounts 
you want to see. When a report is displayed on the screen, click the printer icon on 
the toolbar. 

· To print the amounts owing for each fee scale, click Preview Fee Scales . 
· The Debt Collection Note  column displays your discussions with the debtor. You 

cannot directly write the notes here. To write in this column, click Show Invoices. In 
the Invoices form, click the Debt Collection button, and then write in the text box 
provided. 

· To customize messages for overdue accounts: before reminders are printed, you will 
be prompted to enter messages or to accept default. 

· Each month, you need to print Accounts Rendered. To do this, click Preview 
Reminders, click OK several times until a report is displayed. Click the File menu, 
Print command. In the Print dialog box, enter the pages you want to print, e.g. 1-50, 
then click OK. The specified pages will be printed on the default printer. You can 
repeat the process to print pages 51-100 etc until finish. If your printer has enough 
paper, you can print them all in one go. 

 
You may not want to print accounts rendered for some debtors, e.g. solicitors. To exclude 
these debtors, double click the No Print  check box. Medicare and Veterans accounts are 
automatically excluded. 
 

Transaction Items form  
 
This form given the following data: 
 

· Items billed to the patients: These items have the type Sales/Service. 
· The amounts allocated to the invoices: These items have the type Receipt.  
· Adjustments made to the invoices:  These items have the type Adjustment 

 
Click Find to select the items to display.  You can sort the records and print them. You can 
also click on a record and click Show Invoice or Show Payment to see the original cheque or 
payment.  One cheque payment can be used to allocate to 1 or more invoices belonging to 1 
or more accounts.   
 

Repair and compact data (Practice 2000 Access versi on 
only) 
 
You should repair and compact data everyday to make the system run faster. After power 
failure you should immediately do repair because data might be corrupted.  To do 
repair/compact: 

1. Close Practice 2000 on all computers except the server.   
2. On the server, click Admin Tasks, Repair/compact data, OK, OK.  

 

Audit log  
 
This feature keeps track of changes to invoices, payments, appointments etc. On the server, 
the LOGS subfolder of the main PRACTICE folder stores details of these changes, day by 
day.  You can use these details to re-enter data in case of catastrophic system failures. 
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Print Patient File Number  
 
This feature print a list of patients for use in case your computer system is out of order. 
Roughly 400 patients are listed on one A4 sheet.  
 
You can print only those patients who have been registered after a certain date.  To print 
everyone, enter a very old date such as 01/01/1950.  
 
If some patients do not get printed, they are probably transferred from another software 
package and hence do not have a registration date.  We can pretend they have been 
registered on 1/1/1990 as follows: 

 
1. In Admin Tasks, click Advanced, Run SQL 
2. Type UPDATE PATIENTS SET TIMESTAMP=#01/01/1990#  WHERE 

TIMESTAMP IS NULL 
3. Click OK and confirm the update. 
 

Duplicate Patients  
 
This forms shows all patient records having the same surname, first name, and birth date.  
You should have only one record per person.   
 
Duplicate records may arise if you have used another software previously.  If you enter 
patient data into Practice 2000 from scratch, you should not get any duplicate record 
because Practice 2000 checks the records as you enter them. 
 
To merge all duplicate records automatically, please click Merge All. This can take a long 
time, so please run it at night. Do this only if you are absolutely sure that you have examined 
the duplicate patient list thoroughly: you do not have a choice of which record to keep and 
which to be merged for any duplicate patients. If you want to have control, select the record 
that you want to delete then click Merge + Delete This Record 
 

Summary For Deleted Invoices  
 
Clicking on this button gives a report on all deleted invoices.  This feature is useful for 
accountants and auditors. 
 

Archive Patients  
 
Shows patients who have not attended the surgery within a given period (and have not 
returned since). This feature is used to cull files for patients who have left permanently.  The 
Patient records will show a fee scale named ARCHIVED.  If the patient returns for 
consultation, you can change the fee scale back to eg. Private patient. 

 
Number of Referred Patients  
 
This form lists the number of patients sent to your specialist practice by the referral doctors 
whose records are listed in the Address book.  
 

Print patient address book  
 
Prints all details for all patients.  
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Where Clients Heard About You  
 
This form gives you a graph of the number of patients coming from each source of 
advertisement, e.g. Yellow Pages, local newspapers, word of mouth etc. Use it to compare 
the effectiveness of your marketing campaigns.  In the Patients form, click the More tab and 
then enter the source in the “Hear From” field.  
 

Print all invoices  
 
This report is designed for accountants and auditors. Deleted invoices are shown. 
 

Print all receipts  
 
This report is designed for accountants and auditors. Deleted receipts are shown. 
 

Payments Received form 
 
All payments are kept in this form. When opened, this form displays only un-banked 
payments so that you can check and print a banking statement.  To see any other payments, 
click Find.   
 
Printing all payments for all doctors:  
 

1. Check the list of payments against the cash and cheques held in your cash drawer. 
When things are OK, click Clear Drawer.   

2. Answer on-screen questions for various printing options.  
3. Print one statement to send to the bank along with your cash and cheques.  Print a 

second statement to keep for your tax record.  
4. In Payments Received form, the date you bank the cheques will be written, along with 

the banking sheet number. 
 
Printing the banking statement for a particular doc tor: 
 

1. Click Find.  The Find Payments form will be displayed 
2. Select the doctor account.  Click the Banked check box twice to clear it (i.e. make it 

white). 
3. Click “Find Now” to display un-banked payments for this doctor. 
4. Click Clear Drawer 

 
PRINTING A BANKING STATEMENT NOT CONTAINING CREDIT CARD (OR CASH) PAYMENTS 
 

1. In the Payments Received form, click Find.  The Find Payments form will be 
displayed 

2. In the Type box, select Credit Card (or Cash) 
3. Tick the Exclude radio button, and then click Find Now 
4. Click Preview All 

 
Tips: Sometimes you have to correct some past mistakes by entering a payment.  This 
payment is now displayed as an un-banked payment on the Payments Received form, but it 
has actually been given to the bank already.   
 
Preventing a payment being printed in the banking s tatement: 
 

1. Click the Allow Editing icon on the toolbar 
2. In the Banked column for this payment, enter the date that it was banked 
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3. In the Sheet number column, enter the banking sheet number, or leave blank if you 
don’t know 

4. Once you have clicked Clear Drawer, there’s nothing left in the drawer. So if you click 
Clear Drawer again, it will say “There’s nothing to print”.   

 
Printing a duplicated banking statement 
 

1. Click Find.  The Find Payments form will be displayed 
2. Enter the banking sheet number, or the date you banked the payments.  Click Find 

Now 
3. In the Payments Received form, click Preview All.  After a few questions, a report will 

be displayed. 
4. Click the Printer icon on the toolbar to print 

 
The Find  button gives you many options to search for payments, for example payments that 
have been received on certain dates, payments that have been deleted, or the receipt 
number.  Once displayed, clicking Preview All can print these payments. 
 
In some large practices, the banking statements are printed in the middle of the day.  While 
the payments are being checked, more payments are recorded into the system.  These new 
payments should not be printed in the banking statement.   
 
Print the banking statement up to a given payment: 
 

1. In Payments Received form, note the Receipt Number for the latest payment, e.g. 
2345 

2. Click Preview All to print a trial balance. 
3. Check your cash and cheques.  While doing this, more payments may come into the 

system. 
4. Click Find.  Enter 1 for the ‘Receipt no. from’ and 2345 for (the Receipt no.) ‘To’ 

fields.   
5. Click the Banked check box twice to make it all white. 
6. Click Find Now, and then click Clear Drawer. 

 
Other features: 
 

· EFT payments from HIC are recorded and automatically allocated to invoices, except 
when discrepancies prevent this (see Manual Allocation – or Reconciliation). 

· To add payments received from sources other than patient payments: click New 
Income and enter a positive amount 

· To take money from your cash drawer for petty cash expenses: click New Income 
and enter a negative amount. This will reduce the cash amount in your banking 
statement. However, we recommend you to use the Expenses form (Main Form) to 
keep track of your expenses. 

· Deleted payments are stored for security reasons. To see them, click Find, tick the 
Deleted check box. 

· Payments not fully allocated to invoices can be found by clicking Find. They should 
be deleted, as all payments should be fully allocated. 

· To set up income/expense categories: click Admin Tasks, click Setup and click 
Transaction Categories. 

· To find total payments for invoices that fall in a given period: Press F11 to show the 
Invoices form, click Find, enter a period, click Find Now, click Show Items. The totals 
can be found in the yellow boxes at the bottom. 
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Expenses form 
Bank Reconciliation: 
 

· From the Main Form, click Expenses 
· Click Find button on the Expenses Form, the Find Transactions form open. 
· Enter bank statement’s start date on the Between  textbox 
· Enter bank statement’s end date on the and textbox 
· Click on Uncleared  check box, and click Find Now.  

 
The Expenses Form will show you all expenses in the period you entered. The last collum of 
each row is the Clear  check box. You compare all expense items in the form with the 
expenses in your bank statement. If one expense in the form matches with one in your bank 
statement, click on the Clear  checkbox. After finish checking all the expenses, click 
Reconcile  to clear them off. If all expenses match, the form should have no expense left. If 
there are some expenses in the form, it means those expenses are not matched, and you 
have to investigate the reason.  
 
If you want to see cleared expenses, uncleared expenses or both type, of some time in the 
past, for example in the last month, enter the start time and end time, and select the 
corresponding check box in the Find Transactions form. 



 

76  
 

MedClaims form 
 

 
 
Claims for Medicare / Veteran Affairs / Immunisation can be transmitted electronically. A 
claim is also called a batch. In Practice 2000, each Medicare/Veteran/Immunisation voucher 
must be entered as an invoice. Both GPs and specialists can use Medclaims. 
 
Bulk Billing Claims General Info 
 

· At the end of each day, batch the vouchers into claims.  Specialists usually batch 
once a week. 

· Transmit the claims.  A summary of each claim will be printed in 2 copies.  Please 
mail a copy to HIC, and keep the other copy for your record. 

· After transmission, Practice 2000 will read in electronic messages from HIC.  There 
are 2 types of messages: Exception Statements and EFT Payment Reports. 

· An Exception Statement contains a list of vouchers that are not paid (or only partially 
paid) by HIC, and reasons for the rejections.  The exception statement indicates what 
HIC plans to pay you, but they have not paid into your bank account yet.  Please do 
not resubmit rejected vouchers or do anything when you just see an exception 
statement .  

· An EFT Payment Report tells you that money has been deposited into your bank 
account. Practice 2000 does a number of things when it receives this report: 

1. It fills in the amount paid and the date paid in the record for that claim in the 
Medclaims form 

2. It tries to reconcile the claim, i.e. to create a payment for each voucher in the 
claim so that the amount owing on each voucher becomes zero.  Rejected 
vouchers will remain outstanding. 

3. If the automatic reconciliation is successful, the Receipted check box in the 
Medclaims form will be ticked.  An EFT payment record will be created in the 
Payments Received form for the total amount paid. 
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4. If the automatic reconciliation fails, a message will be displayed asking you to 
do a manual reconciliation.  Automatic reconciliation generally fails if (1) the 
same claim number was mistakenly used for 2 claims or, more usually, if (2) 
you have changed details of a voucher, or taken a voucher off the claim, after 
the claim has been transmitted.  Please see below on how to do manual 
reconciliation. 

5. A report for EFT payments for any doctor for any period can be found by 
clicking EFT Payments from the Medclaims form or the HIC Online form, then 
clicking the Find button.   

6. Each payment contains a Run Number, which is a unique number generated 
by Medicare Aust to identify the payment.  This number should appear in the 
statements from your bank.  You should make sure all run numbers appear on 
your bank statement.  Sometimes the payments actually go missing!!!  
Medicare Aust’s payment system is not perfect. 

· After automatic or manual reconciliation for a claim, click the Exception Statement 
button to resubmit the rejected vouchers (see below on how to resubmit) 

· After resubmission, from the Medclaims form, click on the claim record concerned 
and click Edit Vouchers to verify that all remaining vouchers have been paid off 
correctly, i.e. all amounts owing show zero.  Your aim is to ensure that all vouchers 
are paid off eventually.  For any unpaid vouchers that cannot be chased up, make an 
adjustment so that it shows zero owing 

· Once all vouchers in a claim has been taken care of, in the Medclaims form, click 
Allow Editing icon and tick the Clr (Clear) check box for the corresponding record.  
Next time you open the form, the claim will not be displayed. Your aim is to make the 
Medclaims form display only claims that have not been reconciled 

 
Batching the vouchers into claims  
(and optionally transmit them electronically) 
 

· From the Main Form, click Admin Tasks, Medclaims/BB Claims, New Claims, OK 
· Get a DB1 form (the claim header), have the doctor sign it, then click OK 
· Enter the claim number from the DB1 form (eg. Medicare/Veterans claims: A1234, 

Immunisation claim: A123456; Medicare claim for HIC Online is automatically 
generated without a DB1 form: A1234@). Each claim number has to be unique; do 
not use a claim number twice. Do not enter spaces in the claim number. 

· Select a service provider from the drop-down list. This is the doctor who did the 
consultations.  

· The payee doctor will appear according to the doctor’s record. However, the payee 
doctor could be selected from the drop-down list as well. Select the Fee Scale 
(Medicare/Veteran/Immunisation) from the drop down list 

· Select the type of service (General/Specialist/Pathology/Allied Health). Click OK 
· Enter the period for the vouchers to be batched, or just click OK to accept the default 

period 
· Practice 2000 reports the number of vouchers and the total amount claimed. 

Electronic Medclaims allows up to 99 invoices per claim; but HIC Online will prune the 
number of invoices down to 30 invoices per claim, if necessary.  When asked if you 
want to see the vouchers, click No 

· When asked if you want to put the claim in a queue for electronic transmission, click 
Yes or No 

· When asked if you want to do another claim, click OK if you want to batch for another 
doctor. Otherwise click Cancel to finish batching 

· When asked if you want to transmit the claims now, click “Yes” button. Several claims 
can be transmitted in one go. 

· Vouchers will now be checked for errors: date of transmission, provider number, 
Medicare number, patient’s birth date, item numbers etc. This checking takes a few 
more seconds, yet it saves you lots of hassles later on. 
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· If a Medicare number is missing, or the Medicare number is not valid, or the Medicare 
Issue number is missing, a table will be displayed so that you can correct the 
numbers. After correction, click the cross to close the table down. If you don’t know 
the correct number, just close the table. 

· If a Medicare number is still missing, the table is displayed again to give you a second 
chance to fix the problem. You must enter the patient’s date of birth and suburb. After 
correction, click the cross to close the table down. 

· The modem will make ‘dialling’ noises and start transmitting. It will also check your 
mailbox and read any messages sent to you by HIC. 

· A batch listing will be printed. You need to mail this report along with the DB1 form 
to HIC. Don’t forget to put the red EDI sticker (from HIC) on it . 

· You should print a second listing and keep for your own records. 
 

Important Note: AFTER A BATCH HAS BEEN TRANSMITTED, DO NOT CHANGE O R 
REMOVE ANY VOUCHERS IN THE BATCH UNTIL THE BATCH HA S BEEN PAID OFF. A 
batch is paid when the Medclaims form shows the amount paid for it. 
 
About 1 business day after transmission, HIC sends you a text message to indicate whether 
they have successfully received the file. Practice 2000 will display error messages only. All 
messages are stored in C:\DPS\HICMSG on the Medclaims computer. 
 
A typical error message may say “FAILED DPS DECRYPTION”. This means the encryption 
key held at HIC does not match the encryption key on your computer, so they cannot read 
the file you transmitted. The solution is to resend the key (From the Medclaims form, click 
Send Key). After 3 days, if you still receive the error message, please contact HIC. 
 
About 8-10 days after transmission, money will be deposited in your bank account. The 
Medclaims form will display the amounts and the date received.  
 

· To print the amounts: from the Medclaims form, click EFT Payment, Preview 
Summary. 

· If a batch payment can be (and was) receipted automatically, the “Recpt” check box 
in the Medclaims form will be ticked. If not, you have to receipt manually as discussed 
later in this section. 

· If a batch is not paid in full, a blue star will appear in the Medclaims form. Please 
resubmit rejected items as discussed later 

· After a batch is paid in full, or after resubmitting rejected items, tick the Clear box so 
that the batch will be hidden, i.e. not displayed in the Medclaims form any more. You 
can still display the cleared batches any time by clicking Find in the Medclaims form.  

 
Each claim contains a number of invoices. To print the invoices, click on the claim, and then 
click Print Claim. To display the invoices on the claim, click Edit Claim. 
 
Each invoice can be batched into one claim only. To see what claim an invoice is in: 
 

· Open the Invoices form. Click Find 
· Enter the patient name and the invoice date. Click Find Now 
· Click Edit/Delete to display the Invoice Details form. 
· The claim number will be displayed. If there’s no claim number, the invoice is not 

batched. 
· Before the transmission of a claim, you can edit any of its invoices. If you want to take 

the invoice out of the claim, highlight the Claim no. field and delete the claim number 
(Access version) or click the Clear button next to the Batch no. field (SQL version). 
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Exception statements and EFT payment reports are automatically received (and temporary 
stored in C:\DPS\DPS2PMS) each time you do a transmission. They are then stored in 
C:\DPS\EFTEXCEP on the Medclaims computer. 
 
EFT payments are automatically allocated to invoices, provided that you have not changed 
anything in the batch of invoices.  
 
Do not touch  any voucher in the batch before the submitted batch is paid off . This means 
in general (1) do not delete the batch number in the vouchers, (2) do not change or delete 
any item in the vouchers or (3) do not delete the vouchers. 
 
Manual Allocation 
 
If an invoice is edited or deleted from the batch, the allocation of EFT payment will not be 
successful. Practice 2000 will display a message asking you to do the allocation manually. 
Please: 
 

1. In the Medclaims form, note the amount and the payment date for the batch.  
2. Click on the batch, click Exception Statements, then click Preview Details to display a 

report. Click the Printer icon on the toolbar to print the report. Close the report by 
pressing the Escape key 

3. Close the Exception Statements screen.  Click Edit Vouchers to bring up the Invoices 
form, which shows the vouchers for this batch.   

4. Use the Exception Statements report to find the invoices that have been rejected.  
For each such invoice: 

a. Click on the invoice, then click Edit/Delete to display the invoice details.   
b. Fix the problem raised by HIC, e.g. Not Normal After Care. 
c. Delete the Claim no. of this invoice.  This will take the invoice off the claim. 
d. Click OK/Close to close the Invoice Details form 

5. After all rejected invoices have been taken off the claim, click Find in the Invoices 
form.  In the Bulk Bill Claim box, type in the claim number.  Click Find Now.  The 
Invoices form will show all invoices that remain in this batch. 

6. The total amount for the batch should match the EFT payment amount. If not, check 
the batch against the batch report that you sent to HIC.  Add, edit or delete vouchers 
in the batch until the amounts are the same. 

7. If the total amount owed for the batch matches the EFT payment amount, click New 
Payment in the Invoices form. The Payment Allocation form appears.   

8. Enter the payment details on the top. Click Auto Alloc. Click Close. The batch has 
now been paid off. 

 
Medicare numbers are automatically updated from electronic exception statements. 
Medclaims passwords & encryption keys have to be changed regularly as required by HIC. 
Practice 2000 automatically does this for you. 
 
Rejected items (items that have not been paid) can be displayed: click Exception 
Statements, then All Items. Clear them when action has been taken. 
 
Resubmitting Rejected Invoices in a Batch 
 

1. From the Medclaims form, click on a batch that has not been paid in full (it has a blue 
star), click Exception Statements to show rejected items. 

2. To see the reasons for rejection, scroll to the right. 
3. To print the list of rejected items, click Preview Details; click the Printer icon on the 

toolbar. 
4. Click on a rejected item; click Show Patient to fix incorrect patient details such as the 

first name or the Medicare number. Close the Patients form to return to Exception 
Statements. 
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5. Click on a rejected item; click Show Service, Edit/Delete to fix incorrect invoice 
details. Sometimes you need to add “Not Normal Aftercare” or “Second Service in 
one day” to the Notes box of the invoice. Close the Invoice Details form and the 
Invoices form to return to Exception Statements. 

6. Sometimes the patient name is misspelled. Clicking Show Patient or Show Service 
will not bring up the patient or the invoice. Please go into the Patients form or the 
Invoices form and click Find to find the correct record yourself. 

7. After all invoices have been fixed, click Resubmit in the Exception Statements form. 
This will remove the invoices from this particular batch so that they are ready to be 
rebatched. They will be included in the next claim to be batched for this provider. 

 
Sometimes the Resubmit function fails to find an invoice, for example because of wrong 
patient name. The solution is: 
 

1. Go into the Invoices form. Click Find to bring up the correct invoice.  
2. Click Edit/Delete. In the Invoice Details form, click the More tab. 
3. Delete the Bulk Bill Claim number by highlighting the number then pressing Delete on 

the keyboard 
4. Click OK. This takes the invoice off the old batch.  
 

If an invoice has 2 items, one is paid in full and another not paid, the solution is: 
 

1. Go into the Invoices form. Click Find to bring up the correct invoice.  
2. Click Edit/Delete. In the Invoice Details form, highlight the unpaid item, then click 

Delete Line. Click OK to close  
3. In the Invoices form, click New Invoice to create another invoice just for the rejected 

item. This invoice will be batched into the next new claim. 
 
You can re-transmit a claim that has already been sent. Click the “Send?” Column, then click 
Transmit. Several claims can be transmitted in one go. 
 
At any time, you can read reports sent by HIC regarding EFT payments by clicking Get 
Electronic statements 
 
If a transmission is not successful, you can find out why as follows: 
 

· In the Medclaims form, click Setup, write down your current Medclaims password 
· Click Cancel to return to the Medclaims form.  
· Click Medclaims DPS, enter password, press Enter 
· Type 5 to view audit file, type Yes to confirm.  
· Look at the audit file to see what’s wrong.  
· Press Escape twice to quit DPS. 

 
The HIC’s Document Preparation System (DPS) is a program to encrypt your data before 
transmission so that no one except the HIC can read it.  DPS keeps a record of what has 
been encrypted.  You can view this record by clicking MedClaims DPS. Consult the DPS 
User’s Manual (from HIC) for more details. 
 
Sometimes the encryption key is lost during transmission to HIC. They will ask you to send 
again. Just click Send Key in the Medclaims form. If the automatic update of your encryption 
key fails, a message like “…key expired…” will result at the next attempt of transmission. 
Click Setup, Make key.  
 
If the modem does not ring when you are sending files: try running HyperTerminal to ring any 
number, then go back to Practice 2000 to send the files again. This has been found to help. 
To run HyperTerminal: click Start, Programs, Accessories, Communication, HyperTerminal. 
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Batching Hospital Services 
 
Bulk-bill hospital services can be batched separately from bulk-bill room consultations. A new 
fee scale called BBHosp must be setup as follows: 
 

1. In Admin Tasks, Setup, Fee Scales, click New Scale;   
2. Type: Fee Code = BBHosp (exact spelling please), Fee Name = Hospital Bulk-billing.  

Click the Change button to change the Default Payer to MEDICARE;   
3. Tick the Batch Invoices and EDI check boxes;  
4. Click Copy Fees, type in 5, click OK, type in 0.75, click OK, OK. 

 
(Hospital Bulk-billing fee scale is available as from Practice 2000 Access version 4.04 or 
Practice 2000 SQL version 2.35 SQL) 
 
When creating new invoices, select the BBHosp fee scale in the Invoice Details form.  When 
batching, select the BBHosp fee scale in the Bulk Bill Claims form. 
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HIC Online form 
 
HIC Online allows you to bill patients (private/bulk-bill/DVA/Child Immunisation), then send their claims 
to HIC via the Internet.  For private patients, you can: 
 

• Charge the full fee, say $35.  HIC will pay the $25.70 rebate by EFT into the patient’s bank 
account within 2-3 days (or by cheque if the patient prefers) 

• Charge the gap, say $10.  HIC will send a cheque to the patient.  If the patient does not present 
the cheque to you within 90 days, HIC will direct credit your bank account. 

 
The current Practice 2000 HIC Online (Ver 2.8.6) has been approved by HIC in late April 2004 and is 
now being used by about 130 clinics.  Initially you will find HIC Online annoying because it demands 
accurate data entry, especially the Medicare Reference number for patients.  But after a while you will 
find it fast and reliable. 
 
We have implemented the full range of HIC Online features, including: 
 

• Online Patient Verification (to see if a patient qualifies for Medicare rebate) 

• Same Day Claim Delete (if you have made a mistake in a Private Patient claim) 

• Claim transmission with or without individual keys 

• Eclipse (transmit claims to private health fund) 
 
Eventually HIC will phase out Medclaims in favour of HIC Online.  When register for HIC Online, you 
are qualified for a $750 incentive from HIC (metro area).  HIC Online version 2 runs on Windows 
2000/XP AND Terminal Services. 
 
To get HIC Online: 
 

1. Ring 1800 700 199 to arrange for HIC people to visit your clinic.  They will explain how HIC 
Online works, and register your clinic.  Registration takes about 2 weeks. 

2. Arrange to have Internet access at your clinic.  Dial-up Internet is OK because you can 
transmit patient claims at the end of the day, similar to Medclaims.  Broadband Internet is 
useful if you want to send claims on the fly so you get money back faster.  Broadband costs 
about $30 per month – and you get an extra phone line. 

3. Call us for assistance to install HIC Online from the attached CD.  If you are already running 
the SQL version of Practice 2000, installation will take about 1 hour.  If not, we will convert 
your Access version to SQL – about 2 hours. 

 
How to send a Patient Claim (for private patients)  
 

1. Create an invoice for a private patient as usual.  After entering all items, click 
OK/Close to close down the Invoice Details form.  The Payments Allocation form 
appears 

2. Enter payments (if any) and allocate the payment to the invoices as usual 
3. If you have a broadband Internet connection, choose the PClaim Now  option so that 

the claim can be transmitted straight away  
4. If you have a dial-up Internet connection, choose the Store PClaim  option to store 

the claim on the computer so that you can transmit at the end of the day. 
5. Click on Deem Printed.  A tax invoice will NOT be printed. Instead, a Statement Of 

Claims and Benefit  or a Lodgement Advice  will be printed and must be given to the 
patients. These forms serve the same purpose as tax invoice. However patients 
cannot use those form to claim benefit from Medicare office. 
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6. If patients do not wish the clinic to claim on behalf of them, click to choose the No 
PC1 option and click on Print This Invoice. A tax invoice will be printed as a proof of 
service. 

 

To change the claim number 
 
Double click on the claim number itself. 

 
To resubmit a Patient Claim  
 
After transmitting a new invoice as above, HIC Online might display an error message, for 
example because the Medicare number is invalid.  Please: 
 

1. Find the patient and fix any incorrect patient details 
2. Go into the Invoices form and find the offending invoice.  Edit the invoice to fix any 

problem.  Close the Invoice Details form. 
3. In the Invoices form, click on PClaim Now to retransmit the claim straight away, or 

click Store PClaim for transmission at the end of the day. 
 

To delete a Patient Claim on the same day 
 
After you have transmitted a patient claim, you can change your mind and delete it as 
follows: 
 

1. In the Invoices form, click on the invoice you want to remove 
2. Click on Same Day Delete 

 
To transmit stored Patient claims 
 
If you have a dialup Internet connection, then you would be storing patient claims steadily 
during the day.  At the end of the day, transmit them as follows: 
 

1. Connect to the Internet using your modem. 
2. On the Main form, click Admin Tasks -> Manage Stored Claims 
3. Check the list of claims.  If you want to delete some claims then: 

a. Tick the Del box for these claims 
b. Click the Delete button at the bottom 

4. If you want to hold some claims while transmitting others, un tick the checkbox in 
front of the claims you want to holds 

5. Click Transmit Selected Claims to send any claims that have not been deleted and 
being on the queue 

6. Close down the Internet connection. 
 

To check for a patient’s Medicare eligibility 
 

1. In the Patients form, find the patient that you want to check 
2. Click on the Check Medicare button. 
 

Important tips: If patient does not have Medicare Reference number, check Medicare will 
request it from HIC for you. 
 
How to send bulk-bill Medicare / DVA / Child Immun.  claims  
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During the day, you would be steadily creating Medicare/DVA/Child  immunisation invoices.  
At the end of the day, please batch these invoices as follows: 
 

1. Connect to the Internet 
2. From the Main Form, click on Admin Tasks -> HIC Online (Bulk bill) 
3. To batch a new claim, click on New Claim.   
4. Select the service provider from the drop-down list.  
5. Select the payee provider from the drop-down list.   
6. Select the Service Type.  For Allied Health services, select the Specialist service type 

because a referral is required. 
7. Select the payer (Medicare/Veteran/Immunisation) from the drop down list. Click OK 
8. When asked if you want to see the vouchers, click No if you do not want to. Click Yes 

if you want to check all the vouchers again before submitting it to the HIC 
9. When asked if you want to put the claim in a queue for electronic transmission, click 

Yes. 
10. When asked if you want to do another claim, click OK if you want to batch for another 

doctor. Otherwise click Cancel to finish batching. 
11. Click Transmit Claims to transmit the claims that have a YES in the Send?  Column 
12. When asked if you want to transmit the claims now, if you are using the Individual key 

option, plug a doctor’s  iKey into the USB port or USB extender (blue cable) then 
click on Yes (For terminal services the iKey needs to be plugged into the server 
computer), else click on OK 

13. Enter passphrase for the iKey (if asked) or if you do not use the iKey, click OK without 
typing anything 

14. When asked to print a report detailing all items transmitted, say YES.  Keep the report 
for later reference.  No need to mail the report to HIC. 

15. For DVA claims only (not Medicare, not Child Immunisation): make a copy of the 
above report, put a “HIC Online” sticker on it, and mail to HIC.  Stickers can be 
ordered through Leigh Marden. All Medicare vouchers must be kept for 2 years 

 
NB: For home/nursing home/aged care visits; you hav e to specify where the treatment 
was performed.  When creating a new invoice, select  the location in the WHERE 
TREATED box. 
 
NB: All patients should have a Medicare Reference N umber in addition to the 9-digit 
Medicare number and an Issue number.  The reference  number should not be 0. 
 
NB: Patient names should not have foreign character s such as Â, É, Ô etc 
 

To receive reports for Medicare/DVA/Immunisation cl aims  
 

1. Connect to the Internet 
2. In the HIC Online (Bulk bill) form, click Get Statements.   
3. Practice 2000 will get HIC reports, and automatically fills the Paid and the PayDate 

columns for the claims. 
 
There are two types of reports: 
 

· EFT payment report:  available for any claim successfully submitted  and paid  by 
HIC. Click EFT Payments to view the report. This shows how much HIC has paid the 
doctors. 

· Exception report: available for any claim successfully submitted but not fully paid  (or 
fully paid with a warning). Click on a claim, then click Exception Statements to view 
the report for this claim. This shows all rejected vouchers and the reasons why they 
were rejected.  
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To resubmit rejected vouchers 
 
You have to ensure that all bulk-billing invoices a re eventually paid off .  In the Admin 
Tasks, click HIC Online (Bulk Bill) form.  A list of batches is displayed.  You should not see 
any batch that is over 2 weeks old.  If there is, please: 
 

1. Check the Paid and Pay Date fields for this batch.  If they are empty, click Get 
Statements to get HIC reports for the batch.  If still empty, ask HIC to send reports. 

2. If the batch has been paid as shown by the Paid and Pay Date fields, click Exception 
Statements.  A list of unpaid vouchers are displayed 

3. Click on a voucher. Scroll to the right to see why this voucher is rejected 
4. If the rejection is valid and you cannot reclaim this voucher, please: (1) click Show 

Service to display the voucher (2) click Adjust to make an adjustment so that the 
amount owed is zero (3) click OK to close the voucher and return to the Exception 
Statements form. 

5. If the voucher was rejected because of an incorrect patient detail (e.g. Medicare 
number), please click Show Patient and fix it.  Close the Patients form to return to the 
Exception Statements form. 

6. Now click Show Service display the invoice.  Fix any incorrect service details (e.g. Not 
Normal Aftercare).  Then click the Clear button next to the Batch Number at the top 
right corner.  This will clear the batch number and take the voucher out of the current 
batch, thus allowing the invoice to be resubmitted in the next batch. 

7. Repeat the steps 3-6 above to resubmit all vouchers in the Exception Statements 
form. 

8. Close the Exception Statements form to return to the HIC Online form.   
9. Click Edit Vouchers to show all invoices still in the batch.  The invoices should show 

nothing being owed.  If the amount owed is not zero, and you know the batch has 
been paid, please pay off the batch manually (see the Manual Allocation section) 

10. When all invoices in the batch have been paid off, tick the Clear check box for the 
batch to indicate that you have resubmitted all unpaid invoices and reconciled all paid 
invoices.  This hides the batch from being displayed when you next open the HIC 
Online form.  Don’t worry about the blue asterisk (if any) – it is always there to 
indicate that HIC has not paid this batch in full.   

 
If you follow the above procedure regularly, all bulkbill invoices over 2 weeks old will be paid 
off.  To check if you have missed any invoice, please: 
 

1. In Admin Tasks, click Overdue Accounts 
2. Scroll down until you can see MEDICARE.  The amounts owed over 30 days should 

be zero 
 

DVA Paperless Claiming with Practice 2000 SQL 
 
NEW PROCEDURE 
Since HIC Online version 5.0 or higher, electronic claims are no longer required be 
accompanied by a hard copy presented on an approved DVA form. The provider is still 
required to present the patient with a copy of the DVA Printed statements for their approval 
and signing. 
 
In order to totally wipe off paperwork procedures, Medicare Australia requires more 
information to be sent electronically. Practice 2000 has been developed to provide users with 
extra screens to capture those extra data elements. Those extra elements are organised in 
voucher (or invoice) and service (or item) level. For more information about the rules 
associated with DVA Paperless Claiming, please contact Medicare Australia for support. 
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Medical practitioners will now be able to check online if a veteran is known to DVA prior to 
the lodgement of a claim for treatment services.  
 
SENDING DVA CLAIM  
Create an invoice as usual and select the Fee Scale as Veteran Affair 
 
After finish filling in all necessary details for a DVA invoice (see section 4&5 for more 
information), click on the ChkDVA button to check if the new created invoice is compliant with 
DVA. 
 
To check in advance if the patient is known and eligible to DVA, click on the button OVV. The 
patient details (i.e. name, day of birth, etc) will be sent to and compare with the database 
held by DVA. 
 
Batching a DVA claim is similar to Bulk Bill claiming. From the main menu, go to Admin 
Tasks, HIC Online, New Claim, and select Veteran Affair as the Fee Scale. 
 
DETAIL FOR A DVA VOUCHER  
The user can go to the Advanced tab in the invoice details to include extra information that 
can be transmitted with the voucher 

 
 
 
1. Clinical Condition Treated 
Reason : Provides additional details as to why the service is being performed. Possible 
values are: 
 AC - Acute Care Discharge 
 AR - Allergic Response 
 DR - Drug Reaction 
 BK - Broken (eg. prosthetic, glasses) 
 LT - Lost (eg. prosthetic, glasses) 
 ST - Stolen (eg. prosthetic, glasses) 
 NC - New Condition 
 NS - New Symptoms (ie. existing condition) 
 PD - Progressive Disorder 
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 SC - Significant Change 
 OT - Other   
 
Date: The date the patients’ prosthetic or glasses were lost, broken or stolen 
 
Statutory Declare: The provider must indicate whether they sighted a statutory declaration 
regarding the patients’ prosthetic or glasses being lost, broken or stolen. 
If this box is ticked, it indicates that Statutory Declaration is completed and signed, otherwise 
Statutory Declaration is not provided 
 
White Card : Indicates whether the services rendered are for a White Card holder and the 
service is in accordance with the White Card Condition. If this box is ticked, it indicates that 
condition treated relates to an medical condition known to DVA for White Card holders only, 
otherwise the condition treated is unrelated to the medical condition known to DVA or they 
are not a White Card holder 
 
More: Free text used to provide details regarding the condition being treated in conjunction 
with other details (e.g. white card holder, etc) 
 
 
2. Treatment Location 
Admitted : Indicates if service rendered was performed on an admitted patient in a hospital. If 
ticked, it indicates admitted patient 
 
TLPNo: The Commonwealth Hospital Facility Provider Number. A unique identifier of a 
Registered Hospital, Day Care, Community Health Centre or Residential Care (eg. Nursing 
Home or Hostel) Facility (e.g. 1234567X) 
 
Indication For Service : Free text to provide details of the specific clinical indicators for the 
service or treatment. 
 
Results From Service : Details of the results relating to the requested or referred services. 
 
3. Health Care Plan 
Type: Details the type of Health Care Plan that was issued by the servicing provider. It is 
applicable only if the rendered services are General or Specialist. Possible values are: 
 
VT - Visit (eg. Community Nursing) 
CO - Chiropractic/Osteopathy 
OC - Occupational 
PC - Podiatry Care 
MH - Mental Health  
HD - Hospital Discharge Advice 
PM - Pharmaceutical (ie. Medication) 
TP - Treatment plan (eg. Cleft) 
DB - Diabetes (eg. Insulin) 
AS - Asthma 
OT - Other 
NA - Health Care Plan not issued 
 
Date:  This is the date the Health Care Plan was issued by the servicing provider 
Other: Free text detailing the type of care plan issued 
 
4. Appliance 
Order Date : Date the appliance was ordered or was prescribed 
 
Delivery Date : Date the appliance was delivered or supplied 
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More:  Free text used to provide details regarding the Appliance or Treatment Aid 
 
5. Clinical Referral/Request 
Voucher No . A cross-reference number for the provider to record the original referral/request 
reference number or service voucher number (e.g. the reference number associated with the 
originating referral/request) where the referral/request has been forwarded to another 
provider. 
4.5.2. Report Issued: Indicates whether a report has been provided to the requesting or 
referring provider regarding the requested or referred services originally sought. 
4.5.3. Override: Free text used to provide details regarding the circumstances of the 
emergency or lost referral or request.  
4.5.4. Extra: Details the requested services (eg. Pathology tests, diagnostic imaging 
services) or reason for referral. 
 
6. Benefit Assignment Authorised 
Type: Indicates that the patient (or someone on their behalf) has authorised the assignment 
of their right of benefit to the practitioner. Possible values are 
S = Self (patient) 
P = Parent 
G = Guardian 
R = Responsible Person 
M = Medical Reason 
E = Emergency 
C = Confidential 
 
Text : Free text used to identify the emergency, medical reason or the relationship to the 
patient of the person authorising the assignment of the benefit to the practitioner where the 
patient was unable to sign.  
 
Confidential Details Sent : Indicates whether or not the Servicing Provider has sent 
Confidential Clinical Details to Medicare Australia to support their claim and free text used to 
provide details regarding Medicare Claims Review panel (MCRP) claims where providers 
must demonstrate further examinations are required within specified periods.  
 
EXTRA DETAILS FOR A DVA SERVICE 



 

89  
 

 
User can go to the Advanced tab in the invoice details and click on Advanced button to open 
the DVA service form. Extra service details, such as Anatomical Description/Region, 
Anaesthetic, etc can be included in here 

 
 
1. Anaesthetic 
Start Time : This is the date/time the provider started providing the service 
 
End Time : This is the date/time the provider finished providing the service. 
 
Time Units : This is used for Time Tiered Anaesthetics, for example, Regional Nerve Block 
items (15 minutes blocks) and Hyperbaric items (1 hour blocks) where this reflects the 
number of applicable time units 
 
Type: Indicates the type of anaesthetic used. 
 
 
2.  Emergency Type : Used to indicate whether the service rendered relates to a general 
Emergency service or an After Hours Emergency service. Possible values are: 
E = Emergency Service 
A = After Hours Emergency Service 
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3. Clinical Item Reference 
No. Used to list defined clinical reference numbers (eg. tooth numbers, cleft palate numbers, 
etc.).  
 
Description : Free text used to provide further details regarding what the Clinical Item 
Reference Num represents. 
 
 
4. Anatomical Region 
Description:  Values that can be used to identify the anatomical region for which the service 
is being claimed 
 
Region : Values that can be used to describe the anatomical region for which the service is 
being claimed 
 

 
 
5. Radiology/Imaging 
Equipment ID:  The identification number (allocated by the Dept. of Health & Ageing) of 
equipment used for the service. Usually applies to radiotherapy equipment 
 
Field Qty:  The number of fields irradiated or the quantity of (15 minute) time blocks for 
derived fee intrathecal or epidural infusion services (items 1829 and 18227). 
 
Freq. Details (in megahertz) the irradiation treatment used for the service. 
 
Contrast : Indicates whether the image taken was a contrast or non-contrast image. 
 
SD Exp. Free text used to provide details regarding substituted or self deemed details. 
Providers should indicate whether they consulted with the requesting provider and the date 
of that consultation, or sufficient information to demonstrate they took reasonable steps to do 
so.  
 
 
6. Original Procedure 
Date: The date the patient had the original procedure performed for which the current service 
relates. 
 
Item No . The MBS or DVA specific item number of the original procedure 
 
More: Free text used to provide further details regarding the original procedure (eg. post 
operative complications, reamputation details). Some procedures are considered a 
continuation of treatment and this field allows the provider to add the additional information to 
explain this additional service (eg. repeat studies associated with Diagnostic Imaging).  
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Procedure Abandoned : Free text used to provide details regarding why the procedure was 
abandoned. 
 
MPO (Multiple Procedure Override) : If this box is ticked, it indicates to Medicare Australia 
that this is not a multiple procedure service. 
 

 
 
7.  Pathology 
Accession Time : This is a timestamp value as to when the pathology test was actually 
performed.  
Note: This is different to service date/time when service was rendered. 
 
8.  Collection Time : The date and time when the pathology specimen for this service was 
actually collected 
5.8.4. S4B3 Exemption: Flags the associated service as requiring assessing in accordance 
with S4B3 requirements of the MBS. If ticked, it indicates that the service is exempt 
 
9. Intensive Care Override 
Code: Indicates the service rendered is not associated with the patient’s intensive care or the 
service was Intensive Care related but performed outside of an Intensive Care Management 
Unit. If ticked, it indicates that the service is performed outside intensive care unit; otherwise 
it is not part of intensive care 
 
Text : Free text detailing the reason why the intensive care override has been claimed. 
 
10. Aftercare Override : Indicates if service is part of normal aftercare for the patient. If 
ticked, it indicates that this service is not normal after care 
Apportioned : The percentage of the surgical item benefit which can be claimed as an after 
care attendance item by an After Care provider. 
 
Explanation : Free text stating the reason why the service was not part of the normal 
aftercare for the patient. 
 
Provider No . The Provider Number of the practitioner who will be providing after care to the 
patient either shared with or delegated by the Servicing Provider. 
 
Malignancy Confirmed:  This is an acknowledgement by the provider that the sample was 
malignant. 
 
Size Of Growth (mm) : Used to indicate the size of the growth, cyst, ulcer, scar, tumour, and 
etcetera in millimetres 
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Trouble-shooting HIC Online 
 
Error 1713 – can’t find reports when getting electr onic statements 
 
This error occurs when HIC computers are too busy or you are trying to request statements 
for too many claims.  Use Find to limit the number of claims to be checked and try again. 
  
Error 9318 – non-standard referrals  
 
The standard referral period is 12 months for a GP and 3 months for a specialist. Check the 
invoice that having the problem. If a non-standard referral is actually intended, please type 
the period into the Service Text column for the items 
 
ERROR 9619 – CHECK POSTCODE AND LOCALITY . THIS IS NOT A RECOGNISED COMBINATION OR 
A PO BOX TYPE LOCALITY HAS BEEN ENTERED . 
 
PV( Check Medicare) works fine. However when try to send an PCClaim on the computer, it 
throws up a 9619 error code. Please check postcode and locality (St Helena has to be 
written as SAINT HELENA) 
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Eclipse Form 
 
HIC Online – Eclipse allows you to send In-Patient Medical Claims (IMC) to private Health 
Funds via the Internet.   
 
In order to use Eclipse, you must have Practice 2000 SQL version 2.91 or later, and have 
HICOnline version 4.0 or later installed on your PCs 
 
We have implemented the full range of Eclipse features, including: 
 
• Online Patient Verification (to see if a patient qualifies for Health Fund claiming) 
• Update the list of Health Funds to which allow you transmit your claims  
• 5 types of transmission: Agreements, Schemes, Patient Claims, Medicare Benefits and 

Medicare only 
 
Agreements (IMC AG)  

· The provider has signed an Agreement with the Fund (of which the patient is a 
member) specified in the claim.  

· Payment goes to the provider or BIlling Agent via the Health Fund. 

Schemes (IMC SC)  
· The provider is operating under a scheme with the Fund (of which the patient is a 

member) specified in the claim.  
· Payment goes to the provider or BIlling Agent via the Health Fund. 

Patient Claims (IMC PC)  
· Patient is a member of the Fund specified in the claim.  
· If the claim has been paid, the payment from Medicare goes tot he patient or claimant 

and payment from the Fund goes to the member.  
· If the claim has not been paid, the payment from Medicare and the Fund goes to the 

patient, via cheque (made out to the provider), who then passes it on to the provider. 

Medicare Benefits (IMC MB) 
· Payment from both Medicare and the specified Fund goes to the specified Billing 

Agent. 
 
Medicare Only (IMC MO)  

· Payment from Medicare goes to the specified Billing Agent.  
· There is no Fund involvement. 

 
 

Set up Eclipse 
 

1. Install HICOnline 4.0, see the session HICOnline 4.0 Installation in this manual 
2. Get the list of Health Funds that are available for Eclipse: Go to Admin Tasks, Display 

Health Fund List and click on Update 
3. Enter Facility Ids: Go to Admin Tasks, Set up, Doctors and enter the provider of a 

Registered Hospital or Day Care Facility. This facility ID will automatically come up 
when batching IMC claims. 
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4. If you are a billing agent, go to Admin Tasks, Setup, Businesses and click on Billing 
Agent to enter your Billing Agent ID 

5. Enter Fund Payee ID (Optional): If you have Fund Payee IDs (The Health Fund 
Agreement identifier for the practitioner - used to map Fund payment arrangement 
details), go to Admin Task, Set up, Fund Payee Provider and enter Fund Payee ID for 
each Health Fund 

6. Enter Specimen Collection Point (for pathology services only): Go to Admin Tasks, 
Set up, Businesses and click on SCP ID 

 

 
How to check for a patient’s Health Fund eligibilit y 
 

3. In the Patients form, find the patient that you want to check 
4. Click on More tab, enter HIC Fund Name and Member No 
5. Click on the Check Health Fund button. 
 

Please note that Check Health Fund function does not return the result if the patient’s 
Medicare card number is not entered 
 
 

How to send IMC Claims (In-Patient Medical Claims)  
 

1. Create an invoice for a private patient as usual.  
2. From the Main Form, click on Admin Tasks -> Eclipse 
3. To batch a new claim, click on New Claim.  Double click on the patient field to 

select the patient, select the service provider from the drop-down list, the payee 
provider from the drop-down list, the Fee Scale, Service Type and the Facility ID. 
The Fund Payee ID is optional; if you do not have it, leave it blank. Click OK 

4. Enter the start/end date and click OK 
5. When asked if you want to see the vouchers, click No if you do not want to. Click 

Yes if you want to check all the vouchers again before submitting it to the Health 
Fund 

6. When asked if you want to put the claim in a queue for electronic transmission, 
click Yes. 

7. When asked if you want to do another claim, click OK if you want to batch for 
another doctor. Otherwise click No to finish batching. 

8. Click Transmit Claims to transmit the claims that have a YES in the Send?  
Column 

9. When asked if you want to transmit the claims now, if you are using the Individual 
key option, plug a doctor’s  iKey into the USB port or USB extender (blue cable) 
then click on Yes (For terminal services the iKey needs to be plugged into the 
server computer), else click on OK 

10. Enter passphrase for the iKey (if asked) or if you do not use the iKey, click OK 
without typing anything 

11. When asked to print a report detailing all items transmitted, say YES.  Keep the 
report for later reference.  No need to mail the report to HIC. 

 
 
How to receive reports for IMC claims  
 

4. In the Eclipse form, click Get Statements.   
5. Practice 2000 will get exception and payment reports, and automatically fills the Paid 

and the PayDate columns for the claims. 
 
There are two types of reports: 
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· EFT payment report:  available for any claim successfully submitted  and paid  by 

HIC and Health Fund. Click EFT Payments to view the report. This shows how much 
HIC and Health Fund have paid the doctors. 

· Exception report: available for any claim successfully submitted. Click on a claim, 
then click Exception Statements to view the report for this claim. This shows all 
submitted vouchers, how much Medicare and Health Fund paid for the claim and the 
reason if they did not pay or not fully pay  

 
Please note that some Health Funds have not processed electronically payment report, you 
cannot received the report on the system, they will inform you the payment 

 
 

How to resubmit rejected vouchers 
 

11. On Eclipse Form, click Exception Statement to get reports for the batch 
12. For unpaid  or not fully paid items. Scroll to the right to see why this voucher is 

rejected 
13. If the rejection is valid and you cannot reclaim this voucher, please: (1) click Show 

Service to display the voucher (2) click Adjust to make an adjustment so that the 
amount owed is zero (3) click OK to close the voucher and return to the Exception 
Statements form. 

14. If the voucher was rejected because of an incorrect patient detail (e.g. Medicare 
number, Fund number…), please click Show Patient and fix it.  Close the Patients 
form to return to the Exception Statements form. 

15. Now click Show Service display the invoice.  Fix any incorrect service details (e.g. 
item number, referral details…).  Then click the Clear button next to the Batch 
Number at the top right corner.  This will clear the batch number and take the voucher 
out of the current batch, thus allowing the invoice to be resubmitted in the next batch. 

16. Repeat the steps 3-6 above to resubmit all vouchers in the Exception Statements 
form. 

17. Close the Exception Statements form to return to the Eclipse form.   
18. When all invoices in the batch have been paid off, tick the Clear check box for the 

batch to indicate that you have resubmitted all unpaid invoices and reconciled all paid 
invoices.  This hides the batch from being displayed when you next open the Eclipse 
form.  Please do not worry about the blue asterisk (if any) – it is always there to 
indicate that Medicare and Health Fund have not paid this batch in full.   
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Medical Records form 
 

· This form provides a summary of a patient’s medical record.  To see more details of 
the problem list, reports etc., click the appropriate button. 

· After the initial consultation with a new patient, you need to establish a database 
(history, allergies, immunizations), produce a problem list, and prepare management 
plans.  

· At subsequent consultations, write down progress notes. 
· The Find Patients form allows you to search for specific words in the Problem list, so 

you can make a list of all patients having a certain medical problem such as diabetes. 
· Findings:  This is a work sheet for all assessments.  Include follow-ups for the listed 

problems as well as recording of episodic attendances.  .  
· Click the Findings button to see more details of the progress notes.  To see the 

progress notes in chronological order, click on the date column, then select the menu 
Records => Sort.   

· To sort the progress notes in problem number order, click the problem column, then 
select Records => Sort. 

· Medical reports (no scanner): Summarize all brief reports from consultants here.  For 
long reports, note the date and the author of the report, then file the report at the end 
of all existing reports. 

· Medical reports (scanner available): For text reports, run your OCR (optical character 
recognition) software to convert to text. Then copy and paste the text into Report Text 
column. For pictures, click the Data column, then click Edit menu, Insert Object.  

· To view/print medical reports: double click Report Text or Data columns. 
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Staff pay form 
 

Adding new Staff  
 

1. From the Admin Tasks form, click Staff Pay, Add/Edit Staff.  
2. Select the correct tax scale from a list. Usually it’s scale 7. 
3. Enter rebate, if any, for spouse, dependents, etc as shown on the employment 

declaration form. 
4. Decide how superannuation is to be calculated, e.g. 8% of gross, or a fixed amount at 

each pay. 
 

Creating a new pay 
 

1. On the Staff Pay form, select a staff then clicks New Pay.  
2. On the Staff Pay Details form, select pay period as weekly, fortnightly or monthly. The 

business that pays this staff can be selected. 
3. An unlimited number of pay items can be added. Click the down arrow on each pay 

item to select one of the past items. This speeds up data entry. A pay item can have 
a negative amount, e.g. you have overpaid last time and you wish to recover the 
amount this time. 

 
Gross, Tax, Super and Net are calculated automatically.  You cannot change them here. 
Whenever the superannuation is actually paid to the fund of the staff (eg. Monthly or 
Quarterly at the minimum), the three superannuation fields must be properly edited. Click 
Super Note (this will construct a legally required note in the pay slip and the pay record. 
Clicking Calculate will fill these fields with record and quarterly-default data. 
 
When the Pay Details form is closed, a pay slip is displayed on screen. 
 
Note: The calculated tax for tax scale 7 is lower than that listed in the table of Income Tax 
Instalments by the Tax Office. Tax scale 7 means no leave loading, whereas the table is for 
leave loading.  
 
Sometimes you want to change the tax amount, for example to take into account HECS 
 

1. In the Staff Pay form, edit the tax amount.  
2. Click Preview Pay Advice to reprint the pay slip 

 

Printing all pays in a given Period 
 
If you want to print monthly superannuation contributions due to each person, or to print total 
wages for all staff for a financial year (to make group certificates) 
 

1. Click Find.  Enter the period in the “PayDate Between” boxes.  Click Find Now 
2. Click Preview All. A report will appear on the screen.  If the pay date of a pay falls into 

this period, it will be shown. The start date or the end date of a pay is NOT 
considered. 

3. Click the File menu, Print command. 
 

Editing Tax Rates 
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If the Tax Office changes tax rates, the rates that were supplied with Practice 2000 have to 
be edited.  You will need the “Statement of Formulae For Calculating Income Tax 
Instalments” from the Tax Office. Click Edit Tax Rates to edit the tables. Alternatively, we 
update the tax rates and make available in the upgraded version that can be downloaded 
from our Website. 
 

Entering Annual or Sick Leave 
 

1. On the Staff Pay form, select a staff, and then click Edit Leave 
2. In the Staff Leave form, click New Leave to add a new line at the bottom.   
3. Enter the date that the leave entitlement starts, for example 1/1/98, or the date that 

leave is taken, for example 2/3/98. 
4. Select the type of leave - annual, sick or long service leave 
5. Enter the leave amount, in hours.  For example, 4 weeks of annual leave entitlement 

means 20 days.  If the standard working day has 8 hours, enter 160 as the leave 
amount 

6. If leave is being taken, enter a negative amount. For example, one week of annual 
leave is 5 days, so enter -40 (hours).  

7. Enter a brief description if desired. 
 
The amounts of leave available to a person are given at the bottom of the Staff Leave form.  
They will be printed in pay slips. 
 

How to enter salary sacrifice 
 

1. On the Staff Pay form, select a staff, and then click New Pay 
2. In the Pay Details form, enter the gross pay as usual 
3. In the bottom row, type the amount of salary sacrifice as a negative number, e.g. –

123.00 
4. Click Close.  When a report appears, just close it down. 
5. In the Staff Pay form, add the amount 123.00 to the Super column 
6. Click Preview Pay Advice to print the pay slip. 
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Child Immunisations 
Form 

 
 

 

Recording an Immunisation Episode from the Invoices  
form: 
 

· On the Invoices form, click New Immunisation.  
· On the new invoice, check the date & doctor. Do not change the schedule or the item.  
· If you do not want to proceed, click Delete Invoice. Otherwise, click OK.  
· Enter the vaccine codes and dosages on the “ImmunisationServices” form, then close 

it. 

 
 

Recording an Immunisation Episode from the Patients  
form: 
 

· Open the Patients form. Find the child. 
· Click the menu Patient => New Child Immunisation.  
· In the Invoice Details form, check the invoice date. It MUST be the service date.  
· A “ChildImmun” item is automatically given, along with the amount of $6.60 and GST 

of $0.60.  If the amount is not correct, please fix it now.  
· If this is the completion of an immunisation course, enter the Course Complete item 

below the ChildImmun item.  If the Course Complete item is not available, please set 
it up as shown later. 
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· If you want to cancel the immunisation, click Delete Invoice. Otherwise click OK to 
open the Child Immunisations form 

· Enter details required in the white boxes. You can record up to 5 vaccines. 
· Close the form. The record will be saved automatically 

 
Note: If the default fee for the ChildImmun item is not $6.00, the solution is: 
 

· Go into Admin Tasks, Setup tab, Fee Scales. Select the “ChildImmun” fee scale. 
· Change the fee for the “ChildImmun” item as required. Also ensure that the GST rate 

is 0%. 
 

Setting up the “Course Complete” item: 
 

· Go into Admin Tasks, Setup tab, Fee Scales. Select “ChildImmun” fee scale. 
· Click New Item. In the input box, type “Course Complete” without the quotation mark, 

then click OK 
· A new line is added to the items table. Change the fee for the “Course Complete” 

item as required. Also ensure that the GST rate is 10%. 
 
Recording an immunisation episode from the Waiting Room form: Select the child, click the 
Immunisation button, and then continue as above. 
 
Recording an immunisation episode from the Invoices form: click the New Immunisation 
button, find the child, and then continue as above. 
 

Sending Child Immunisations Claims via Medclaims: 
 

· Contact Australian Childhood Immunisation Register authority. Ask for a Medclaims 
application form. Fill in and return the form. 

· Batch the immunisation vouchers in the same manner as your Medicare vouchers: 
Open the Medclaims form, click New Claim. Enter claim number, provider etc. In the 
Payer box, select Immunisation. 

· Note that Immunisation claims can be batched and electronically transmitted, the 
payment and other messages are manual 

· Transmit the claim as usual. No need to mail the paper vouchers. 
 

Showing the Immunisations for a child: 
· In the Patients form, find the child, then click the menu Patient => Show Child 

Immunisations.  The Immunisation Services form will show the episodes.   
· Click Print to print an Immunisation Certificate required by Schools. 

 

Removing an immunisation: 
 

· Show the immunisation as above, then click the menu Records => Delete Record 
· Find the immunisation invoice corresponding to this episode, then click Delete Invoice 
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Echocardiography form 
 
Click New Echo to create an invoice for an echocardiography service. Enter the items to bill, 
and then click OK.  In Echocardiography form, enter echocardiography details for the patient. 
Finally, click Print or Fax to finish. You need to install WinFax to do faxing.  
 
To save telephone cost, do not fax each report individually. Wait until the end of the day, 
click Find to select the day’s reports, and then click Fax. Reports to the same fax number will 
be sent together. 
 
A related form is the Cardiography form, which allows you to write the following types of 
reports: 
 

· Abdominal Arterial Ultrasound 
· Carotid Duplex Ultrasound 
· Lower Limb Arterial Ultrasound 
· Lower Limb Venous Ultrasound 

 
The reports are based on Word templates.  You can customize them by opening the 
EchoTemplates subfolder in the shared Practice folder on the server.  You can also add new 
templates. 
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Pathology Downloading 
form and  

Manual Pathology form 
 
The electronic downloading of pathology/radiology results are best done through clinical 
software packages.  For those doctors who don’t use clinical software, e.g. specialists, 
Practice 2000 provides a way to download results.   
 
The pathology labs should send patient reports in PIT7 format to the subfolder PATHIN in the 
shared folder PRACTICE on the server.  To import the reports, run Practice 2000, click the 
More tab of the Main form, then click Pathology Downloading.   
 
For those doctors who don’t want electronic downloading, they can manually record test 
results from Radiology/Pathology labs.  To do this: 
 

1. From the Main form, click the More tab, Manual Pathology 
2. Click the New button.  Select and accept a patient 
3. Type data in the boxes provided.  You do not need to fill in all the boxes. 
4. To find any record, click the Find button. 
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Operation Bookings form 
 
This form is useful to specialists who perform operations, e.g. neurosurgeons, urologists. For 
each operation, you enter all details such as date and time of operation, the hospital, the 
anaesthetist, the pathology tests required etc.  Then the form will allow you to print out letters 
containing instructions to the patient, the referring doctor, the hospital, the anaesthetist, and 
the pathology service.  The Patient Consent Form is also printed.  A large amount of your 
time can be saved. 
 

Setting up  
 
The following tables must be setup before you can do bookings.  Please follow the order of 
the tables exactly as below. 
 
Address Book: 
 

1. Click Address Book at the bottom of the form to open the Address Book.   
2. Enter the hospitals, anaesthetists and pathology services.  Choose the correct 

Hospital/Anaesthetist/Pathology Type for each entry (in the Type field). 
3. Enter the referring doctors and assistants too 

 
Operation Instructions: 
 

1. Click the Op Instructions button to open a table. On each line, enter an instruction to 
the hospital, anaesthetist and the patient. Read the Status Bar at the bottom to see 
the data required for each field 

2. The Report Code should be a unique code to identify the instruction 
3. The Category field determines whether the instruction is for the hospital, anaesthetist 

or the patient. 
4. The Summary field helps you remember what the instruction is about 
5. The Details field contain the actual instructions that will be printed in the letters to the 

patient, the hospital etc 
 
Operation Diagnoses: 
 

1. Click the button near the Indication box of the form (on the right) to open a table.   
2. On each line, enter a diagnosis.   
3. Read the Status Bar at the bottom to see the data required for each field 
4. Ignore the ICD Code field 

 
OpCodes: 
 

1. Click the button near the Opcode box of the form to open a table.   
2. On each line, enter an operation code.   
3. The Code field is a unique code to identify the operation 
4. The Category Code is either OP(eration) or END(oscopy) 
5. The Description will be printed on the letters 
6. Usual Stay: 1 means same day 
7. Admin Day: 0 means same day, 1 means 1 day before 
8. PreOp Pathology Code: click the down arrow to select an instruction to the pathology 

service. The list comes from the Operation Instructions table created previously 
9. PreOp Patient Code: similar to PreOp Path Code 
10. PreOp Hospital Code: similar to PreOp Path Code 
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11. Usual Admit Diagnosis: click the down arrow to select a diagnosis. The list comes 
from the Op Diagnoses table created previously 

12. Usual Discharge Diagnosis: as above 
13. Ignore all other fields 

 
List Time: 
 

1. Click the button near the List Time box of the form to open a table.   
2. On each line, enter an operation schedule.   
3. The List ID field is a unique code to identify the schedule. An example is C1P, where 

C=Cabrini hospital, 1=Monday, P=pm 
4. Hospital: select the hospital (must have been entered in the address book) 
5. Usual Anaesthetist/Assistant: select from the address book 

 

Creating a new Operation Booking: 
 

1. Click New. Select the patient.  
2. In the Operation Bookings form, fill in the white boxes.  
3. You can select several Op Codes.  The Details box will list them all.   
4. If several patients are operated upon on the same day, enter 1, 2, 3 etc in the List 

Order to determine who is operated first, second etc. 
5. Normally you want to print the operation letters about two weeks before the operation 

date.  Please enter the date you want to print in the Print Date field. 
6. The Notes field is for your own use.  It won’t be printed 

 

Printing an Operation Booking: 
 

1. Click Open. If asked to select a letter template, choose OpLetter 
2. Click OK, Microsoft Word will bring up the letter.  You can modify the letter if 

necessary. 
 

Printing Pre-operation List: 
(Before the date of operation, a list of patients to be operated must be faxed to the hospital) 
 

1. Click Find.  Enter the operation dates, and then click Find Now 
2. Click Preview List.  Then click the Printer icon on the toolbar. 

 

Printing several Operation Letters 
 

1. Click Find.  Enter the print dates or other criteria, and then click Find Now 
2. Click Print All Letters.   
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Routine tasks 
 

Backup 
 
You should back up data daily. Backing up means putting a copy of your data on floppy 
disks, magnetic tapes or similar.  If your hard disk crashes, you can restore the database 
from backups. 
 
There should be a separate set of disks for each day of the week. The backup disks are to 
be labeled Mondays, Tuesdays etc. In case something is wrong with one set of disks, you 
still have others to fall back on.  If you use CD’s for backing up, please put away a CD each 
month as a permanent backup. 
 
When you quit Practice 2000, it will ask whether you want to back up your data.  If you 
answer yes, the Windows backup program BACKUP will run. 
 

Restoring Data 
 
If your current database is lost (by accidental deletion or hard disk crash), you can restore 
the database from backups.  It is strongly recommended that you restore data once a month 
to a separate  computer  to verify that your backups are really working. It’s not unusual for 
backups not to work because of human or machine errors. 
 
Suppose you have backed up on a CD by zipping the files with PKZIPC.  Please restore as 
follows:  
 

1. Run Practice 2000 SQL.  Click Admin Tasks, Setup, Attach Database.   
2. If the database name is C:\PRACTICE\PRACTICE.MDF, you’re OK.  Click Cancel 
3.  If not, type C:\PRACTICE\PRACTICE.MDF  then click Attach.   
4. Insert the backup disk (CD, DVD or USB memory stick).  Click Start, Run.  Type  

COMMAND  then click OK  
5. In the black screen, type  CD \PRACTICE  then press Enter 
6. Type  PKZIPC -EXTRACT  D:\PRACTICE.ZIP   then press Enter  (please replace D:\ 

with the correct drive letter for your backup disk, and replace PRACTICE.ZIP with the 
correct backup file name).  The database file PRACTICE.DAT will be extracted.   

7. Click Start, Programs, Practice 2000, Practice SQL Manager 
8. Click the Backup/Restore tab.  In the Restore From File box, type  

C:\PRACTICE\PRACTICE.DAT  then click the Restore button 
9. Run Practice 2000 SQL and check that you have the latest data 
 

 

Re-indexing the database: 
 
When the computer runs very slowly, try re-indexing the database.  The task takes 
about 3 minutes.  Just click Start, Programs, Practice 2000, Practice SQL Manager, 
Indexes, Re-index All. 
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Password and security 
 
To prevent unauthorized entry into the database, you need to set up a security system so 
that Practice 2000 will request passwords when starting. If the following steps have not been 
done during system set up, please do them for each computer: 
 

1. Find out where your shared Practice folder is. Typically it is \\SERVER\PRACTICE, or 
C:\PRACTICE if single user. 

2. Click Start, Programs, Practice 2000, Workgroup Admin 
3. Click Join. Type in \\SERVER\PRACTICE\SYSTEM.MDW or similar. Click OK, OK, 

Exit. 
 
On the server: 
 

1. Start Practice 2000. Select the menu command Tools => Security => User & Group 
Accounts => Change Logon Password. 

2. Leave the old password blank. Enter a new password for Admin. Type it a second 
time to verify. 

3. MEMORIZE THE PASSWORD CAREFULLY.  Note whether each letter of the 
password is uppercase or lowercase. Password is case sensitive. 

4. Close the dialog. Close Practice 2000  
 
From now on, when you run Practice 2000, a Log On form will ask you for a name and a 
password. You have 3 choices: 
 

· User Name: Admin. Password: the one you have entered previously. Admin is all-
powerful and can access all functions of the system.   

· User Name: Manager. Password: leave blank. Manager can do all things other than 
Staff Pay. In the Earnings form and the Payments Received form, Manager can only 
see 2 days at a time 

· User Name: User. Password: leave blank. User can only do reception tasks. User 
cannot do Admin Tasks. 

 

Creating new Users (in addition to the 3 users abov e): 
 

· Select the menu command Tools => Security => Users and Group Accounts 
· Click the New button. 
· Enter the name of the user, for example RECEPTIONIST1. 
· Enter a personal ID for the user, for example RECEPTIONIST1.  This ID is for added 

security so that other people cannot read your data. Click OK. 
· Determine the groups this user should belong to. The list of groups available appears 

on the left.  The receptionists should be in the Users group, but not the Admins group.  
If you add an administrator, you should add both the Admins group and the Users 
group.   

· Click the group desired from the list of groups available, then click ADD>>.  You can 
add more than one group. 

· Close the form, then quit Practice 2000. 
 
From now on, when the receptionist runs Practice 2000, he can enter RECEPTIONIST1 as 
the log-on name, and leave the password blank.   
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Changing password: 
 

· Select the menu command Tools => Security => User & Group Accounts => Change 
Logon Password. 

· Enter the old password. 
· Enter a new password. Type it a second time to verify. 
· Note whether each letter of the password is uppercase or lowercase. Password is 

case sensitive. 
· Close the dialog.  

 
A user can change his password any time, using the above procedure. Admin, the privileged 
user, can remove the security system by changing his password to blank. 
 

Security Groups 
 
From July 2007, the security system is redesigned.  What a user can do now depends 
primarily on the groups he belongs to.  There are three predefined groups of users: 
 
- The Users group, whose members can only do reception work and HIC Online, and 

cannot access Admin Tasks.  HIC Online is now available in the More tab of the Main 
Form. 

- The Doctors group, whose members can only do reception work and see their own 
earnings, and cannot access Admin Tasks.  The doctors’ earnings is now available in the 
More tab of the Main Form 

- Admins, who can click on Admin Tasks in the Main Form 
 
The Admins group and the Users group are already available by default.  To create the 
Doctors group , please: 
 
- Click the Tools menu, Users and Group Accounts.   
- Click the Groups tab, then click New 
- In the Name box, type Doctors.  In the Personal ID box, type Doctors 
 
To decide the group for each user : 
 
- Click the Tools menu, Users and Group Accounts.   
- Select a user.   
- In the Member Of box, select the group (Admins, Doctors or Users) for this user 
 
To ensure each doctor can only see his own earning:  
 
- Click Admin Tasks, Advanced tab, Miscellaneous button 
- Look for a parameter called OnlyDoctorSeeEarnings 
- Change its value to TRUE 
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Importing & exporting 
data 

 
Practice 2000 allows users to import and export data in industry-recognized formats 
 

· The simplest way to export data is to highlight any data you see on the screen, eg. 
Invoices, then click the Copy button on the tool bar. Switch to another application, 
e.g. Excel, and paste the data in.  

· To export data on the screen to the Internet, use the menu File => Send => HMTL.  
· To export data to Microsoft Word or Excel and run Word/Excel immediately, use File 

=> Office Links. 
· Data in any table or form can be exported in the following formats: Excel, Access, 

Word, ASCII text, dbase, paradox. First display the table or form, then click the File 
menu, and Export command. 

 
Suppose you have a list of specialists in another Windows application such as Excel. You 
can import the data into Practice 2000 as follows: 
 

· In Practice 2000, open up the Addresses form  
· Note the columns available on the form: ID, Surname, First Name, Initials … 
· Click the Allow Editing button so you can add data to the Addresses form. 
· Switch to Excel. Open the sheet containing data.  
· Move the columns around so that they match exactly with the columns of the 

Addresses form: the first column should be ID, second Surname etc. 
· Leave the first column in the spreadsheet blank, since the computer will fill in the ID 

number. 
· You do not need column labels on the spreadsheet.  
· Select the rows that contain data by moving the mouse over the row headings. 
· Click the Copy button on the toolbar. 
· Switch back to Practice 2000. Click the Record Selector of the last row on the sheet 

to select the row. The record selector is the grey button to the left of each row. The 
last row contains no data. 

· Click the Paste button on the toolbar. 
· Click OK to paste data according to the Tab order. That’s it. 

 
Your data is entirely yours: Use Microsoft Access to open Pracdata.mdb and, if you are 
Admin, do whatever you like: adding new tables, adding new fields, write new programs etc. 
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Practice 2000 Advanced 
 
In Practice 2000, records of patients, services etc. are displayed on forms, which are like 
windows.  A form contains buttons to carry out tasks specific to the data on the form.   
 
A patient record is like a patient card you keep in your filing cabinet.  Changing a field in the 
record is like rubbing out the old words and writing new words on the patient card.  So please 
be careful with changing data.  If you want to register a new patient, do not overwrite an 
existing record. Instead, click New Patient to get a new card. 
 
Records can also be displayed in datasheets, which are like tables.  More data can be 
displayed this way.  It is easy to switch between forms and datasheets: use the View menu. 
 
The tasks common to all forms such as adding record, deleting record etc. can be accessed 
through the menus on top of the screen.  The most frequently used menu commands are 
represented as icons on the toolbar.   
 
To close a form, there are several methods: 
- Some forms have a Close button on them.  Just click it.  This is the preferred method to 

close. 
- Click the X button on the top right corner of the form 
- Press CTRL - F4 
 

Datasheets 
 
The default Form View shows one single record on a form.  You can switch to the Datasheet 
View to see many records at a time.  Each record is displayed in a row. Choose the View 
menu to switch between form view and datasheet view.  In the datasheet view, use the arrow 
keys and Page Up/Page Down keys to move between records and fields. 
 
The form view is best for doing something about the current record, since command buttons 
are usually available.  The datasheet view is best for seeing several records at once so that 
you can choose one.   
 
To choose a record, select View => Datasheet View.  Click on the row for the record you 
want, then switch back to form view by selecting View => Form View. On the left of each row 
is a Record Selector.  It may contain symbols: 
 

· An arrow: The record you are working with. 
· A pencil: The record is being modified.  Other users cannot edit this record. 
· A crossed circle: The record is being edited somewhere else.  You cannot edit it now. 
· A star: A new record for data entry. 

 
To change the height of a row, move the mouse pointer to the border between the record 
selectors.  Drag the mouse to move the horizontal grid lines. 
 
To change the width of a column, move the mouse pointer to the border between two column 
headings.  Drag the mouse to move the vertical grid line. 
 

Adding records 
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· Choose the menu Records => Go To => New to add a new record at the end of 
existing records.  Alternatively, click the New button on the toolbar. 

· Press TAB to move from one field to the next. Press Shift Tab to move to the 
previous field. 

· After all the fields for a record have been filled, press Tab to get a new, blank record. 
· If the field is a check box, click on it or press the Space Bar to cross or uncross it. 
· If the field contains a bold down arrow, click on the arrow to see a list of values.  Click 

on any value to select.  Alternatively, press Alt and down arrow keys together to 
display a list, move around with the arrow keys, and press Enter to select. 

· To enter a date such as 2 January 1994, you can type `2/1/94’ or `020194’. 
· Some fields do not have enough space to display all data.  As you type, text is 

scrolled left.  Data is not lost.  Use the Left and Right arrow keys to scroll the text to 
see data.   Press Home to see the first word, and End to see the last word.  You can 
also press Shift and F2 together to display all data in a large Zoom box. 

· Press Ctrl and ‘ (single quote) together to make a field having the same value as in 
the previous record (e.g. two patients having the same surname). 

· After all records have been added, close the form or datasheet.  Records are saved 
automatically when you close the form, or when you move to another record.   

· In a multi-user system,  when you are editing a record, other users cannot modify it.  
So, when you finish editing the record, choose the menu File => Save Record.  This 
enables other users to edit it.   

· The above comment also applies to a single user system when you are opening 
several forms simultaneously.  For example, if you are entering a new service for Mr. 
J. Smith on the Services form and then you open the Patients form, you will not be 
able to modify the patient record for Mr. Smith. 

 

Editing records 
 
When you start to edit a record in a form, the pencil symbol appears in the record selector.  
On any other forms where this record is being displayed, a crossed circle symbol appears to 
indicate that they cannot be modified.  After you save the edited record, the pencil symbol on 
this form becomes a triangle, and the crossed circle symbol on other forms becomes a 
triangle also. 
 
IMPORTANT:  Whenever you make a mistake, click Edit => Undo menu.  You can always 
restore what was in the record before you edited it by undoing two times, until the pencil 
symbol in the record selector disappears. 
 
When a form is opened, the first record is displayed, and the first field in the record is 
highlighted, i.e. selected.  If you type something, new data will replace the selected data. 
 

· To select text, click where you want to start selecting, then hold down the left mouse 
button and drag across text. 

· To change text, select any text to be replaced and type in new text.  
· To delete text, select it, and then press Delete. 
· Press Backspace to delete the character on the left of the blinking bar (the insertion 

point). 
· Press Delete to delete the character on the right of the blinking bar. 
· On a form, click a field’s label to quickly select the field. 
· If a field label has an underlined letter, press ALT and the letter together to quickly 

select the field. 
· Changes are saved automatically when you move to another record or when you 

close the form. It is advisable to save the record occasionally.  Choose the menu File 
=> Save Record. 
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· To insert text in the middle of a field, click with the mouse to get a blinking insertion 
point.  Move the insertion point with the arrow keys.  Type in text. If a field is too small 
to see all text, press SHIFT and F2 together to display a Zoom box for text. 

 

Deleting records 
 
Select a record by clicking the record selector (or choose the menu Edit => Select Record).  
Then press Delete. In datasheet view, you can select many records by holding down the left 
mouse button while moving the mouse pointer over the record selectors.  Press delete to 
delete them all. 
 
You can select all records by choosing the menu Edit => Select All Records.  Pressing 
Delete will then wipe out all data. 
 

Viewing records 
 
To see another record, use the navigation buttons in the lower left corner of the form. From 
left to right, these are:   
  

· Go to the first record 
· Go to the previous record (Pressing Page Up does the same thing) 
· Got to the next record (You can also press Page Down) 
· Go to the last record 

 
The message “Record: 3 of 3” indicates that this is the third record in a total of 3.  You can 
move to a particular record by overwriting the current record number with another number. 
The Go To commands on the Records menu can also be used to move from record to 
record.  They are exactly the same as the navigation buttons. 
 
Sometimes the form shows only one record.  To see all records, choose the menu Records 
=> Show All Records. 
 

Printing records 
 

· Some forms have command buttons for printing data.  Use these buttons if available.   
· A form can also be printed as seen on the screen.  Choose the menu File => Print to 

display a Print dialog box.  Then choose OK to print. 
· To preview how the form will look on a page, choose the menu File => Print Preview.  

When finished, choose the menu View => Form to return to the form. 
 

Finding records 
 
Switch to the datasheet view by selecting View => Datasheet.  Press Page Up/Page Down to 
see the records.  If you see the record you want, click on it, then switch back to form view by 
selecting View => Form. 
 
If there are too many records, do as follows.  Suppose you want to search for all patients 
having the surname SMITH: 
 

1. Open the form. 
2. Click on the field you want to search for data.   
3. Choose the menu Edit => Find.  The Find dialog box is displayed. 
4. Type the value you want in the Find What box. 
5. Click the Find First button.  The first record matching this criterion will be displayed on 

the form. 
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6. Click the Find Next button.  The next record matching the criterion will be displayed. 
7. Click the Close button to finish searching. 

 

Sorting records 
 
When a form is opened, the records are displayed in the order of data entry.  However, you 
may want to sort records in alphabetical order.  Suppose you want to sort patient surnames: 
 

1. Click on the field you want to sort. 
2. Select menu Records => Sort Ascending.  Records will be sorted.  The datasheet 

view will show this clearly. 
 

Filtering records 
 
You can filter records so that a form contains only records matching certain criteria.  Then 
there are less records to be seen and hence less confusion.  Suppose you want the Patients 
form or datasheet to list only patients whose surname is Smith: 
 

· Choose the menu Filter => Advanced Filter/Sort.  A Filter form will be displayed. 
· In the table in the bottom half of the form, click on the first column, then click on the 

bold down arrow.  A list of fields will be displayed. 
· Click on the word Surname in the list.  The column now contains the Surname field. 
· In the Criteria row, type the word Smith. 
· Choose the menu Filter => Apply Filter/Sort.  The form will display only records 

containing the surname Smith.  The datasheet view will show this clearly. 
· To display all records again, select the menu Filter => Remove Filter/Sort. 

 

File menu 
 

· Close:  Close the active window (the window that has the highlighted title bar). 
· Save record:  Save the current record.  In a multi-user system, this allows other users 

to edit the record. 
· Print setup:  specify printer, paper size, paper margin, paper orientation etc. If the 

DATA ONLY check box is ticked, the field borders and form gridlines will not be 
printed. 

· Print preview:  Display an item (form or report) as it will look when you print it.   
· Use the navigation buttons at the bottom to see other pages (if multiple pages). 
· Click on the page to zoom in for more details.  Click again to zoom out, to see the 

whole page. 
· Choose menu File => Print to print the item, or choose File => Close to close the 

preview window. 
· Print:  Print a form, datasheet or a report.  You can print all the pages, some of the 

pages, or a selected part of the datasheet. 
 

Edit menu 
 

· Undo/Undo typing: undo your most recent changes. If you modify a record then move 
to another record, this command will undo the modification. 

· Undo current field/record: After you make some changes in a field, you can restore 
the original field by using this command. Choosing this command again will undo all 
changes to this record. 

· Cut: If you have selected some text, you can remove the text selection with this 
command.  The removed text is put on the Windows clipboard so that you can paste 
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it somewhere else.  This command also works with record selections (See File => 
Select record). 

· Copy:  If you have selected some text or records, you can copy the selection to the 
clipboard.  Then you can paste the selection somewhere else. 

· Paste:  If you have some text or records on the clipboard (by using Cut or Copy 
commands), you can paste the selection where the insertion point is.  You can paste 
as many times as you like. 

· Paste appends:  If you have some records on the clipboard (by using Cut or Copy 
commands), you can append the records at the end of all records of the current form. 

· Delete:  if you have selected some text or records, this command will delete the 
selection.  Pressing Delete does the same thing. 

· Select record:  select the current record, which is being displayed on the form.  On a 
datasheet, select the record where the insertion point is. 

· Select all records:  select all records of the current form/datasheet. 
· Find:  Find records that contain certain values in a field.  You need to click on the field 

you want to search for, and then choose this menu.  The Find dialog will appear.   Its 
title bar contains the name of the field you have clicked. Type in the value you want to 
search for.  There are options to make the value to match all or part of the field.  You 
can also search for any field that contains the value, but this is usually slow. The Find 
First button will find the first record that matches the value.  Find Next button will 
search for the next record. 

· Replace: Replace the text in a field with a new text.  The Find Next button allows you 
to find the text and highlight it, but not replace. The Replace button replaces the 
highlighted text.  The Replace All button replaces all the fields without asking for 
confirmation. 

 

View menu 
 

· Form:  display one record on a form.  You can see all the fields of a record, but you 
cannot see other records. 

· Datasheet:  display each record on a row.  You can see many records, but all the 
fields may not be visible.  Use the scroll bar at the bottom to see more fields. 

 

Records menu 
 

· Data entry: gives a blank form for entering new records.  Existing records are hidden 
so that you cannot see them.  To see existing records, choose Records => Show All 
Records. 

· Go to: Go to the first, last, next or previous record in the database.  Go to => New will 
give you a blank form at the end of existing records so that you can create new 
records. 

· Refresh: update all fields in the record to reflect the latest information available.   
· Sort: sort the records.  Click on a field, and then choose Sort Ascending to sort the 

records according to this field.  You can also choose Sort Descending. 
· Allow editing: If a tick precedes this item, you can edit the records.  Selecting this item 

will remove the tick.  Then you can see the records but not change them. To allow 
editing again, selecting this item once more. 

 

Patient menu 
 
In many forms, a patient is being processed; e.g. the Waiting room form or medical record 
form. This menu allows you to perform some tasks on the patient. You can recall the patient 
for later consultations, put him into the waiting room or write referral letters for him, check 
accounts etc. 
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Filter menu 
 

· Edit filter/sort:  Sometimes you want to filter out records so that only some records 
can be seen on a form.  For example, you can display only patients whose surname 
is Smith.   

· Open the Patients form. 
· Choose the menu item Records => Edit Filter/Sort.  A window for designing the filter 

is displayed.   
· In the row entitled Field, click on the first box.  A bold down arrow appears.   
· Click on the arrow to see a field list.   
· Select the field Surname 
· In the row entitled Criteria, type in `Smith’. 
· Close the filter window. 
· Choose Records => Apply Filter/Sort.  The form now has fewer records, and they all 

have surname Smith. 
· Apply filter/sort:  Apply the latest filter so that only records meeting certain criteria are 

displayed. 
· Remove filter/sort:  show all records in the database; ignoring filters.  When records 

are deleted, sometimes they show #DELETED in the fields.  Show All Records will 
get rid of them. 

 

Toolbar 
 
The toolbar is just below the menu bar.  Its buttons duplicate the most often used menu 
commands so that you can quickly do a task by clicking.  If you leave the mouse cursor on a 
button, the button’s name will be displayed. 

  


